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Section 1 Introduction

1.1 Documentation Overview
This Installation Guide provides:
e Safety information
¢ Unpacking instructions

¢ Installation instructions, including connections with
Windows and iOS operating systems

e Certification and warranty information

Once you are operating the CombiFlash Rf, you may refer to
the Help menu for operating instructions.

IﬁNote

This Installation Guide will use the term “CombiFlash Rf’ when the
context applies to all systems (including the EZ Prep systems
which are based in the Rf platform). This installation guide will
refer to the specific model name when the discussion is limited to
a particular model or configuration.

1.2 Product Overview

The Teledyne Isco CombiFlash Rf flash chromatography
system gives you high-productivity automation,
programmable gradients, UV detection and peak separation,
and automatic detection of columns and collection tube racks
(with the exception of the Rf150). Its small size makes it a
great “personal system” and well-suited for operation within
chemical hoods and other limited indoor spaces.

/AWARNING

Avoid hazardous practices! If you use this instrument in any way not
specified in this manual, the protection provided by the instrument
may be impaired; this may increase your risk of injury.

EAR99 Technology Subject to Restrictions Contained on the Cover Page 1-1
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The CombiFlash Rf system is available in different
configurations:

Figure 1-1 CombiFlash Rf 150 system, 10-100 mL/min, 150 psi
(without injection valve)

CombiFlash Rf 150 - For general purpose Flash chromatog-
raphy needs, the CombiFlash Rf is a 10—100 mL/min, 150
psi system that pumps two solvents to form a binary gradi-
ent. This configuration has an easily accessible fluid path
that supports liquid or solid sample introduction, and a
fixed-wavelength UV detector (254 nm). The system can be
configured for full-spectrum (200-400 nm) UV detection
with secondary monitoring, manual solvent selection valves
to form a binary gradient from two of four solvent inlets,
and a 4-port manual injection valve.
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[

Figure 1-2 CombiFlash Rf* system, 1-200 mL/min, 200 psi (with
automatic injection valve)

CombiFlash Rft — For more advanced needs, the

CombiFlash Rft is a 1-200 mL/min (delivery flow rate),
200 psi system that forms a binary gradient by automati-
cally selecting two solvents from four inlets. This configura-
tion has an automatic, self-cleaning injection valve for
sample introduction, and full-spectrum UV (200—-400 nm)
or UV-vis (200—800 nm) detection with secondary wave-
length monitoring. An internal air pump is used for
post-run column air purging, active solvent level sensing,
and waste full bottle detection.

EAR99 Technology Subject to Restrictions Contained on the Cover Page 1-3
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Figure 1-3 CombiFlash Rff Lumen system, with evaporative light
scattering and UV (or UV-vis) detection

CombiFlash Rft Lumen - This system has the same high
performance features as the Rf" system, but includes an
internal evaporative light scattering detector (ELSD).
During operation, this detector can be combined with the
UV (200-400 nm) or UV-vis (200—800 nm) detection to iso-
late visible and UV absorbing compounds, as well as com-
pounds with little or no chromophores.
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Combiézs#2/* Purlon

Figure 1-4 CombiFlash Rft Purlon

CombiFlash Purlon - This system has the same features as

the Rf* but includes a mass spectrometer with a detection
range of 50 to 1200 Daltons (Da) (Purlon, Purlon S) or
50-2000 Da (Purlon L systems). During purification, this
system can be combined with the UV (200 - 400 nm) or
UV-vis (200 - 800 nm) detector to isolate visible and UV
absorbing compounds, as well as compounds with specific
molecular weights or mass ranges.

EAR99 Technology Subject to Restrictions Contained on the Cover Page 1-5



CombiFlash® Rf* User Manual

Figure 1-5 CombiFlash EZ Prep system

CombiFlash EZ Prep - This system takes the Rft system to
the next level of performance by including the capability to
perform Preparative HPLC separations on the same sys-
tem used for flash chromatography. It is available with all
the detector combinations of the Rf* including UV, UV-Vis,
Evaporative Light Scattering, and the Purlon mass spec-
trometer. In addition, the system is capable of preparative
HPLC separations at flow rates of up to 200 ml/min and
3500 psi (241 bar).
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Figure 1-6 CombiFlash Rf 4x system

CombiFlash Rf 4x — To perform multiple, sequential purifi-
cations in a personal or workgroup setting, a 4x module can

be added to the Rf* or Rf* Lumen system. This configura-
tion is known as the CombiFlash Rf 4x system, a fully auto-
mated four channel Flash chromatography system. The
four channels are independent—including separate waste
containers with full bottle detection.

All CombiFlash Rf systems are optimized for use with
Teledyne Isco’s RediSep® Rf columns, which are pre-packed
with a variety of media. For example, the CombiFlash Rf can
purify samples from 4 milligrams to more than 33 grams using
RediSep Rf columns loaded with 4 to 330 grams of silica gel.

Applications include purification of organic compounds for
drug discovery, as well as research in agrochemicals,
petrochemicals, natural products, polymers, and catalysts.

EAR99 Technology Subject to Restrictions Contained on the Cover Page 1-7
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1.3 Operating Overview

The CombiFlash Rf system is equipped with a touch screen
display for local control.

The system supports TCP/IP communication. This allows
direct control of the system by a Windows computer between
Ethernet ports of the CombiFlash Rf system and the computer.
The Windows computer must have Microsoft Internet
Explorer 6 or newer.

TCP/IP communication also allows remote control of the
system via an established network. Remote controlling devices
on the network can be a Windows PC or an Apple mobile
digital device (iPod Touch, iPhone, and iPad).

| M Note

Teledyne Isco recommends that you obtain assistance from your
Information Technology department before attempting direct or
network connections.

1.3.1 Multiple Control Possibilities
The system can be accessed from the built-in touch panel and
up to ten network devices. The touch panel shares control with
all connected devices. The system performs the most recent
command from any control input.

1.3.2 File Storage

To support operation from a variety of direct and network
connections, the software and all files are stored in the
CombiFlash Rf on an internal hard drive. This ensures that
your compound purification methods and run history files can
be viewed from any connection. Optionally, run files may be
saved to a USB flash drive, a networked controlling computer
or a network drive.
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1.4 Specifications

Table 1-1 CombiFlash Rf 150 and Rf* System

Specifications !

Rf 150 Systems
(Without Inject Valve)

Rf* Systems
(With Inject Valve)

Overall Dimensions 61 x 36 x 43cm (24 x 14.1 x 17")
(HxWxD)
Weight 22.3 kg (49.2 Ibs) 24.5 kg (54 Ibs)

Power Options

Input voltage range from 100 to 240 VAC, 50/60 Hz,

2.0 Amps maximum.

Line cord is the disconnect device.

Line Frequency

50/60 Hz

Ambient Temperature

20 to 40 °C (maximum temperature must be at least
15 °C below the boiling point of the solvent)

Humidity (when
connected to power)

95% relative humidity maximum at 20 to 40 °C

Flow Rate Range

10 to 100 mL/min

1 to 200 mL/min

Flow Rate Accuracy
(tested with water at
138 kPa or 20 psi)

+10%

+5% (5-200 mL/min)

Pressure Limit 2

1,034 kPa (150 psi)

Up to 1379 kPa (200 psi)
(column dependent)

Pressure Accuracy

10% of full scale

5% of full scale

Gradient Formation

Binary gradient from 1
and 2 solvent inlets.
Optional manual valves
to selectfrom 1, 2, and 3,
4 inlets.

Binary gradient from 1, 2,
and 3, 4 solvent inlets.
Solvent selection can be
automatically controlled
by the method.

Gradient Accuracy:

+2% of full scale, typical;
+5% maximum

+1% of full scale

Peak Detection Modes

Slope or threshold

Flow Cell Pathlength

0.1 mm, +25%

EAR99 Technology Subject to Restrictions Contained on the Cover Page
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Table 1-1 CombiFlash Rf 150 and Rf* System

Specifications 1 (Continued)

UV Detection 200 to 400 nm, optional 200 to 800 nm UV-Vis

Wavelength
Monitor Wavelength Optional 200 to 400 nm, optional
with Purity Ratio 200 to 800 nm UV-Vis

Wavelength Accuracy +5 nm

Fraction Accuracy +[2mL + (flow rate + 60)]

Electrical Safety per EN 61010-1

Pollution Degree 2

Installation Category Il

Maximum Altitude 2000 meters

Note 1. All specifications are subject to change.
Note 2. For Rf* columns undetected by RFID, the max pressure is limited to 50

psi.
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Table 1-2 CombiFlash Rft Lumen

1

Specifications

Dimensions

61 cm (24")x36 cm (14.1")x43 cm (17") (HxWxD)

Weight

30.75 kg (67.8 Ibs)

Power Options

Input voltage range from 100 to 240 VAC, 50/60 Hz,
2.0 Amps system maximum.

Line cord is the disconnect device.

Line Frequency

50/60 Hz

Ambient Temperature

20 to 40 °C (maximum temperature must be at least
15 °C below the boiling point of the solvent)

Humidity (when
connected to power)

0 to 95% non-condensing

Flow Rate Range

1 to 200 mL/min

Flow Rate Accuracy

+5% (5-200 mL/min)

Pressure Limit 2

1379 kPa (200 psi)

Pressure Accuracy

5% of full scale

Gradient Formation

Binary gradient from solvent inlets 1-4. Solvent
selection can be automatically controlled by the
method.

Peak Detection Modes

Slope or threshold

Flow Cell Path Length

0.1 mm, +25%

UV Detection and
Monitor Wavelength

Selectable from 200 to 400 nm range. Optional 200 to
800 nm UV-Vis detector.

Wavelength Accuracy +5 nm
Gas Inlet Pressure 60 to 70 psig
Gas Consumption <2.5 SLPM

Spray Chamber Setting range: 10 to 60 °C
Temperature limited to minimum of 5 °C below ambient
Drift Tube Temperature | Setting range: 30 to 90 °C

Must be 5 °C above spray chamber temperature
Minimum temperature is 5 °C above ambient
Maximum temperature is 60 °C above ambient
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Table 1-2 CombiFlash Rff Lumen

Specifications 1 (Continued)

Split Flow Rate 0.75 mL/min, +10%

Fraction Accuracy +[2mL + (flow rate + 60)]

Electrical Safety per EN 61010-1

Pollution Degree 2

Installation Category Il

Maximum Altitude 2000 meters

Note 1. All specifications are subject to change.
Note 2. For columns undetected by RFID, the max pressure is limited to 50 psi.
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Table 1-3 CombiFlash Rft Purlon

1

System Specifications

Dimensions (H x W x D)

CombiFlash Rf: 24 x 14 x 17 in (60 x 36 x 43 cm)
Mass Spectrometer 26 x 11 x 22 in (66 x 28 x 56 cm)
Roughing Pump 10 x 9 x 18 in (26 x 23 x 46 cm)

Flow Rate Range

1 - 200 mL/min

Pressure Limit

200 psi (13.8 bar)

UV and UV- Vis
Detection

Variable UV 200 - 400 nm standard. Variable UV-Vis
200 - 800 nm option

ELSD Detection

Option that can be combined with either UV or UV-Vis

Mass Spectrometry
Detection

50 — 1200 Dalton, 1 Dalton Resolution

Electrospray lonization (ESI) or optional Atmospheric
Pressure Chemical lonization (APCI)

Positive or Negative lonization Mode

Gas Consumption

4 SLPM

Number of Solvents

Binary gradient with any two of four solvents; A third
solvent can be used to add modifier at a fixed
percentage.

Programmable
Gradients

Linear, step, isocratic

Sample Injection

Direct

User Interface

10.4" touchscreen

Software

PeakTrak

Fraction Collector

Internal

Note 1. All specifications are subject to change.

Table 1-4 CombiFlash Rf* 4x System

1

Module Dimensions

Specifications

61 cm (24")x21.6cm (8.5")x43.2 cm (17") (HxWxD)

Module Weight

13.6 kg (30 Ibs)

Overall Dimensions

61 cm (24")x57.6cm (22.6")x43 cm (17") (HxWxD)

Overall Weight

40.8 kg (90 Ibs)

EAR99 Technology Subject to Restrictions Contained on the Cover Page 1-13
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Table 1-4 CombiFlash Rf* 4x System

Specifications 1 (Continued)

Power Options

Input voltage range from 100 to 240 VAC, 50/60 Hz,
2.5 Amps system maximum, 0.5 amps module
maximum.

Line cord is the disconnect device.

Line Frequency

50/60 Hz

Ambient Temperature

20 to 40 °C (maximum temperature must be at least
15 °C below the boiling point of the solvent)

Humidity (when
connected to power)

95% relative humidity maximum at 20 to 40 °C

Flow Rate Range

1 to 200 mL/min

Flow Rate Accuracy

+5% (5-200 mL/min)

Pressure Limit 2

1379 kPa (200 psi)

Pressure Accuracy

5% of full scale

Gradient Formation

Binary gradient from A1, A2, and B1, B2 solvent inlets.
Solvent selection can be automatically controlled by
the method.

Peak Detection Modes

Slope or threshold

Flow Cell Path Length

0.1 mm, +25%

UV Detection and
Monitor Wavelength

Selectable from 200 to 400 nm range. Optional 200 to
800 nm UV-Vis detector.

Wavelength Accuracy

+5nm

Fraction Accuracy

+[2mL + (flow rate + 60)]
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Table 1-4 CombiFlash Rf* 4x System

Electrical Safety per EN 61010-1

Specifications I (Continued)

Pollution Degree

2

Installation Category

Maximum Altitude

2000 meters

Note 1. All specifications are subject to change.
Note 2. For columns undetected by RFID, the max pressure is limited to 50 psi.

Table 1-5 CombiFlash EZ Prep Specifications?

Dimensions

67 cm (26.5")x43cm (17")x43 cm (17") (HxWxD)

Weight

37.4 kg (82.5 Ibs.),
43.6 kg (96.1 Ibs.) with ELSD detector

Power Options

Input voltage range from 100 to 240 VAC, 50/60 Hz,
300VA maximum typical.
Line cord is the disconnect device.

Line Frequency

50/60 Hz

Ambient Temperature

20 to 40 °C (maximum temperature must be at least
15 °C below the boiling point of the solvent)

Humidity (when
connected to power)

0 to 95% non-condensing

Flow Rate Range

5 to 200 mL/min

Flow Rate Accuracy

+5% (5-200 mL/min)

Pressure Limit?

241 bar (3500 psi)

Pressure Accuracy

5% of full scale

Gradient Formation

Binary gradient from solvent inlets 1-4. Solvent
selection can be automatically controlled by the
method.

EAR99 Technology Subject to Restrictions Contained on the Cover Page 1-15
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Table 1-5 CombiFlash EZ Prep Specifications? (Continued)

Gradient Accuracy

+3% Typical (20-200 mL/min tested with isopropyl
alcohol and identical head pressure for A and B)

Peak Detection Modes

Slope, Threshold, or Time Windows

Flow Cell Path Length

.1 mm, £.025mm. Optional .2mm, .3mm, .5mm, 1mm,
and 2mm.

UV Detection and
Monitor Wavelength

Selectable from 200 to 400 nm range. Optional 200 to
800 nm UV-Vis detector.

Wavelength Accuracy +5 nm
Fraction Accuracy +6%

ELSD Options Only

Gas Inlet Pressure 60 to 70 psig
Gas Consumption <2.5 SLPM

Drift Tube Temperature

Setting range: 30 to 90 °C

Split Flow Rate

0.75 mL/min, +10%

Spray Chamber

Setting range: 10 to 60 °C
Temperature limited to minimum of 5 °C below ambient

Electrical Safety per EN 61010-1

Pollution Degree

2

Installation Category

Maximum Altitude

2000 meters

a. All specifications are subject to change.
b. Forflash columns undetected by RFID, the max pressure is limited to 50 psi.
For columns with a RIFD tag, pressure limit is determined by column pres-

sure rating.
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Table 1-6 Component Materials List

Component Materials

Teledyne Isco RediSep | Virgin Polypropylene, silica-based media (alumina
Rf Cartridge columns also available), polyethylene (HDPE) frits

Process Tubing Fluoropolymer, Carbon impregnated fluoropolymer
tubing and 316 stainless steel tubing

Drain Tubing Vinyl with FEP liner
Process Valves PEEK, PTFE, perfluorelastomer, PPS
Sample Loading Cap 316 stainless steel

Sample Loading Cap PTFE, Elgiloy®?

Seal

Injection Valve PTFE, PCTFE, PPS for prep valve
Flowcell 303 SST, Type ES Quartz, SIMRIZ SZ485
Pump 316 stainless steel, PTFE, Elgiloy®

a. Elgiloy is a registered trademark of Combined Metals of Chicago, L.L.C.
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1.5 Controls, Indicators, and Features of the
CombiFlash Rf

Figures 1-7 through 1-9 illustrate the controls on the
CombiFlash Rf (including the EZ Prep).

Figure 1-7 CombiFlash Rf Features (Front)

1. Touch Panel LCD display — Large 10.5 inch display for
system monitoring and control.

2.USB Port — Convenient, front panel port that accepts USB
Flash memory drive. A Flash drive may be inserted into
this port for transferring files, importing and exporting
methods, and performing system software updates.

3. Adjustable Flash Column Mount — The injection valve
assembly and upper column mount slide along this mount
so the system can accept a variety of column sizes.

4. On/Standby Switch — 1 = On, 0 = standby.

5.Fraction Collector Arm and Drop Former — The arm
and drop former move to deposit liquid in the collection
tubes.

6.Racks and Collection Tubes — Racks hold the fraction
collection tubes for all Rf system. Racks include an RFID
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tag which the system uses to read the rack type and
collection tube size. The Rf150 cannot read the RFID tag.

7.Sample Injection Port — Luer-type fitting to accept the
sample though either a solid load sample cartridge (shown)
or a liquid injection using a syringe or similar device.

8.Injection Valve — This six-way valve is automatically
positioned by the CombiFlash Rf* according to its current
mode of operation. Modes include column equilibration,
sample injection, elution, column flushing, valve cleaning,
and system purging. The injection valve is not available on
the standard Rf 150 systems.

9. Upper Flash Column Mount — Secures the column inlet.

10.Lower Flash Column Mount — Secures the column
outlet.

11.Top Shelf — Allows storage of accessories and solvent
bottles.

12. Column Expansion Ports — These ports are also used for
additional external detectors (e.g., Purlon mass
spectrometer). The 4x module option is not available for the
Rf 150 systems.
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Figure 1-8 CombiFlash Rf Features (Side)

@ 9 @ @ @
Figure 1-9 CombiFlash Rf Features (Back)

13.Upper Drain Tube — Liquids spilled on the top shelf are
carried away through this tube to a user-supplied
container.

14. External Detector (All systems except the Rf 150 and
Rf* Lumen) — The system can accept an analog peak
voltage signal from an external detector. The system will
process this analog signal to determine the presence of a
peak using PeakTrak’s slope or threshold algorithms. See
section 2.11 more information.
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15. Ethernet Port — An 8P8C jack for a network connection
using a standard CATS5 cable, or for a direct connection to a
computer using a cross-over cable.

16.USB Port — For control of peripheral equipment such as
the Rf* 4x or Purlon mass spectrometer detector. This rear
panel port is also used in service-related functions.

17.Cooling Fan — Cools the internal electronic assemblies.

/MNAWARNING

Do not touch the fan.

18.Solvent Level Sensing Outlet Ports — uses air or
user-supplied gas to measure the hydrostatic pressure of
the solvent above the weighted tubing outlet. The ports are
not present on the Rf 150 systems.

19.Solvent Inlet Ports — Accepts A and B solvents. The Rf
150 system does not use the 4-port block. Refer to Section
3.4 for more information on Rf 150 solvent inlet ports.

20.0Optional External Gas Port — An inlet for an internal
pump which supplies pressurized air or user-supplied gas
for solvent level sensing, waste container full detection,
and system/column purges. The external gas should be
regulated to 2—5 psig before connecting the source to this
port. The port is not present on the Rf 150 systems.

21.Mains Power — Connects the system to AC line voltage.
22.Waste Ports — From left to right:

¢ Waste Level Sense — The system uses air or
user-supplied gas to measure the hydrostatic
pressure of the waste above the level sense line end.
The system will suspend operation when this level is
too high. This port is not present on the Rf 150
systems.

¢ Diverter Valve Waste — The diverter valve on the
fraction collector arm sends fluid to this waste port.

¢ Inject Valve Waste — The injection valve is cleaned
after each run. The system directs fluids from this
automatic cleaning routine to this port.
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23.Lower Drain Tube — This tube carries away liquids
spilled onto the rack area.

24.Cooling Fan — (Rf" Lumen only) Cools the internal ELSD
components.

25.Exhaust Port — (Rf* Lumen only) Vents the carrier gas
and vaporized solvents.

Refer to Fig.

1-9 for other

back panel
features.

Figure 1-10 CombiFlash Rf* Lumen ELSD Features (Back)

26.Nitrogen Inlet — (Rf" Lumen only) Connects to the carrier
gas supply (60 to 70 psig).

27.External Detector — (Rf" Lumen only) Reserved for
future use.

28.P-trap Drain — (Rf" Lumen only) During operation,
condensate from the Thermo-split™ process drains from
the system. An internal P-trap prevents aerosol particles
from escaping through this drain.

29.Pump Drain — (Rf Lumen only) An internal drip tray is
located below the splitter for the ELSD. Should the pump
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or its fittings leak, liquids will drain from this port to
protect internal components.

/N CAUTION

Discontinue use of the CombiFlash Rf* Lumen if liquid is present
at the Pump Drain. Contact Teledyne Isco technical service for
assistance with correcting the leak.

Figure 1-11 Optional CombiFlash Rf* 4x Module Features (Back)

30.Waste Level Sense — The system uses air or user-supplied
gas to measure the hydrostatic pressure of the waste above
the level sense line end. The system will suspend operation
when this level is too high. Four ports allow you monitor
the level of each waste container on the Rf* 4x system.

31.Column Waste — Waste fluids are sent out ports 1 through
4. Tubing connected to these ports are paired with the
waste level sense air lines and routed to a collection
container for each channel.

32.From Rf* — This port on the Column Waste block receives
fluid from the diverter valve on the fraction collector arm.
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33.Valve Waste Out — The injection valves on channels 2
through 4 are cleaned after each run. The system directs
fluids from this automatic cleaning routine to this shared
port.

34.A B - Reserved for future use.

35.USB Cable — This cable connects to the USB port on the
Rf* system back panel (see item 16). The Rf* system
controls the operation of the Rf* 4x module through this
connection.

36.Mains Power — Connects the module to AC line voltage.

37.Waste Level Sense From Rf' — Receives pressurized air
or optional external gas from the Rf* system.
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1.6 Safety

Before installing, operating, or maintaining this equipment, it
is imperative that all hazards and preventive measures are
fully understood. While specific hazards may vary according to
location and application, take heed in the following general
warnings:

/A WARNING

Avoid hazardous practices! If you use this instrument in any
way not specified in this manual, the protection provided by
the instrument may be impaired.

/A WARNING

Liquids associated with this instrument may be classified as
carcinogenic, biohazard, flammable, or radioactive. Should
these liquids be used, it is highly recommended that this
application be accomplished in an isolated environment
designed for these types of materials in accordance with
federal, state, and local regulatory laws, and in compliance with
your company’s chemical/hygiene plan in the event of a spill.

/A WARNING

If you are using flammable solvents or chemicals with this
system, vapor concentration levels may exceed the maximum
exposure levels as recommended by OSHA Guide 1910.1000.
To reduce those levels to a safe exposure, Teledyne Isco
recommends that you place the system in a laboratory hood
designed for the purpose of ventilation. This hood should be
constructed and operated in accordance with federal state and
local regulations. In the event of a solvent or chemical spill,
your organization should have a plan to deal with these
mishaps. In all cases, use good laboratory practices and
standard safety procedures.

/A WARNING

The CombiFlash Rf* has redundant safety devices to limit
pressure to less than 210 psi (1448 kPa). RediSep columns
smaller than 100 g are CE certified using standard IEC61010-1
for use on the CombiFlash Rf*. RediSep columns larger than
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100 g meet Pressure Vessel Directive 97/23/EC. Teledyne Isco
strongly recommends against the use of columns rated less
than 210 psi (1448 kPa).

1.6.1 Hazard Severity Levels

This manual applies Hazard Severity Levels to the safety

alerts. These three levels are described in the sample alerts
below.

/AN CAUTION

Cautions identify a potential hazard, which if not avoided, may
result in minor or moderate injury. This category can also warn you

of unsafe practices, or conditions that may cause property
damage.

/MN\WARNING

Warnings identify a potentially hazardous condition, which if
not avoided, could result in death or serious injury.

/\ DANGER

DANGER - limited to the most extreme situations to identify
an imminent hazard, which if not avoided, will result in
death or serious injury.

1.6.2 Hazard Symbols

The equipment and this manual use symbols used to warn of
hazards. The symbols are explained in Table 1-7.

1-26 EAR99 Technology Subject to Restrictions Contained on the Cover Page



Section 1 Introduction

Table 1-7 Hazard Symbols

Warnings and Cautions

The exclamation point within the triangle is a warning
sign alerting you of important instructions in the
instrument’s technical reference manual.

The lightning flash and arrowhead within the triangle is a
warning sign alerting you of “dangerous voltage” inside
the product.

> >

The pinch point symbol warns you that your fingers or

%9 hands will be seriously injured if you place them
between the moving parts of the mechanism near these
symbols.

Symboles de sécurité

Ce symbole signale I'existence d’instructions
importantes relatives au produit dans ce manuel.

Ce symbole signale la présence d’un danger
d’électrocution.

>

Risque de pincement. Ces symboles vous avertit que
%9 les mains ou les doigts seront blessés sérieusement si

vous les mettez entre les éléments en mouvement du
mécanisme pres de ces symboles

Warnungen und Vorsichtshinweise

Das Ausrufezeichen in Dreieck ist ein Warnzeichen, das
Sie darauf aufmerksam macht, daB3 wichtige
Anleitungen zu diesem Handbuch gehéren.

Der gepfeilte Blitz im Dreieck ist ein Warnzeichen, das
Sei vor “gefahrlichen Spannungen” im Inneren des
Produkts warnt.

> >

Vorsicht Quetschgefahr! Dieses Symbol warnt vor einer
%9 unmittelbar drohenden Verletzungsgefahr fir Finger und

Hande, wenn diese zwischen die beweglichen Teile des
gekennzeichneten Geréates geraten.
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Table 1-7 Hazard Symbols (Continued)

Advertencias y Precauciones

Esta senal le advierte sobre la importancia de las
instrucciones del manual que acompanan a este
producto.

interior del producto.

ii Esta sefal alerta sobre la presencia de alto voltaje en el

Punto del machacamiento. Sus dedos o manos seriusly
%9 seran dafados si usted los coloca entre las piezas
moviles cerca de estos simbolos.

1.7 For Additional Information

Technical assistance for the CombiFlash Rf system can be
obtained from:

Teledyne Isco
4700 Superior St.
Lincoln NE 68504

Phone: (800) 775-2965 or (402) 464-0231
Fax: (402) 465-3001
E-mail: IscoService@teledyne.com
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Section 2 Preparation:
Rf", Rf" Lumen, Rf" Purlon, and
EZ Prep Systems

This section provides instructions for unpacking and installing
the CombiFlash Rft, Rf* Lumen, Rf* Purlon, and EZ Prep
systems. The Rf* Purlon has supplementary instructions for
installation of the Purlon Mass Spectrometer. The EZ Prep
system comes with the tubing connections completed and
therefore the tubing will be covered in Section 2.6. To prepare a
system for operation, sequentially follow all instructions in
sections 2.1 through 2.14.

| M Note

CombiFlash Rf* Purlon system installation is not covered by this
manual. Instead, refer to instruction sheet 60-5233-638 for the
installation procedures.

| M Note

Section 2.16 contains an Installation Qualification checklist. If
required, sign off the checklist entries as you successfully
complete the following sections.

2.1 Unpacking the Unit

The CombiFlash Rft or Rff Lumen system is shipped in a
single carton. The optional 4x expansion module is shipped in
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a second carton. Carefully unpack the shipment and inspect
the contents.

/MN\WARNING

The system is heavy. Use a two-person lift to prevent injury.

/N\CAUTION

Do not lift the system by the fraction collector arm. Use the lifting
handles located on the instrument side panels.

If there is any damage to the shipping carton or any
components, contact the shipping agent and Teledyne Isco (or
its authorized representative) immediately.

/A WARNING
If there is any evidence that the system has been damaged in
shipping, do not plug it into AC power. Contact Teledyne Isco
or its authorized representative for advice.

Compare the contents of the boxes with the enclosed packing
slips. If there are any shortages, contact Teledyne Isco
immediately.

The fraction collector arm was stowed to prevent damage
during shipping. The arm stowing bracket should be removed
at this time.

1. Loosen the bracket’s two thumbscrews along the sides of
the arm (Figure 2-1).

Thumbscrew

Figure 2-1 Remove arm stowing bracket and spacer
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2. Push the arm to the left or right remove the spacer.

3. Store the bracket and spacer. These parts should be
reinstalled if the system must be shipped again.

2.2 Instrument Location

The CombiFlash Rf" and Rff Lumen systems have a relatively
small footprint, requiring about 1550 square centimeters (240
in?) of level bench space. Ensure that the system has at least 3
cm (1.25") of air space behind it for ventilation. Additional
space may be required for solvent and waste containers.

The optional 4x expansion module is installed to the left of the
system. This module requires an additional 933 cm? (145 in?)
of level bench space. Ensure that the module has at least 3 cm
(1.25") of air space behind it for ventilation. Instructions for
installing the 4x module can be found in Section 4 of this

guide.
Refer to Table 1-1 for environmental conditions and power
requirements.

/MAWARNING
The system is heavy. Use a two-person lift to prevent injury.

Before making any connections to the CombiFlash Rf system,
place it on the bench or in the fume hood where it will be
operated. Temporarily position the system so you can access
the back panels to complete the connections.

2.3 Connect Power

Ensure that the On/Standby switch below the touch screen
panel is in the Standby position. Then, use the supplied IEC
power cord to connect the system to mains power.

/A WARNING

Mains power must meet the voltage, frequency, and amperage
requirements listed on the serial number label.

/A WARNING

As long as the AC mains power cord is connected, power is
inside the unit. The mains power cord is the disconnect device.
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Position the system so that the power cord can be unplugged,
or use a power strip where the plug can quickly be removed
from the outlet in the event of an emergency.

2.4 Connect Solvent Lines (Excludes EZ Prep)
/AWARNING

Risk of fire ignited by electrostatic discharge. Never substitute
the black tubing on CombiFlash systems. The black tubing
(P/N 023-0503-06) is conductive. This tubing is required to
dissipate static electricity.
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To Solvent Supply To Solvent Level Sensing
Connection ’7
i
[\ 60-0923-017 Ferrule
|

60-0923-015
Compression Fitting Nut

60-5235-050 38 mm Cap, or
60-5235-051 45 mm Cap

60-5234-129

Inlet Filter Assembly
(Place weighted filter at
bottom of container.)

Figure 2-2 Recommended solvent connection

/N CAUTION
To prevent damage or premature wear to the pump and internal
valves, clean solvent should be used. The solvent should not
contain any dissolved solids.
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/N\CAUTION
If solvent containers are reused, particulate matter can
accumulate in the container. Containers should be thoroughly
cleaned before each refill. Failure to clean the containers may
result in damage to the solvent selection valve and internal
components.

The CombiFlash Rff and Rf' Lumen systems have four
solvent inlet ports on the back panel, labeled 1-4.

The system requires at least one A and one B solvent to form a
binary gradient, and assumes that the B solvent is stronger
than A. The other inputs allow you to form alternative binary
gradient, or to change the B solvent mid-run.

The accessory package includes several pieces to complete the
solvent inlet connections. To connect the solvent lines:

1. Connect the solvent source to the system’s Solvent Inlet
ports. Figure 2-2 shows the recommended connections
when the user-supplied solvent container has a 38 or 45
mm opening (GL 38 or GL 45).

If the container does not have a GL38 or GL45 opening, do
not use the cap. Use an alternate method to cover the open-
ing, to prevent particulate matter from entering the con-
tainer. Ensure that the solvent and air tubing are secured
so that the weighted filter remains at the bottom of the sol-
vent source.

The Solvent Level Sensing air line connects to the back

panel with a compression fitting. This fitting must be air-
tight. To connect tubing using the compression fittings:

2. Slide the nut and ferrule onto the tubing as shown in
Figure 2-2.

3. Fully insert the tubing into the threaded bulkhead fitting
on the back panel of the system.

4. Finger-tighten the nut onto the threaded bulkhead fitting.
This will seat the ferrule in the fitting.

| M Note

When using higher-density solvents such as dichloromethane
(DCM), place the solvent container level with or above the
CombiFlash Rf system. Placing solvent containers below the level
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of the system can contribute to decreased flow due to the high
vapor pressure of DCM. This problem becomes more pronounced
as the ambient temperature increases.

2.5 Connect Waste Lines (Excludes EZ Prep)
/MAWARNING

Risk of fire or equipment damage. Failure to connect Waste
Port tubing may allow organic solvents to pool in unsafe areas,
possibly creating dangerous levels of flammable vapors.

/A WARNING

Risk of fire ignited by electrostatic discharges. Never
substitute the black tubing on CombiFlash systems. The black
tubing (P/N 023-0503-06) is conductive. This tubing is required
to dissipate static electricity.

| /\ CAUTION

Elevated flammable vapor levels are possible. Ensure that the
waste container is adequately ventilated, preferably by placing it in
a fume hood.

The system has two waste outlets on the back panel: Diverter
Valve waste and Inject Valve waste. You can route waste to a
common collection container, or to individual containers.

The Waste Level Sense uses air pressure to detect the liquid
level in the common waste container. If using individual
containers, use the waste level sense to detect the level of the
Diverter Valve waste container. Under normal operating
conditions it will fill faster than the Inject Valve waste
container. Empty both containers at the same time to prevent
overfilling the unmonitored container.
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To Diverter Valve Waste

Connection
To Waste Level )
Sense Connection r -Cr)% rllwggttig/nalve Waste

60-0923-017 Ferrule

60-0923-015
Compression Fitting Nut

60-5234-143
Waste Tubing Assembly

Ventilation Hole

(Luer fitting)

If necessary, connect

user-supplied tubing and

(See Top View) route to fume hood.

Tubing Stop
(ferrule) 60-5235-053 38 mm Waste Cap, or

60-5235-054 45 mm Waste Cap

about 2 inches - - -
(5cm)

(Top View)

Diverter Valve Waste

Waste Level Sense © G Ventilation
Inject Valve Waste

Figure 2-3 Recommended waste connections, with plastic plate
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The accessory package includes parts to complete the waste
connections. Figure 2-3 shows the recommended connections
for user-supplied waste containers with either a 38 or 45 mm
opening (GL 38 or GL 45).

Refer to the steps in section 2.4 to connect the tubing to the
system using the compression fittings. Then, complete the
connections (refer to Figure 2-3):

1. Push the three tubes through the cap. The tubing will fit
snugly in the cap and may require some force.

2. Push the Waste Level Sense tubing until the Tubing Stop
is against the cap. This ensures that the outlet is about two
inches (5 cm) below the container’s maximum level.

Should the container not have a GL 38 or GL 45 opening, omit
the use of the waste cap. Ensure the solvent tubes are secured
so they drain into the waste container. Secure the Waste Level
Sense air tubing so its outlet is at least two inches (5 cm)
below the container’s maximum level. Seal the container
opening to avoid solvent vapors.

| M Note |

When using higher-density solvents such as dichloromethane
(DCM), ensure that the waste container is no more than 3 feet
below the supply solvent levels. Placing solvent containers above
the system and waste containers on the floor may cause the
internal check valves to open and allow solvent to flow through the
system when in the standby state.
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2.6 EZ Prep Plumbing Connections

The EZ Prep comes with the solvent inlet lines and waste lines
pre-assembled to the instrument. To install the EZ Prep:

1. Remove the shipping clamps that retain the plumbing lines
(Figure 2-4).

Figure 2-4 Remove the two sthpmg clamps mdzcated above

2. Remove the 2 screws and tubing clamps identified in figure
2-4. This releases the tubing lines for placement in the
solvent supply and waste reservoirs.

| M Note

Due to the large size of the inlet filter and inlet line tubing
connections, the tubing assemblies have been pre-assembled with
a bottle cap the is typical for the region (GL 38 in the USA and GL
45 in the rest of the world). If these caps aren’t suitable for your
containers, you will have to make modifications as needed.

3. Place the solvent lines in the solvent supply containers.
The solvent inlet filters will need to be placed into the
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supply vessels first, followed by the level sensing lines. If
the solvent sense line is placed into the container first,
with some containers, there will be insufficient room
remaining to insert the solvent supply filter. If the solvent
lines are unable to reach the supply container (such as
when placed below the work surface), the clamp that
retains the tubing above the inlet ports can be removed.
The solvent lines can be rotated in their fittings by
loosening the fitting nut. If the nut has been loosened, be
sure it is properly tightened to prevent air leakage into the
fluid connection.

4. Place the waste lines in a suitable waste container.

|4 Note

When using higher-density solvents such as dichloromethane
(DCM), place the solvent container level with or above the
CombiFlash Rf system. Placing solvent containers below the level
of the system can contribute to decreased flow due to the high
vapor pressure of DCM. This problem becomes more pronounced
as the ambient temperature increases.

2.7 External Gas

2.7.1 CombiFlash Rf*, Rf* Lumen, and EZ Prep
The CombiFlash Rf*, Rff Lumen, and EZ Prep systems use an
internal air pump to provide compressed air for solvent and
waste level sensing. Optionally, the system can deliver a
compressed gas. Inert or other gases may be more suitable
than air for some applications.

If ambient air is compatible with your solvents and waste,
simply leave the Optional External Gas port open.

If you want to use a gas instead of air, connect user-supplied
I/8" I.D. tubing to the Optional External Gas port. Connect the
other end to the user-supplied compressed gas. The external
compressed gas should be dry, filtered, and regulated to 2—5
psi (0.14-0.34 atm, 13.8—-34.5 KPa).
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2.7.2 CombiFlash Rf* Lumen or EZ Prep with ELSD only

ELSD operation requires a carrier gas. To connect the carrier
gas to the CombiFlash Rf* Lumen or EZ Prep:

1. Locate the %8 inch O.D. FEP tubing (part number
023-0503-02) from the accessory package.

2. Push one end of the tubing into the Nitrogen Inlet port on
the back of the system. The tubing should be fully seated in
the port.

3. Cut the tubing to length and connect the other end to the
user-supplied carrier gas. An assortment of Us inch
adapters are supplied in the accessory kit to complete the
connection to your gas source.

| M Note

Teledyne Isco recommends >99% pure nitrogen from a source
that can deliver 2.5 SLPM at 60 to 70 psi.

2.8 Connect and Route Drain Lines

/MN\WARNING

Risk of fire or equipment damage. Failure to connect drain lines
may allow organic solvents to pool in unsafe areas, creating a
potential for dangerous levels of flammable vapors. Improper
draining may damage the instrument’s internal components.

The CombiFlash Rf system has drain tubes extending from its
back panel. The tubes drain away any liquid spilled on the top
shelf (Rf *only) and the tray beneath the fraction collection
racks.

1. Test the Fraction Collector drain by connecting a vacuum
or air supply source to the outlet end of the drain tube.
Then, verify the presence of such vacuum or air supply
source on the drain (Figure 2-5).

2. (Rf* only) Test the top shelf drain by connecting a vacuum
or air supply source to the outlet end of the drain tube.
Then, verify the presence of such vacuum or air supply
source on the drain (Figure 2-6).
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L~

o O

Figure 2-5 Fraction Collector Drain

N\ —
D

Figure 2-6 Top Shelf Drain

Vacuum or
pressurized air
applied to the outlet
end of the drain
tube must exist at
the collection tray
drain hole.

L Rf" only ~Vacuum

or pressurized air
applied to the outlet
end of the drain
tube must exist at
the top shelf drain
hole.

3. Route the end of both drain tubes to a suitable waste fluid

collection container.
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| M Note

It may be necessary to extend the drain tube. If so, splice the
tubing with user-supplied tubing. The user-supplied tubing should
have an inside diameter no smaller than the existing drain tubing,
and must be compatible with the solvents used by the system.
Route this extension tubing to the waste collection vessel.

(CombiFlash Rf" Lumen and EZ Prep with optional
ELSD only) The CombiFlash Rft Lumen system has
additional drains that must be connected:

4. Locate the Y4 inch 1.D. silicone tubing (part number
029-1312-02) and a nylon tubing clamp (part number
149-2002-08) from the accessory kit. Connect one end of the
tubing to the P-trap port and secure it with the clamp.

5.The P-Trap must be filled with fluid to prevent sample loss.
To accomplish this, raise the drain tubing above the
instrument and place 10 mL of liquid, such as isopropyl
alcohol, into the tube. Lift it high enough so the fluid enters
the P-trap drain.

6. Route the end of the P-trap drain tube to a suitable waste
fluid collection container. Please be aware that as the
tubing is lowered, several ml of isopropyl alcohol will run
out of the tubing. This is normal and means that the
P-trap is properly filled. Depending on your application,
the P-trap fluid may need periodic replenishment to ensure
maximum signal strength of the ELSD.

@Note

If accessible, the outlet end of the P-trap drain tube may be used
to refill the P-trap.

7. Connect user-supplied tubing (}2 inch I.D.) to the exhaust
port and route the exhaust away from the system. This will
prevent unnecessary solvent vapor alarms.

| M Note

The exhaust gas is dry and does not require a waste collection
container.
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| M Note |

Drain tubing is not required on the Pump Drain port.

| /\ CAUTION |
Discontinue use of the CombiFlash Rf* Lumen if liquid is present
at the Pump Drain. Contact Teledyne Isco technical service for
assistance with correcting the leak.

2.9 Position the System

After completing the various connections, the system can be
moved to its operating position. Turn the system so that the
operator can access all of the front view features and controls
(Figure 1-7). Use care not to damage the connections, tubing,
and cables while moving the system.

/\ CAUTION |

Ensure that the CombiFlash Rf* has at least 3 cm (1.25") of air
space behind it for ventilation.

Position the solvent and waste containers as necessary.

| M Note

When using higher-density solvents such as dichloromethane
(DCM), place the solvent container level with or above the
CombiFlash Rf* system. Placing solvent containers below the
level of the Rf* can contribute to decreased flow due to the high
vapor pressure of DCM. This problem becomes more pronounced
as the ambient temperature increases.

| M Note

When using higher-density solvents such as dichloromethane
(DCM), ensure that the waste container is no more than 3 feet
below the supply solvent levels. Placing solvent containers above
the system and waste containers on the floor may cause the
internal check valves to open and allow solvent to flow through the
system when in the standby state.
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2.10 Install Collection Tube Racks

Before beginning a run, you must load collection racks with
tubes onto the system’s fraction collector tray.

Your system was shipped with two collection tube racks. The
following tube rack sets are available:

60-5237-013 — Two racks for 13 x 100 mm test tubes
(8 mL). Total tubes: 216.

60-5237-061 — Two racks for 16 x 100 mm test tubes
(14 mL). Total tubes: 150.

60-5237-031 — Two racks for 16 x 125 mm test tubes
(15.5 mL). Total tubes: 150.

60-5237-032 — Two racks for 16 x 150/160 mm test
tubes (18 mL). Total tubes: 150.

60-5237-033 — Two racks for 18 x 150 mm test tubes
(25 mL). Total tubes: 140.

60-5237-034 — Two racks for 18 x 180 mm test tubes
(30 mL). Total tubes: 140.

60-5237-035 — Two racks for 25 x 150 mm vials (50
mL). Total vials: 60.

60-5237-040 — One rack for twelve 480 mL French
square bottles.

60-5394-469 — Two racks for 20 mL (28 x 61 mm)
scintillation vials. Total vials: 54.

60-5394-468 — Two racks for 40 mL (28 x 95 mm)
scintillation vials. Total vials: 54.

To load the racks:
1. Insert test tubes, vials, or bottles into the rack (Fig. 2-7).

/N CAUTION

Risk of broken glass or equipment damage. Do not load test tubes
longer than the length listed on the tube size label.
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Figure 2-7 Loading test tubes
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2. While holding the rack with the tube size label visible

(Figure 2-8), insert the racks into the system. Slide the
rack in until you feel it drop into its seated position.

Tube Size
Label

Figure 2-8 Inserting the collection tube rack

/\ CAUTION |

An incorrectly installed rack will cause the rack to be misaligned
under the fraction collector arm. Misaligned racks might cause
fractions to miss the tube opening or deposit in the wrong tube.
Always ensure the tube size label is visible (that is, facing outward)
and the rack is pushed in until it is seated.

When you turn the power switch to on, the system will
automatically detect the type of rack and configure program
settings accordingly. Later, in section 2.13.6, you can configure
the maximum volume for each tube size.

2.11 External Detector (Optional)

CombiFlash Rf systems with serial numbers greater than
209C20092 can be configured for use with an analog signal
from a user-supplied external detector. The analog signal
should range from —1.2 to +1.2 volts, although custom
interface cables may convert other analog signals to this
range. Contact the factory for interface and fluid path options.

| M Note

The external detector option is not supported on CombiFlash Rf*
Lumen systems.
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2.12 Turn on Power

The system’s power switch is located just below the touch
screen panel.

1. Turn the switch to the ON position. The system will begin
its startup routine which includes self diagnostics.

2. Monitor the movement of the fraction collector arm. The
arm should move to the left rear corner of the fraction
collector area. You should not hear any grinding noises
during the homing sequence. If grinding is heard there is a
problem with the homing of the fraction collector arm.

3.The system is ready for operation when the PeakTrak
screen is displayed.

2.13 Configure the System

Before operating the system, it should be configured for the
desired operation. To configure the system, open the
Configuration window by selecting Tools>Configuration from
the PeakTrak menu.

The configuration window has four tabs: Instrument
Configuration, Network Configuration, User Preferences and
Prep HPLC (on EZ Prep systems only). Network Configuration
settings are discussed later in Section 7, REMOTE INTERFACES.

Adjust the following (sections 2.13.1 through 2.13.8) on the
Instrument Configuration, User Preferences and Prep HPLC
(if applicable) tabs for the desired operation and then click OK
to save the settings.

Some configuration settings do not take effect until the system
is restarted. After completing sections 2.13.1 through 2.13.8
follow the instructions in section 2.13.9.

2.13.1 Solvents

When you installed the system, up to four solvents were
connected to the back panel. This section of the Instrument
Configuration tab allows you to manage these solvents. To do
so:
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| M Note

The system is shipped with common solvent names already
loaded. If your solvent names are listed in the solvent drop-down
list boxes, skip steps 1 through 3.

1. Click the “Add Solvent” button.
2. Enter the solvent name and click the OK button.
3. Repeat steps 1 and 2 for all solvents.

4. For the Solvent 1 drop-down list box, select the solvent
name connected to the 1 Solvent Inlet Port. Repeat for
Solvents 2, 3, and 4.

5.Select the “Enable solvent level sensing” check box to
enable this feature (recommended). Clear this box to
disable this feature.

The solvent level sensing feature will monitor solvent
usage to minimize the risk of running out of solvent during
a purification run. The system compares the volume
required for a purification run with the estimated volume
in the solvent container and alerts you when there is not
enough.

6.If using the solvent level sensing feature, enter the
Minimum Solvent Level (density dependent) as a range in
centimeters.

To understand this range, consider that dichloromethane is
more dense than hexane. If the selected range is 2—4, the
system triggers an alert when the dichloromethane level
falls to about 2 cm above the weighted filter. At the same
selected range, the system would trigger an alert when the
hexane falls to about 4 cm above the weighted filter.

2.13.2 Enable Automatic Phase Change (EZ Prep Only)

The EZ Prep has a feature which automatically changes
solvents used in normal phase flash separations to HPLC
reverse phase separations and vice versa without any user
interaction. For this feature to function properly, the strong
reverse phase solvent must be miscible with the strong normal
phase solvent. In addition, specific solvent types and locations
must be followed. To enable this feature, simply press the
button. A dialog box will appear that defines placement of the
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solvents. For proper operation of this function, Solvent 1 must
be the weak normal phase solvent (typically an alkane such as
hexane). Solvent 2 must be the strong solvent (such as ethyl
acetate). Solvent 3 is the weak reverse phase solvent (usually
water) and solvent 4 is the strong reverse phase solvent (such
as methanol or acetonitrile).

2.13.3 General Settings
CombiFlash Rf Name (optional) — Use this option to name
your system. The name will appear in operational displays
and run summaries. This feature is useful when your
laboratory has more than one CombiFlash Rf system.

Time Zone — Select your time zone from the drop-down list
box.

2.13.4 Set Date/Time

Click this button to open a window from which you can set the
system date and time.

To prevent unauthorized time changes, this feature is
password protected. The system is shipped with the password
set to combiflash. Use the Tools>Set Password menu
command to change this password for greater security.

2.13.5 Vapor Limit
The system has an internal vapor sensor that detects vapors
present in the immediate atmosphere. When the limit is
exceeded, the CombiFlash Rf will shut down to avoid a
hazardous condition.

Teledyne Isco recommends using the default setting of 25.
This value represents an organic vapor level slightly above the
ambient vapor level of a well-ventilated laboratory.

A setting below 25 could cause random alarms without
significant vapors present. If PeakTrak displays a Vapor Limit
alarm while the Vapor Limit is set at 25, perform the following
checks on your laboratory and the instrument:

¢ Ensure that no open containers or spills of organic
solvent are in close proximity to the system.

e Ensure that the system is located in a well-ventilated
area.
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¢ Ensure that there is no visible solvent leakage from the
system.

If PeakTrak continues to display the Vapor Limit alarm after
you have made these checks and corrected any problems
found, it is likely that organic vapors are present in the ambi-
ent environment of your laboratory. In this case, increase the
setting of the Vapor Limit. Settings greater than 25 are appro-
priate for laboratory environments with a somewhat elevated
background solvent vapor concentration, representing a safe
setting, but one with a reduced margin for error.

2.13.6 Set Default Tube Volumes

Click this button to open a window from which you can set the
default volume of the collection tubes. You can increase or
decrease these values to set the desired default volume
collected in each container. Just be sure you don’t overflow the
containers by exceeding their capacity.

The system will automatically advance to the next tube when
this default volume is met in each tube. Keep in mind that
advanced method settings (discussed in Section 5 and the
on-line help) may override this default setting. During a run,
other factors such as automatic tube advances for detected
peaks will affect collected volume.

2.13.7 User Preferences

View the User Preferences tab to configure system operation
for the current user.

| M Note

New systems will only have one user account named “common.”

Language — Select the user’s desired language from the
drop-down list box.

Automatically Print Report at End of Run - if this option
is enabled, the system will print a report at the end of each
run.

| M Note

This option requires the system to be configured for network
operation and a connection to a printer on the network. Network
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settings are discussed in Section 7, REMOTE INTERFACES. Do not
select this option for these initial installation steps.

Default Run Units — Run units are displayed along the
X-axis of the chromatogram. Select Time (in minutes) or
Column Volumes. A column volume unit is the time it takes to
pump enough solvent to exchange the volume held by the
column. The duration in minutes will vary according to the
column media and size, and the flow rate.

Gradient Method — Select the standard gradient type
(Figure 2-9).

e Linear — The system gradually mixes solvents A and B
from the last programmed %B until it reaches the next
programmed %B. This method connects the inflection
points that define the gradient with a straight line.

e Step — The system holds each %B value until it reaches
the next programmed %B. Because the system holds the
%B values, the changes at each new value are nearly
instantaneous, producing a stepped appearance on the
plot area.

e Isocratic — The system holds the initial solvent mix for
the entire run.

I

inear Step Isocratic

Figure 2-9 Gradient types

Enable Run Length Extension — When enabled, this option
automatically extends the run if a peak is eluting at the end of
the maximum %B gradient. This ensures that a late-eluting
peak fully comes off the column and is collected.

An automatic run extension is a five-minute isocratic hold
added to the end of the run’s maximum %B gradient profile.
During the extension, the system continues to pump the
maximum %B solvent mixture. Should the system still detect
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a peak after an extension, the system will add another, up to a
maximum of three extensions.

Occasionally, compounds might come off the column once the
%B returns to the minimum value at the end of a run. If the
Run Length Extension is enabled, it will automatically extend
the run one time to clear the column and plumbing of any
remaining material.

Original method . Extension 2 . Final Extension[
Extension 1 Extension 3 B
| | | | | | | | | | | | | | | | | | | | | | | | | | | | |
0 5 10 15 20 25
Minutes

Figure 2-10 Automatic Run Extension Examples

Figure 2-10 illustrates the possible run extensions. The
original method was programmed to rise to the maximum %B
over seven minutes, hold for two minutes and return to the
minimum %B for a final minute. At nine minutes, a peak was
eluting. The system extended the run, holding the %B at the
maximum level for another five minutes. This also occurred at
fourteen and nineteen minutes, resulting in the second and
third extensions. At 24 minutes, the %B solvent strength
returned to zero. Before the final minute elapsed, more
compound was detected, causing the system to extend the run
for a final five minutes at the minimum %B.

Enable rapid equilibration — select this option to
equilibrate the column at a high flow rate.

| M Note

Due to the high pressure that is possible during rapid equilibration,
this option may not be desirable for some column media or
purification methods.

Enable Automatic Peak Hold - inserts an isocratic hold for
the duration on an eluted peak.
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Use ELSD by Default - causes all runs to use the ELSD
detector unless disabled in the run requirement screen
[STARTING A RUN USING DEFAULT SETTINGS [6.4.1]].

2.13.8 Prep HPLC Tab

The DEFAULT COLUMN allows selection of the most commonly
used Preparative HPLC column. This will be the method
loaded when the user first selects use of the Preparative HPLC
function during normal operation. Many times this will be the
column mounted onto the system. The drop down list to select
the DEFAULT COLUMN is based on the columns already defined
by the user. To define a column, refer to the area below the
DEFAULT COLUMN field.

To define a column:

1. Press NEW. This will open a dialog box allowing the new
column to be named. This name will be used to refer to the
column in normal usage. This name will also be printed on
the report.

2. Select the MEDIA SIZE. This data will be printed on the
chromatograms for future reference.

3.Enter a COLUMN DIAMETER. This information will be used
by the system to recommend an optimal flow rate to
achieve highest resolution for the column being defined.

4. Enter a COLUMN LENGTH. This is used to recommend a
separation length. This length is based on a gradient
segment approximately 12 column volumes in duration.

5.Select DEFINE METHOD. This allows a review of the method
defined by the system. This is an opportunity to edit the
recommended gradient shape and duration to better match
the expected chemistry. A higher flow rate can be selected
to balance resolution and throughput.

6. Selecting SAVE. This will save the column and allow its use
on the system.

7.1f you are done defining columns, press the OK button.

If you have several columns that will be used on the system,
these can be defined at this time or at any later time.

e SAVE AS allows you create a new column definition
based on an existing column. This is done by selecting
the existing column in the COLUMN NAME drop down
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box. The column definition can be saved with a new
name using SAVE AS. The newly created column
definition can be edited in the same manner as when
creating a new column.

e DELETE allows you to remove a column no longer used
from the drop down list.

¢ A history of the usage of each column is maintained on
the EZ Prep system. RESET COLUMN HISTORY allows you
to delete that column history.

2.13.9 Restart the system

Some configuration settings do not take effect until the system
is restarted. After completing sections 2.13.1 through 2.13.8
restart the system:

1.If the Configuration window is not closed already, click the
OK button to close it.

2. Place the Power switch below the LCD display in the Off
position and wait one minute or more.

/N CAUTION

Always wait until the screen turns off or at least one minute after
placing the Power switch in the Off position. Moving the switch to
the Off position begins a power down sequence that takes up to
one minute to complete. If you move the switch to the ON position
before the sequence is complete, the system may not start up
correctly.

/N\CAUTION

Except during an emergency, never remove AC power
immediately after placing the Power switch in the Off position. The
power down sequence includes file maintenance that takes up to
one minute to complete. Interrupting the file maintenance may
corrupt files causing abnormal operation or a complete system
failure.

3. After one minute or more, place the Power switch in the On
position.

4. The system is ready for operation when the PeakTrak
screen is displayed.
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2.14 Prime the Solvent Lines

Before the first use, the system should be primed. Ensure that
the solvent containers are filled, then:

1. Select the “Tools>Auto prime” menu command.

2. There are 4 solvent selection lists labeled from 1st solvent
through 4th solvent, describing the order in which solvents
will be pumped. The solvent choices for each list are those
defined by the CONFIGURATION [6.3.10] window. (Rf*
systems, including those equipped with 4x).

e If all solvents are of a similar polarity, it is
recommended that the solvent be primed in order of
decreasing solvent strength, with the weakest solvent
primed last.

e Ifthe 4 solvents are of mixed polarity (aqueous and
nonpolar), ensure that sequential solvents are
compatible, such as water, acetonitrile, ethyl acetate,
hexane.

e Ifyou are performing an autoprime after redefining
some of the solvents, it may be beneficial to run 2
autoprime operations sequentially to get full flushing
of the lines.

3. Click the PLAY button to start priming the system.

Preparative HPLC systems typically require the user to open
a prime valve and draw fluid with a syringe to prime the
system. The EZ Prep doesn’t require this action due to its
unique valves and integrated priming pump.

IﬁNote

When priming the first time, inspect the solvent and waste
connections to the system. If any leaks are observed, click the
Cancel button to stop the Auto Prime. Correct the leak by
tightening the fitting an additional "4 turn, and then restart the Auto
Prime from step 1.

To terminate an autoprime step in process and advance to
the next Auto Prime step, you can click the Fast Forward
button. The Auto Prime window closes when finished.

After Auto Priming, the system is ready for operation. If you
are priming a new system for the first time, it may be
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beneficial to flush all of the fluid lines with the desired solvent
to remove any isopropanol left from production testing. This
can be done with the manual control feature (Section 6.3.9).

|4 Note |

Use Auto Prime for quick solvent changes of similar polarity by
pumping a fixed amount of solvent through the waste fluid path at
100 mL/min. For more advanced priming functions such as
varying the flow rates, fluid paths, etc., or to purge the system with
air before changing between normal and reversed phase solvent
systems, use the Tools>Manual Control option.

2.15 System Verification

It is recommended that the system operation be verified.
Verification of the EZ Prep system is also accomplished by
performing the defined normal phase procedure below. This
tests all EZ Prep system functions also. To do so, use a
pre-packaged CombiFlash Rf test kit:

¢ Part number 60-5237-050
Test kit containing five of the 5 gram size solid load
cartridges pre-filled with 0.5 grams of test sample
NPHE, and five 4 gram RediSep Rf silica gel columns

¢ Part number 60-5237-051
Test kit containing four of the 25 gram size solid load
cartridges pre-filled with 0.5 grams of test sample
NPHE, and four 4 gram RediSep Rf silica gel columns

¢ Part number 60-5234-626
Test mixture supplied in the Purlon accessory kit,
containing 10 g of MSD test mix

e Part number 60-5234-315
Test mixture supplied with APCI probes, 5 mL

¢ Part number 60-5234-627
Test mixture supplied with ESI probes, 10 mL

| M Note

Verification of the EZ Prep is accomplished by verifying the flash
chromatography operation. All functionality of the EZ Prep is
verified by that process.
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2.16 Installation Qualification Checklist

Table 2-1 may be completed to verify and document the
installation procedures contained in Section 2 of this guide.
See following page:
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Table 2-1 Installation Qualification Checklist

Installer Operator
Step | Description Initials Initials
2.1 UNPACKING THE UNIT
2.2 INSTRUMENT LOCATION

2.3 CONNECT POWER

2.4 CONNECT SOLVENT LINES
(EXCLUDES EZ PREP)

2.5 CONNECT WASTE LINES
(EXCLUDES EZ PREP)

2.7 EXTERNAL GAS (Optional)

2.8 CONNECT AND ROUTE DRAIN
LINES

2.9 POSITION THE SYSTEM

2.10 INSTALL COLLECTION TUBE
RACKS

2.11 EXTERNAL DETECTOR
(OPTIONAL)

2.12 | TURN ON POWER

2.13 | CONFIGURE THE SYSTEM

214 PRIME THE SOLVENT LINES

2.15 SYSTEM VERIFICATION

Certification of Section 2 Completion

Installer Name (print):

Installer Signature:
Date:

Operator Name (print):

Operator Signature:
Date:

Comments:
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Section 3 Preparation:
Rf 150 Systems

This section provides instructions for unpacking and installing
the CombiFlash Rf 150 system. To prepare the system for

operation, sequentially follow all instructions in sections 3.1
through 3.11.

| M Note

Section 3.13 contains an Installation Qualification checklist. If
required, sign off the checklist entries as you successfully
complete the following sections.

IﬁNote

The Rf150 is rated for operation with reagent grade solvents.
Operation at pressures > 5 bar (~75 psi) with high purity hexanes
(>99% pure) at 100% concentration may cause the pump to stall
and produce a grating sound. Many times, normal operation can
be restored by removing the high pressure load and flushing the
pump with isopropy! alcohol.

3.1 Unpacking the Unit

The CombiFlash Rf 150 system is shipped in a single carton.
Carefully unpack the shipment and inspect the contents.

/A WARNING

The system is heavy. Use a two-person lift to prevent injury.

/AN CAUTION

Do not lift the system by the fraction collector arm. Use the lifting
handles located on the instrument side panels.
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If there is any damage to the shipping carton or any
components, contact the shipping agent and Teledyne Isco (or
its authorized representative) immediately.

/AN\WARNING

If there is any evidence that the system has been damaged in
shipping, do not plug it into AC power. Contact Teledyne Isco
or its authorized representative for advice.

Compare the contents of the box with the enclosed packing
slips. If there are any shortages, contact Teledyne Isco

immediately.

The fraction collector arm was stowed to prevent damage
during shipping. The arm stowing bracket should be removed
at this time.
1. Loosen the bracket’s two thumbscrews along the sides of
the arm (Figure 3-1).

,/ Spacer ’
/ & @ I
=l & |
Thumbscrew

Thumbscrew

Figure 3-1 Remove arm stowing bracket and spacer

2. Push the arm to the left or right remove the spacer.

3. Store the bracket and spacer. These parts should be
reinstalled if the system needs to be shipped again.
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3.2 Instrument Location
The CombiFlash Rf 150 has a relatively small footprint,
requiring about 1550 square centimeters (240 in?) of level
bench space. Ensure that the CombiFlash Rf has at least 3 cm
(1.25") of air space behind it for ventilation. Additional space
may be required for solvent and waste containers.

Refer to Table 1-1 of this guide for environmental conditions
and power requirements.

/A WARNING

The system is heavy. Use a two-person lift to prevent injury.

Before making any connections to the CombiFlash Rf 150,
place the system on the bench or in the fume hood where it
will be operated. Temporarily position the system so you can
access the back panels to complete the connections.

3.3 Connect Power

Ensure that the On/Standby switch below the touch screen
panel is in the Standby position. Then, use the supplied IEC
power cord to connect the CombiFlash Rf to mains power.

/A WARNING

Mains power must meet the voltage, frequency, and amperage
requirements listed on the serial number label.

/A WARNING

As long as the AC mains power cord is connected, power is
inside the unit. The mains power cord is the disconnect device.
Position the Rf 150 system so that the power cord can be
unplugged, or use a power strip where the plug can quickly be
removed from the outlet in the event of an emergency.
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3.4 Connect Solvent Lines

/AN\WARNING

Risk of fire ignited by electrostatic discharge. Never substitute
the black tubing on CombiFlash systems. The black tubing
(P/N 023-0503-06) is conductive. This tubing is required to
dissipate static electricity.

| /\ CAUTION

To prevent damage or premature wear to the pump and internal
valves, clean solvent should be used. The solvent should not
contain any dissolved solids.

The CombiFlash Rf 150 system has two solvent inlet ports on
the back panel: one A solvent and one B solvent (Figure 3-2).

Figure 3-2 CombiFlash Rf150 solvent inlet ports

The system requires at least one A and one B solvent to form a
binary gradient. It assumes that the B solvent is stronger than
A. When using the optional valve kit. the second set of inputs
allows you to manually switch between alternative binary

gradient solvent systems, or to change the B solvent mid-run.

3-4
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/N\CAUTION
To prevent damage or premature wear to the pump and internal
valves, clean solvent should be used. The solvent should not
contain any dissolved solids.

| M Note

An optional, manual solvent selection valve kit may be added to
provide inlets for two A solvents and two B solvents. If using the
optional valve kit, connect the kit and solvent lines according to the
instruction sheet.

Accessory package P/N 60-5239-012 includes pieces to
complete the solvent inlet connections.

1. Locate a Solvent Inlet Filter Assembly (P/N 60-5234-193)
in the accessory package. Connect the tubing end to the A
Solvent inlet. Thread the nut into the Solvent A Inlet and
finger-tighten.

2. Connect the second Solvent Inlet Filter assembly to the B
Solvent inlet.

3.Insert the filter end of each solvent inlet filter assembly
into their respective solvent containers.

4. The accessory package includes labels to easily identify the
inlet lines. Apply the A and B labels to the solvent lines
above the solvent container openings.

/N\CAUTION

If solvent containers are reused, particulate matter can
accumulate in the container. Containers should be thoroughly
cleaned before each refill. Failure to clean the containers may
result in damage to the solvent selection valve and internal
components.

IﬁNote

When using higher-density solvents such as dichloromethane
(DCM), place the solvent container level with or above the
CombiFlash Rf system. Placing solvent containers below the level
of the system can contribute to decreased flow due to the high
vapor pressure of DCM. This problem becomes more pronounced
as the ambient temperature increases.
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3.5 Connect Waste Lines

/AN\WARNING

Risk of fire or equipment damage. Failure to connect Waste
Port tubing may allow organic solvents to pool in unsafe areas,
possibly creating dangerous levels of flammable vapors.

/AN\WARNING

Risk of fire ignited by electrostatic discharges. Never
substitute the black tubing on CombiFlash systems. The black
tubing (P/N 023-0503-06) is conductive. This tubing is required
to dissipate static electricity.

| /\ CAUTION

Elevated flammable vapor levels are possible. Ensure that the
waste container is adequately ventilated, preferably by placing it in
a fume hood.

/AN CAUTION

Do not overfill the waste collection containers. Regularly monitor
and empty the bottles before they overfill.

The system has one waste outlet on the back panel: Diverter
Valve waste.

Accessory package (P/N 60-5239-012) includes a Waste Tube
Assembly (P/N 60-5234-187). To connect the Waste tube:

1. Connect the cut end of this assembly to the Diverter Valve
Waste port on the system:

a. locate the black nut and ferrule in the accessory
package. Slide the nut and ferrule onto the tubing as
shown in Figure 3-3.

Ferrule Tubing
Nut

Lih
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Figure 3-3 Preparing a bulkhead fitting connection

b. Fully insert the tubing into the threaded bulkhead
fitting on the back panel of the system.

c. Finger-tighten the nut onto the threaded bulkhead
fitting. This will seat the ferrule in the fitting.

2. Route the tubing and insert the weighted end into the
user-supplied waste container.

3.6 Connect and Route Drain Lines

/A WARNING

Risk of fire or equipment damage. Failure to connect drain lines
may allow organic solvents to pool in unsafe areas, creating a
potential for dangerous levels of flammable vapors. Improper
draining may damage the instrument’s internal components.
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The CombiFlash Rf 150 system has drain tubes extending
from its top shelf and back panel. The tubes drain away any
liquid spilled on the top shelf and the tray beneath the fraction
collection racks.

1. Test the fraction collector drain by connecting a vacuum or
air supply source to the outlet end of the drain tube. Then,
verify the presence of such vacuum or air supply source on
the drain (Figure 3-4).

Vacuum or
L~ pressurized air
applied to the outlet
end of the drain
tube must exist at
= the collection tray
L drain hole.
N

—

Figure 3-4 Fraction Collector Drain

2. Test the top shelf drain by connecting a vacuum or air
supply source to the outlet end of the drain tube. Then,
verify the presence of such vacuum or air supply source on
the drain (Figure 3-5).

3.Route the end of both drain tubes to a suitable waste fluid
collection container.

| M Note

It may be necessary to extend the drain tube. If so, splice the
tubing with user-supplied tubing. The user-supplied tubing should
have an inside diameter no smaller than the existing drain tubing,
and must be compatible with the solvents used by the system.
Route this extension tubing to the waste collection vessel.
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L— Vacuum or
pressurized air
applied to the outlet
end of the drain
tube must exist at
the top shelf drain
hole.

\\

Figure 3-5 Top Shelf Drain

3.7 Position the System

After completing the various connections, the system can be
moved to its operating position. Turn the system so that the
operator can access all of the front view features and controls
(Figure 1-7). Use care not to damage the connections, tubing,
and cables while moving the system.

/\ CAUTION |

Ensure that the CombiFlash Rf has at least 3 cm (1.25") of air
space behind it for ventilation.

Position the solvent and waste containers as necessary.

| M Note

When using higher-density solvents such as dichloromethane
(DCM), place the solvent container level with or above the
CombiFlash Rf system. Placing solvent containers below the level
of the Rf can contribute to decreased flow due to the high vapor
pressure of DCM. This problem becomes more pronounced as the
ambient temperature increases.
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3.8 Install Collection Tube Racks

Before beginning a run, you must load collection racks with
tubes onto the system’s fraction collector tray.

Your system was shipped with two collection tube racks. The
following tube rack sets are available:

60-5237-013 — Two racks for 13 x 100 mm test tubes
(8 mL). Total tubes: 216.

60-5237-061 — Two racks for 16 x 100 mm test tubes
(14 mL). Total tubes: 150.

60-5237-031 — Two racks for 16 x 125 mm test tubes
(15.5 mL). Total tubes: 150.

60-5237-032 — Two racks for 16 x 150/160 mm test
tubes (18 mL). Total tubes: 150.

60-5237-033 — Two racks for 18 x 150 mm test tubes
(25 mL). Total tubes: 140.

60-5237-034 — Two racks for 18 x 180 mm test tubes
(30 mL). Total tubes: 140.

60-5237-035 — Two racks for 25 x 150 mm vials (50
mL). Total vials: 60.

60-5237-040 — One rack for twelve 480 mL French
square bottles.

60-5394-469 — Two racks for 20 mL (28 x 61 mm)
scintillation vials. Total vials: 54.

60-5394-468 — Two racks for 40 mL (28 x 95 mm)
scintillation vials. Total vials: 54.

3-10
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To load the racks:
1. Insert test tubes, vials, or bottles into the rack (Fig. 3-6).

Figure 3-6 Loading test tubes

| /\CAUTION

Risk of broken glass or equipment damage. Do not load test tubes
longer than the length listed on the rack label.

2. While holding the rack with the rack label visible (Figure
3-7), insert the racks into the system. Slide the rack in
until you feel it drop into its seated position.

Figure 3-7 Inserting the collection tube rack

EAR99 Technology Subject to Restrictions Contained on the Cover Page 3-11



CombiFlash® Rft User Manual

/\CAUTION |

An incorrectly installed rack will cause the rack to be misaligned
under the fraction collector arm. Misaligned racks might cause
fractions to miss the tube opening or deposit in the wrong tube.
Always ensure the tube size label is visible (that is, facing outward)
and the rack is pushed in until it is seated.

3.9 Turn on Power

The system’s power switch is located just below the touch
screen panel.

1. Turn the switch to the ON position. The system will begin
its startup routine which includes self diagnostics.

2. Monitor the movement of the fraction collector arm. The
arm should move to the left rear corner of the fraction
collector area.

/N\CAUTION

You should not hear any grinding noises during the homing
sequence. If grinding is heard there is a problem with the homing
of the fraction collector arm. Contact the factory for assistance.

3.The system is ready for operation when the PeakTrak
screen is displayed.

3.10 Configure the System

Before operating the system, it should be configured for the
desired operation. To configure the system, open the
Configuration window by selecting Tools > Configuration from
the PeakTrak menu.

The configuration window has three tabs: Instrument
Configuration, Network Configuration, and User Preferences.
Network Configuration settings are discussed later in
Section 7, REMOTE INTERFACES.

Adjust the following (sections 3.10.1 through 3.10.6) on the
Instrument Configuration and User Preferences tabs for the
desired operation and then click OK to save the settings.

Some configuration settings do not take effect until the system
is restarted. After completing sections 3.10.1 through 3.10.6,
follow the instructions in section 3.10.7.

3-12
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3.10.1 Solvents

When you installed the system, up to two solvents were
connected to the back panel. This section of the Instrument
Configuration tab allows you to name these solvents. To do so:

| M Note

The system is shipped with common solvent names already
loaded. If your solvent names are listed in the solvent drop-down
list boxes on the main window, skip these steps.

1. Click the “Add Solvent” button.
2. Enter the solvent name and click the OK button.
3. Repeat steps 1 and 2 for both solvents.

3.10.2 General Settings

CombiFlash Rf Name (optional) — Use this option to name
your system. The name will appear in operational displays
and run summaries. This feature is useful when your
laboratory has more than one CombiFlash Rf system.

Time Zone — Select your time zone from the drop-down list
box.

3.10.3 Set Date/Time

Click this button to open a window from which you can set the
system date and time.

To prevent unauthorized time changes, this feature is
password protected. The system is shipped with the password
set to combiflash. Use the Tools>Set Password menu
command to change this password for greater security.

3.10.4 Vapor Limit (Optional)

The system has internal vapor The sensor detects vapors
present in the immediate atmosphere. When the limit is
exceeded, the CombiFlash Rf will shut down to avoid a
hazardous condition.

Teledyne Isco recommends using the default setting of 25.
This value represents an organic vapor level slightly above the
ambient vapor level of a well-ventilated laboratory.

A setting below 25 could cause random alarms without
significant vapors present. If PeakTrak displays a Vapor Limit

EAR99 Technology Subject to Restrictions Contained on the Cover Page 3-13



CombiFlash® Rft User Manual

alarm while the Vapor Limit is set at 25, perform the following
checks on your laboratory and the instrument:

¢ Ensure that no open containers or spills of organic
solvent are in close proximity to the system.

¢ Ensure that the system is located in a well-ventilated
area.

e Ensure that there is no visible solvent leakage from the
system.

If PeakTrak continues to display the Vapor Limit alarm after
you have made these checks and corrected any problems
found, it is likely that organic vapors are present in the ambi-
ent environment of your laboratory. In this case, increase the
setting of the Vapor Limit. Settings greater than 25 are appro-
priate for laboratory environments with a somewhat elevated
background solvent vapor concentration, representing a safe
setting, but one with a reduced margin for error.

3.10.5 Set Default Tube Volumes
Click this button to open a window from which you can set the
default volume of the collection tubes. You can increase or
decrease these values to set the desired default volume
collected in each container. Just be sure you don’t overflow the
containers by exceeding their capacity.

The system will automatically advance to the next tube when
this default volume is met in each tube. Keep in mind that
advanced method settings (discussed in Section 5 and the
on-line help) may override this default setting. During a run,
other factors such as automatic tube advances for detected
peaks will affect collected volume.

3.10.6 User Preferences

View the User Preferences tab to configure system operation
for the current user.

| M Note

New systems will only have one user account named “common.”

Language — Select the user’s desired language from the
drop-down list box.
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Automatically Print Report at End of Run - if this option
is enabled, the system will print a report at the end of each
run.

| & Note

This option requires the system to be configured for network
operation and a connection to a printer on the network. Network
settings are discussed in Section 7, REMOTE INTERFACES. Do not
select this option for these initial installation steps.

Default Run Units — Run units are displayed along the
X-axis of the chromatogram. Select Time (in minutes) or
Column Volumes. A column volume unit is the time it takes to
pump enough solvent to exchange the volume held by the
column. The duration in minutes will vary according to the
column media and size, and the flow rate.

Gradient Method — Select the standard gradient type
(Figure 3-8).

e Linear — The system gradually mixes solvents A and B
from the last programmed %B until it reaches the next
programmed %B. This method connects the inflection
points that define the gradient with a straight line.

e Step — The system holds each %B value until it reaches
the next programmed %B. Because the system holds the
%B values, the changes at each new value are nearly
instantaneous, producing a stepped appearance on the
plot area.

e Isocratic — The system holds the initial solvent mix for
the entire run.

I

Linear Step Isocratic

Figure 3-8 Gradient types
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Enable Run Length Extension — When enabled, this option
automatically extends the run if a peak is eluting at the end of
the maximum %B gradient. This ensures that a late-eluting
peak fully comes off the column and is collected.

An automatic run extension is a five-minute isocratic hold
added to the end of the run’s maximum %B gradient profile.
During the extension, the system continues to pump the
maximum %B solvent mixture. Should the system still detect
a peak after an extension, the system will add another, up to a
maximum of three extensions.

Occasionally, compounds might come off the column once the
%B returns to the minimum value at the end of a run. If the
Run Length Extension is enabled, it will automatically extend
the run one time to clear the column and plumbing of any
remaining material.

Original method . Extension 2 . Final Extension[
Extension 1 Extension 3 B
[ e e e e e e e e e e T N
0 5 10 15 20 25
Minutes

Figure 3-9 Automatic Run Extension Examples

Figure 3-9 illustrates the possible run extensions. The original
method was programmed to rise to the maximum %B over
seven minutes, hold for two minutes and return to the
minimum %B for a final minute. At nine minutes, a peak was
eluting. The system extended the run, holding the %B at the
maximum level for another five minutes. This also occurred at
fourteen and nineteen minutes, resulting in the second and
third extensions. At 24 minutes, the %B solvent strength
returned to zero. Before the final minute elapsed, more
compound was detected, causing the system to extend the run
for a final five minutes at the minimum %B.

3-16
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Enable rapid equilibration — select this option to
equilibrate the column at a high flow rate.

| M Note

Due to the high pressure that is possible during rapid equilibration,
this option may not be desirable for some column media or
purification methods.

3.10.7 Restart the system

Some configuration settings do not take effect until the system
is restarted. After completing sections 3.10.1 through 3.10.6
restart the system:

1.If the Configuration window is not closed already, click the
OK button to close it.

2. Place the Power switch below the LCD display in the Off
position and wait one minute or more.

/N\CAUTION

Always wait at least one minute after placing the Power switch in
the Off position. Moving the switch to the Off position begins a
power down sequence that takes up to one minute to complete. If
you move the switch to the ON position before the sequence is
complete, the system may not start up correctly.

/N\CAUTION

Except during an emergency, never remove AC power
immediately after placing the Power switch in the Off position. The
power down sequence includes file maintenance that takes up to
one minute to complete. Interrupting the file maintenance may
corrupt files causing abnormal operation or a complete system
failure.

3. After one minute or more, place the Power switch in the On
position.

4. The system is ready for operation when the PeakTrak
screen is displayed.
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3.11 Prime the Solvent Lines

Before the first use, the system should be primed. Ensure that
the solvent containers are filled, then:

1. Select the “Tools>Auto prime” menu command.
2. Click the Play button to start priming the system.

The system pumps 100% Solvent B through the system and
out the Waste port, and then repeats with 100 % Solvent A.
(This B-A order leaves the internal lines filled with solvent
appropriate for the beginning of a purification run.)

| M Note |

When priming the first time, inspect the solvent and waste
connections to the system. If any leaks are observed, click the
Cancel button to stop the Auto Prime. Correct the leak by
tightening the fitting an additional Y/ turn, and then restart the Auto
Prime from step 1.

To advance to the next Auto Prime step, you can click the
Fast Forward button. The Auto Prime window closes when
finished.

After Auto Priming, the system is ready for operation
(Section 5).

Use the Auto Prime feature for quick solvent changes by
pumping a fixed amount of solvent through the waste fluid
path at a high flow rate. For more advanced priming functions
such as varying the flow rates, fluid paths, etc., use the
Tools>Manual Control option.

3.12 System Verification

It is recommended that the system operation be verified. To do
S0, use a pre-packaged CombiFlash Rf test kit:

¢ Part number 60-5237-050 — Test kit containing five of
the 5 gram size solid load cartridges pre-filled with 0.5
grams of test sample NPHE, five 4 gram RediSep Rf
silica gel columns, and instructions.

e Part number 60-5237-051 — Test kit containing four of
the 25 gram size solid load cartridges pre-filled with 0.5
grams of test sample NPHE, four 4 gram RediSep Rf
silica gel columns, and instructions.
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3.13 Installation Qualification Checklist

Table 3-1 Installation Qualification Checklist

Installer Operator
Step | Description Initials Initials
3.1 UNPACKING THE UNIT
3.2 INSTRUMENT LOCATION

3.3 CONNECT POWER

3.4 CONNECT SOLVENT LINES

3.5 CONNECT WASTE LINES

3.6 CONNECT AND ROUTE DRAIN
LINES

3.7 POSITION THE SYSTEM

3.8 INSTALL COLLECTION TUBE
RACKS

3.9 TURN ON POWER

3.10 | CONFIGURE THE SYSTEM

3.1 RESTART THE SYSTEM

3.12 SYSTEM VERIFICATION

Certification of Section 3 Completion

Installer Name (print):

Installer Signature:
Date:

Operator Name (print):

Operator Signature:
Date:

Comments:
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Section 4 Preparation:
Optional 4x Module

This section provides instructions for unpacking and installing
the CombiFlash Rf 4x module after completing the
CombiFlash Rf" or Rff Lumen system installation (Section 2).
To prepare the system for operation, sequentially follow all
instructions in sections 4.1 through 4.10.

| M Note |
Section 4.12 contains an Installation Qualification checklist. If
required, sign off the checklist entries as you successfully
complete the following sections.

| M Note
The optional 4x module is not compatible with the CombiFlash
Rf 75 system.

4.1 Unpacking the Unit

The CombiFlash Rf 4x module is shipped in a single carton.
Carefully unpack the shipment and inspect the contents. If
there is any damage to the shipping carton or any components,
contact the shipping agent and Teledyne Isco (or its
authorized representative) immediately.

/A WARNING

If there is any evidence that the system has been damaged in
shipping, do not plug it into AC power. Contact Teledyne Isco
or its authorized representative for advice.

Compare the contents of the boxes with the enclosed packing
slips. If there are any shortages, contact Teledyne Isco
immediately.
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4.2 Instrument Location

The CombiFlash Rf system requires approximately 1550
square centimeters (240 in2) of level bench space. Ensure that
the CombiFlash Rf has at least 3 cm (1.25") of air space behind
it for ventilation. Additional space may be required for solvent
and waste containers.

The optional 4x expansion module is installed to the left of the
CombiFlash Rf system. If paired with the Rf* Purlon mass
spectrometer, the 4x expansion module must be installed to
the right of the Purlon. The 4x module requires an additional
933 cm? (145 in2) of level bench space. Ensure that the module
has at least 3 cm (1.25") of air space behind it for ventilation.

Refer to Table 1-4 for environmental conditions and power
requirements.

Before making any connections to the CombiFlash Rf 4x
module, place it on the bench or in the fume hood where it will
be operated. Temporarily position the system so you can
access the back panels to complete the connections.

4.3 Connect Power

Ensure that the On/Standby switch below the CombiFlash Rf
system touch screen panel is in the Standby position. Then,
use the supplied IEC power cord to connect the CombiFlash Rf
4x module to mains power.

/MN\WARNING

Mains power must meet the voltage, frequency, and amperage
requirements listed on the serial number label.

/AN\WARNING

As long as the AC mains power cord is connected, power is
inside the unit. The mains power cord is the disconnect device.
Position the CombiFlash Rf system and Rf 4x module so that
the power cord can be unplugged, or use a power strip where
the plug can quickly be removed from the outlet in the event
of an emergency.
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4.4 Connect Solvent Lines
/N\WARNING

Risk of fire ignited by electrostatic discharge. Never substitute
the black tubing on CombiFlash systems. The black tubing
(P/N 023-0503-06) is conductive. This tubing is required to
dissipate static electricity.

| /\ CAUTION

To prevent damage or premature wear to the pump and internal
valves, clean solvent should be used. The solvent should not

contain any dissolved solids.

The CombiFlash Rf system has four solvent ports on the left
side panel. To complete the solvent connections:

A B C© D
(1Y & & U

Front
o —

-
Figure 4-1 Labeled ports on CombiFlash Rf system side panel

4.4.1 Connecting the CombiFlash Rf with 4x Module
1. Remove the jumper tubing from ports A, B, C, and D.
2. Locate the solvent lines on the side of the Rf 4x module.

These lines are labeled A through D. Connect the solvent
lines to their respective ports on the CombiFlash Rf

system.
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4.4.2 Connecting the CombiFlash Rf with 4x Module and Purlon

1. Place the Purlon next to the Rf system, opposite the 4x

module. See Figure 4-2. The Rf* system is used as an
example only.

4x module Rf" Purlon

Figure 4-2 Component arrangement for connection with Rf system, 4x
module and Purlon

2. Connect the 4x tubing to the Rf, except for the tubing
marked “D”, according to CONNECTING THE COMBIFLASH
RF WITH 4X MODULE [4.4.1].

3. Connect the 4x tubing marked “D” to the shorter tubing
assembly from the coupling package, using the coupler, as
shown in Figure 4-3.
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Purlon

4x module

Figure 4-3 Coupler for connecting 4x tubing

4. Connect the other end of the shorter tubing assembly to the
tee fitting on the back of the Purlon.

5. Connect the longer tubing assembly to the “D” port on the
Rf and to the other side of the tee fitting on the back of the
PurlIon.

4.5 Connect Waste Lines

/MNAWARNING

Risk of fire or equipment damage. Failure to connect Waste
Port tubing may allow organic solvents to pool in unsafe areas,
possibly creating dangerous levels of flammable vapors.

/A WARNING

Risk of fire ignited by electrostatic discharges. Never
substitute the black tubing on CombiFlash systems. The black
tubing (P/N 023-0503-06) is conductive. This tubing is required
to dissipate static electricity.

| /\ CAUTION

Elevated flammable vapor levels are possible. Ensure that the
waste container is adequately ventilated, preferably by placing it in
a fume hood.

The Rf 4x module has six liquid waste ports on the back panel
(Figure 4-4):
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¢ one inlet to receive diverter valve waste from the
CombiFlash Rf system labeled Column Waste, From RF.

e four waste outlets —one for each column channel,
labeled Column Waste 1, 2, 3, and 4.

¢ one Valve Waste outlet shared by channels 2 through 4
for automatic injection valve cleaning.

The Rf 4x module can automatically detect full waste bottles
and stop operation to prevent overfilling a waste container.
This safety feature requires five air line connections:

¢ one Waste Level Sense From Rf inlet to receive air or
external gas from the CombiFlash Rf system.

e four Waste Level Sense outlets 1, 2, 3, and 4.

| M Note

The following instructions assume that the waste from each
channel will be isolated in separate containers.

WASTE @

LEVEL

SENSE
FROM RF

WASTE LEVEL SENSE
VALVE
WASTE
ouT
COLUMN
‘ ' . ' Gl

1 1O O |rrom
DISCONNECT SUPPLY RF
BEFORE SERVICING
MAINS 2 O
@
A B 3 O
© O .o

AN ®
!

Figure 4-4 Rf 4x Module back panel connections
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| M Note

If the waste is to be collected in a common container, skip the
Column Waste and Waste Level Sense connections (steps 1
through 7) and complete step 8 to route the Valve Waste Out from
the Rf 4x module to the common container. The waste tubing
assembly connected to the back panel of the CombiFlash Rf
system will route all waste fluids to the common collection
container and sense the level.

To complete the waste line connections:

1. At the waste container for the CombiFlash Rf system
(Channel 1), remove the black tubing that delivers Diverter
Valve Waste fluid and the natural tubing that delivers
Waste Level Sense air. The cap and black tubing from the
Inject Valve Waste should remain attached to the waste

bottle.

2. At the CombiFlash Rf system back panel, disconnect the
black tubing from the Diverter Valve Waste port and the
natural tubing from the Waste Level Sense port.

IﬁNote

The Inject Valve Waste tubing must remain connected between
the Rf system back panel and its waste container.

Refer to Figures 4-5 and 4-6 for steps 3 and 4.

3. Locate the 20 inch (50 cm) long Column Waste Assembly
(P/N 60-5234-192) in accessory package 60-5239-008.
Connect this tubing between the CombiFlash Rf system

and the Rf 4x module:

a. Connect the cut end of the black tubing to the
CombiFlash Rf system Diverter Valve Waste port. Use a
black nut and ferrule from the accessory package.
Finger-tighten the nut to seat the ferrule in the

bulkhead fitting.

@
2 s 2
g2
|_

T
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Figure 4-5 Preparing a bulkhead fitting connection

b. Connect the other end of the black tubing to the Rf 4x
port labeled “From Rf” (in the block labeled “Column
Waste”). Finger-tighten the threaded fitting.

4. Locate the 20 inch (50 cm) length of natural tubing from
the accessory package. Using nuts (60-0923-015) and
ferrules (60-0923-017), connect this tubing between the
CombiFlash Rf system’s Level Sense port and the Rf 4x
module’s Waste Level Sense From Rf port.

Level Sense
Waste Solvent (air)

Figure 4-6 CombiFlash Rf system to Rf 4x waste tubing connections
(all other connections not shown)
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To Rf 4x Module To Rf 4x module
Waste Level Sense Column Waste connections
connections 1, 2, 3, or4—‘ 1,2,3,0r4

Channel 1 Only:
To Rf system
Inject Valve Waste

60-0923-017 Ferrule

60-0923-015

Compression Fitting See step 8 for details on
Nu

this connection for
channels 2 through 4.

60-5234-188
Waste Line Assembly

Ventilation Hole
(Luer fitting)
If necessary, connect

(See Top View) user-supplied tubing and
Tubing Stop route to fume hood.
(ferrule)

60-5235-053 38 mm Waste Cap, or
60-5235-054 45 mm Waste Cap

(Top View)

Column Waste
Waste Level Sense with tubing stop © G Ventilation

Inject Valve Waste (Rf*)
or Valve Waste Out (Rf 4x)

Figure 4-7 Recommended Rf 4x module channel 1 waste connections
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5. Select one of the four waste line assemblies (PN
60-5234-188) from the accessory package. This will be used
to complete the waste connections for channel 1 as shown
in Figure 4-8.

| M Note

These instructions assume that the column waste from each
channel will be isolated in separate containers. If the waste is to be
collected in a common container, omit the use of the waste caps
and secure all liquid and air lines in the common container. The
ends of all air lines should extend at least 2 inches (5 cm) below
the container opening.

a. At the Rf 4x back panel, connect the threaded fitting on
the waste line assembly to the Column Waste port
labeled “1.”

b. At the Rf 4x back panel, connect the natural tubing of
the waste line assembly to the Waste Level Sense port
labeled “1.”

c. At the CombiFlash Rf system back panel, the black
tubing should still be connected to the Inject Valve
Waste port (from step 1). If not, reconnect the tubing.

d. At the waste container cap for channel 1, insert the
black tubing into the Diverter Valve Waste opening.

e. At the waste container cap for channel 1, insert the
natural tubing into the Waste Level Sense opening
(Figure 4-7). Push the stop (ferrule) on the Waste Level
Sense tubing against the cap. This ensures that the
Waste Level Sense tubing is far enough into the
container to detect when it is nearly full.

f. At the waste container cap for channel 1, insert the
black tubing from the Inject Valve Waste port. The
completed waste connections for Channel 1 are shown in
Figure 4-8.

6. Using one of the three remaining waste line assemblies
and waste caps, complete the waste connections for channel

2 as shown in Figure 4-9.

7. Using the three remaining waste line assemblies and waste
bottle caps, complete the waste connections for channels 2
through 4 as shown in Figure 4-9.
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(All other connections
not shown)

To
Waste
Bottle 2

Bottle 3 Bottle 4

Figure 4-9 Channels 2 through 4 waste tubing connections

8. The post-run valve cleaning fluids share a common port for
channels 2 through 4. Select the 48 inch (120 cm) length of
black tubing from the accessory package and connect it to
the Valve Waste Out bulkhead fitting on the Rf 4x module.
Route the other end of this tubing to one of the waste
bottles. (The channel 2 waste bottle is shown in
Figure 4-10.) You can alternatively route it to a container
other than those used for channels 2 through 4, however
the system will not be able to detect the level and prevent
overfilling.
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£

To Waste

Bottle 2 @

Figure 4-10 Valve Waste Out routed to Channel 2

@Note

When using higher-density solvents such as dichloromethane
(DCM), ensure that waste containers are no more than 3 feet
below the supply solvent levels. Placing solvent containers above
the system and waste containers on the floor may cause the
internal check valves to open and allow solvent to flow through the
system when in the standby state.

[ M Note

The Rf 4x back panel ports labeled A and B are not used.
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4.6 Control Connection
Operation of the Rf 4x module is controlled by the CombiFlash

Rf system via USB connection. Connect the USB cable from
the Rf 4x module to USB port on the system back panel.

| M Note

If using the Rf 4x with the Rf* Purlon system, an additional USB
hub must be supplied by the user; it is not included with the
system.

4.7 Position the System

After completing the fluid, air, and control connections, the
system can be moved to its operating position.

| /\CAUTION

Use care not to damage the connections, tubing, and cables while
moving the system.

1. Turn the CombiFlash Rf system so that the operator can
access all of the front view features and controls (Figure
1-7).

2. Position the Rf 4x module along the left side of the
CombiFlash Rf system.

3. The Rf 4x module has a tab extending from the right side of
its base plate. Slightly raise the CombiFlash Rf system and
slide the Rf 4x module so that the system will rest on the
module’s tab. The weight of the CombiFlash Rf system on
the tab will hold the two together.

4.8 Remove Shipping Hardware

To prevent damage to the injection valve assemblies during
shipping, each is secured by a thumbscrew which must be
removed before operating the system. Firmly grasp the
cartridge guide above the injection valve and then remove the
thumbscrew (Figure 4-11). Gently lower the injection valve
once the thumbscrew is removed.

| M Note

Save the thumbscrews should there be a need again to stow the
valves for shipping.
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@ Thumbscrew
/ (one of three)

Figure 4-11 Remove thumbscrews

4,9 Turn on Power

Turn the CombiFlash Rf system switch to the ON position.
The system will begin its startup routine which includes self
diagnostics. During the startup routine, the system will detect
the connected Rf 4x module and automatically configure the
user interface to access the additional channels. The system is
ready for operation when the PeakTrak screen is displayed.
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4.10 Prime the Solvent Lines

The Rf 4x module was factory tested with 1:1 water/isopropyl
alcohol and subsequently purged with air. If residual fluids
would affect your chromatography, prime all channels on the
system.

Channel 1 should have been primed during the installation
steps in Section 2.14 (page 2-27). Channel 1 can be primed
using the Auto Prime menu command.

Channels 2 through 4 must be primed using the Manual
Control menu command. To do so:

1. Ensure that the solvent containers are filled.

2. Insert a priming tube assembly (from the accessory
package) between the upper and lower column mounts on
channels 2 through 4.

3. Select the “Tools>Manual Control” menu command.
4. Select the Column 2 the channel option.

5. Click the Prime B button. The system pumps 100% solvent
B through channel 2.

| M Note

When priming the first time, inspect the solvent and waste
connections to the system. If any leaks are observed, click the
Cancel button to stop the pump. Correct the leak by tightening the
fitting an additional V4 turn, and then restart the prime.

6. Allow the system to pump solvent B for at least 3 minutes.
Then, click the Cancel button.

7.Click the Prime A button. The system pumps 100% solvent
A through channel 2.

8. Allow the system to pump solvent A for at least 3 minutes.
Then, click the Cancel button.

| M Note

This B-A order leaves the internal lines filled with solvent
appropriate for the beginning of a purification run.

9. Repeat steps 4 through 8 for channels 3 and 4. Be sure to
change the channel option before starting the pumps.
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4.11 System Verification

It is recommended that the system operation be verified for
each channel. To do so, use a pre-packaged CombiFlash Rf test
kit:
¢ Part number 60-5237-050
Test kit containing five of the 5 gram size solid load
cartridges pre-filled with 0.5 grams of test sample
NPHE, and five 4 gram RediSep Rf silica gel columns.

¢ Part number 60-5237-051
Test kit containing four of the 25 gram size solid load
cartridges pre-filled with 0.5 grams of test sample
NPHE, and four 4 gram RediSep Rf silica gel columns.

¢ Part number 60-5234-626
Test mixture supplied in the Purlon accessory kit,
containing 10 g of MSD test mix

® Part number 60-5234-315
Test mixture supplied with APCI probes, 5 mL

e Part number 60-5234-627
Test mixture supplied with ESI probes, 10 mL

The test kits include instructions.
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4.12 Installation Qualification Checklist

Table 4-1 Installation Qualification Checklist

Installer Operator
Step | Description Initials Initials
41 UNPACKING THE UNIT
4.2 INSTRUMENT LOCATION

4.3 CONNECT POWER

4.4 CONNECT SOLVENT LINES

4.5 CONNECT WASTE LINES

4.6 CONTROL CONNECTION
4.7 POSITION THE SYSTEM
4.8 REMOVE SHIPPING HARDWARE

4.9 TURN ON POWER

410 PRIME THE SOLVENT LINES

4.1 SYSTEM VERIFICATION

Certification of Section 4 Completion

Installer Name (print):

Installer Signature:
Date:

Operator Name (print):

Operator Signature:
Date:

Comments:
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Section 5 Operation

This section provides abbreviated operating instructions for
the CombiFlash Rf systems. For complete instructions, refer to
Help menu option from PeakTrak’s main menu.

5.1 Flash Sample Preparation

Before starting a run, consider how the sample will be
introduced to the column media. This section discusses three
methods: liquid injection, solid sample cartridges, and
pre-loading the sample on the column.

5.1.1 Liquid Sample Injection
If the sample is soluble in the starting mobile phase, it can be
prepared as a solution and injected onto the column when
prompted during the purification run.

5.1.2 Solid Samples

Some compounds are not soluble in solvents that are
compatible with the chromatography. In addition, the
compounds may have very limited solubility in any solvent,
resulting in sample volumes that are impractical for good
chromatography. The answer in this case is solid sample
introduction. Here the reaction mixture or dissolved sample is
mixed with the same media in the chromatography column.

Some samples of this type may be simply dissolved and placed
into a prefilled cartridge. You can then use the cartridge
immediately or dry it before placing it on the system.

Other samples may need more care. Typically you would
create a mixture of 20% sample load to media (w/w). Then dry
the mixture under conditions that will drive off the solvent
without affecting the compounds of interest. These compounds
remain bound to the media. Once dried, pour the
media/sample mixture into an empty cartridge.
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To prepare an empty solid sample cartridge:

1. Ensure the empty cartridge has a bottom frit.

/N\CAUTION

Missing frits may cause equipment damage, UV detection
problems, or increased maintenance. Frits prevent solids from

entering the fluid path.

2. Prepare the media and sample:

a. Dissolve your sample in a minimal amount of a
suitable, volatile solvent.

b. Place the media into the solvent. If using silica gel, a
particle size of 40-60 pm (240—400 mesh) is
recommended. The amount of silica required is about
four to five times the mass of your sample.

c. Agitate the solvent for a moment to allow the sample
to adsorb to the silica.

d. Remove the solvent with a suitable method, such as
rotary evaporation. Alternatively, you can dry the
prepared cartridge after step 5 by drawing the
solvent out using a vacuum or using the Rf* system’s
air purge.

3. Load the media and sample mixture into the cartridge. Tap
the cartridge on the bench top to settle the mixture.

4. Place a frit on the top of the cartridge. Force the frit down
against the mixture using the plastic plunger.

5. Wipe any residual powder inside the neck of the cartridge.

| M Note |
On Rf* systems, including those equipped with 4x, you can
remove solvent from a prepared cartridge by attaching the
cartridge cap and manually purging (TOOLS>MANUAL CONTROL)
the cartridge with air.

Empty solid sample cartridges also allow a variety of
adsorbents, such as diatomaceous earth, boiling chips, cotton
balls, or paper wipes. Even with alternative adsorbents,
always use top and bottom frits to prevent fluid path
problems.
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After you have prepared the pre-filled or empty cartridge,
place the solid sample cartridge on the system:

1. Attach the desired adjustable cartridge cap:
e 60-5237-047, fits 2.5 and 5 gram solid load cartridges.

* 60-5237-048, fits 12 and 20 gram solid load
cartridges.

e 60-5237-044, fits 32 and 65 gram solid load
cartridges.

2. Press the lever on the side of the cap and fully extend the
plunger (Figure 5-1).

Figure 5-1 Press the lever and extend the plunger

3.Slide the plunger into the cartridge until it reaches the top
frit (Figure 5-2).

4. Press the lever and push the cartridge into the cap. Align
the cartridge so that it fits fully into the recess in the cap
(Figure 5-3).

5. Load the solid sample cartridge with cap on the sample
injection port.
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Figure 5-2 Insert the plunger to the bed

Figure 5-3 Align and push cartridge into the cap, and then rotate the
cartridge to secure it.
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5.1.3 Pre-loading on Column
You can load the reaction mixture or sample directly onto the
column, sometimes called “direct” or “dry” loading.

| M Note

If using this method, use care to ensure that a column equilibration
does not wash away the sample. Bypass the column equilibration
at run time by selecting “Preload on column” (or “No Equilibration”
for Rf 150 systems) as the sample Loading Type. Refer to Section
5.3 for more details.

5.2 Loading a RediSep Rf Column
To load a RediSep Rf column:

/A WARNING

The CombiFlash Rf has redundant safety devices to limit
pressure to less than 210 psi (1448 kPa). RediSep columns
smaller than 100 g are CE certified using standard IEC61010-1
for use on the CombiFlash Rf. RediSep columns larger than
100 g meet Pressure Vessel Directive 97/23/EC. Teledyne Isco
strongly recommends against the use of columns rated less
than 210 psi (1448 kPa).

| M Note

For best results, always use RediSep Rf columns. The system will
not automatically detect other columns. The system also limits the
maximum operating pressure to 50 psi when the column is not
detected.

1. Select a RediSep Rf column. The on-line help includes a
column selection guide that can assist you in selecting a
stationary phase media and column size.

2. Raise the injection valve (column mount for Rf 150
systems) and insert the column into the top column mount.
Note that the column fittings are keyed to ensure the
correct flow direction.

3. Slowly lower the injection valve while aligning the bottom
column fitting. The spring-loaded injection valve will hold
the column in place.
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4.To seal the column fittings, give the column a slight twist
(Y4 turn).

| M Note

After loading a RediSep Rf column, the system (with the exception
of the Rf 150) will use RFID technology to automatically detect the
media type and column size. PeakTrak displays the detected
column size on the Main and Method Editor windows. If the
system does not detect the column, manually select the column
media and size.

5.3 Start a Default Method

After completing the system installation steps (Section 2
through 4, as necessary), preparing the sample, and inserting
the column, you are ready to perform a run with the default
method. The system’s default methods are factory-set with run
parameters typically used by chemists. Default methods are
optimized for the use of RediSep Rf columns. The default
settings will:

e collect all fluid in the fraction collector rack

e differentiate between UV (254 nm) vs. non-UV absorbing
fluid and place the fluids into separate tubes

e cut UV absorbing peaks based on slope detection or level
threshold.

To start the run from the PeakTrak Main window:

1. Enter a sample name. If you choose not to, PeakTrak will
enter the date and time as the sample name when you start
the run.

2. Review the PeakTrak Main window settings. If you want to
change any settings, refer to the Editing a Method on-line
help topic.

3. Click the Play button.

4. Select the sample Loading Type from the list. This Loading
Type should support the sample preparation you chose in
Section 5.1. Possible sample loading types for the Rft, Rf
Lumen and Rf 4x systems are:

¢ Solid (Pause) — Select this option if you intend place
the sample into a solid sample load cartridge, but
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have not yet prepared the sample. You must also
specify the cartridge type and size (Column plan
subscribers only). When you click the run button, the
system will perform a column equilibration and then
wait while you prepare the cartridge. After you have
placed the cartridge on the system, click OK to
continue with the run.

e Solid — Select this option if you have prepared the
sample and placed it into a solid sample load
cartridge. You must also specify the cartridge type
and size (Column plan subscribers only). The system
will proceed automatically until the end of the
programmed run length.

e Liquid - Select this option if you have prepared a
liquid sample and plan to manually inject it into the
injection port after column equilibration.

¢ None (on column) — Select this option if you have
pre-loaded the sample on the column. The system will
skip column equilibration so that the sample will not
be flushed from the column before the run.

Loading Type options for the Rf 150 system are:

¢ Equilibration — Select this option if you intend to
equilibrate the column before introducing the liquid
or solid sample.

¢ No Equilibration — Select this option to skip column
equilibration.

5.Review or update the Start Rack and Start Tube.

6. Review the Minimum Run Requirements. The system will
report the estimated solvent volumes, expected waste,
collection tube usage, etc. You can use this information to
verify that there will be enough solvent to complete the
run, the waste volume does not exceed the collection
container’s capacity, and whether or not more tubes will be
required during the run.

| M Note

The Rf* systems, including those equipped with 4x, estimate the
solvent volumes by monitoring the solvent level in the container
and the known usage rate. The systems continue to refine this
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estimate during operation. Solvent level sensing is not available on
the Rf 150 system.

@Note

If the waste level sensing tube is inserted correctly into the waste
container, Rf* systems, including those equipped with 4x, will
automatically suspend operation before an overflow condition
might exist. To prevent the run from being suspended before
completing the run, ensure that the container will hold the
expected waste volume. Waste level sensing is not available on
the Rf 150 system.

7. (Rft Lumen) If the ELSD will be used for the run, ensure
that the ELSD option is selected. Otherwise the ELSD may
be disabled. The Rf* Lumen system will automatically
check this option if the previous run used the ELSD.

@Note

If you typically use normal phase solvents and the ELSD P-trap
drain fluid hasn’t been replenished recently, you may need to
ensure the P-trap is full for maximum ELSD signal strength. This
can be done by lifting the drain line above the instrument and
placing 10 ml of isopropyl alcohol in the drain line. Lift the line
sufficiently that the fluid flows into the P-trap drain. Then place into
a waste container so that the excess fluid can drain out of the trap.
If you normally use higher boiling point solvents such as water, the
P-trap will typically remain full and will not require replenishment.

| M Note

If you are using a silica flash column and your solvent exceeds 7.5
pH, the ELSD should not be used. Basic conditions can dissolve
silica. When the solvent with dissolved silica is evaporated in the
ELSD, silica can build up over a period of time and eventually clog
the ESLD, resulting in an expensive repair. Sample build up in the
spray chamber is less of a concern since it is sent to the chamber
in smaller quantities only during the peak and is more easily
cleaned from the chamber during regular cleaning (see
Chromatography Technical Note TN21, Preventative cleaning of
the ELSD detector).
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8. Click OK and the run begins. The system responds
according to the sample Loading Type selected in step 4.

Rf* systems, including those equipped with 4x —

e If you selected Solid (Pause), the system
equilibrates the column with the starting %B and
then waits while you prepare the solid sample load
cartridge. Place the cartridge on the system and click
OK to continue.

e Ifyou selected Solid, the system equilibrates the
column and immediately starts the separation. The
prepared solid load cartridge should be in place
before clicking the OK button.

e If you selected None (on Column), the system skips
the equilibration and immediately starts the
separation. The sample must be on the column before
clicking the OK button.

¢ Ifyou selected Liquid, the system equilibrates the
column and then waits. When instructed, perform the
following steps:

a. Place the injection syringe on the injection port.
b. Slowly force the liquid into the injection port.

c. Chase the first injection with a second injection
solution of at least 0.25 mL. The chase solution can be
the starting mobile phase or diluted sample mixture.

d. Click OK to continue the run.

e Purlon Loading- (Purlon systems only) sets the
amount of sample sent to the mass spectrometer. Default
is “Medium”. Select “LOW” for highly loaded columns or
samples with a strong molecular ion to reduce
saturation of the mass spectrometer detector. Select
“HIGH?” for lightly loaded columns of samples with weak
detection on the mass spectrometer.

e DETECTION IONS- enter up to 4 ions, or a range and
up to 3ions. On Purlon S and Purlon L systems, the ions
may be a mix of positive and negative.

¢ Mass Spectrometer- (Purlon systems only) click this
button to enable mass spectrometer detection

EAR99 Technology Subject to Restrictions Contained on the Cover Page 5-9



CombiFlash® Rf* User Manual

¢ ELSD- click this button to enable the evaporative light
scattering detector (Lumen systems only)

Rf 150 systems —

e If you selected Equilibration, ensure that the

solvent delivery tubing is connected to the injection
port above the column. When you click the OK
button, the system equilibrates the column and then
waits. When instructed, perform a liquid injection as
described in steps a through d above, or attach the
solid sample cartridge to the injection port and
connect the solvent delivery tubing. Click the OK
button to continue.

If you selected No Equilibration, ensure that the
solvent delivery tubing is connected. The system
starts the run immediately and assumes that the
sample has been injected on the column or the solid
load cartridge is in place.

5.4 During the Run

You may allow system to proceed with the gradient while

monitoring the progress on the PeakTrak main window. If
desired, gradient parameters may be modified during the run.
(See the Real-time Gradient Editing on-line help topic.)

As the run progresses, the absorbance trace is drawn on the
Gradient Plot area. The separation or purification continues
until the end of the run defined by the run length setting.

During the run, data is automatically saved every few seconds.
PeakTrak automatically saves all run history on the system’s
internal hard drive in its native .RUN format. You can
manually save a Run file as Text or PDF while stopped or any
later time as long as the .RUN file has not been deleted.

Selected files can be manually saved to a connected Flash
drive. To automatically save a Text or PDF file after each run,
configure the Network File Save feature (see Section 7.1.3).

5.4.1 Run Control Buttons

¢ Play — The Play button starts the run. During the run,
other run control buttons are active.

e Pause — The Pause button holds the %B at the current
value while the system continues to operate (sometimes
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called an isocratic hold). Note that pausing the run
extends the run length. While in the Paused state, you
can resume the run by clicking the Play button, or stop
the run by clicking the Stop button. If you resume the
run, the system continues with the gradient curve at the
%B when the system was paused.

e Stop — The Stop button suspends the entire run.
Unlike the Paused state, the pump, peak detection, and
fraction collection will not operate. While stopped, you
can end the run by clicking the Rewind button, resume
the run by clicking the Play button, or skip the rest of
the run sequence by clicking the Fast Forward button.

| /\ CAUTION

(All Rf* Systems)— When the Stop button is pressed, solvent
remains in the tubing from the injection valve to the fraction
collector’s drop former. Follow the steps listed below, considering
your instrument’s configuration.

* Solid Sample Cartridge with air purge enabled:
If you suspend the run with the Stop button, do not remove
the column and/or solid sample cartridge without first
pressing the Fast Forward button to purge solvents from all
lines. If you stop the run because your peak of interest has
been collected, protect the next user from being sprayed by
solvents left in the lines by pressing Fast Forward so the
instrument purges itself and is safe for its next use.

* Solid Sample Cartridge with air purge NOT enabled,
i.e., purge time set to zero in Method Editor:
If you suspend the run with the Stop button, remove the
column and install the Prime Tube in place of the column.
Manually purge the Sample Cartridge by pressing Tools ->
Manual Control -> Air Purge Cartridge. Repeat this
procedure for Air Purge Column.

¢ Liquid sample loaded onto column with air purge
enabled:
If you suspend the run with the Stop button, remove the
column and install the Prime Tube in its place. Use the Fast
Forward button to ensure no sample is left in the flow cell
and fraction collection lines, possibly affecting subsequent
separations.
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¢ Liquid sample loaded onto column with air purge NOT
enabled:
If you suspend the run with the Stop button, remove the
column and install the Prime Tube in its place. Manually
purge the liquid lines by pressing Tools -> Manual Control
-> Air Purge Column.

e Next Tube — This button advances the fraction
collector to the next tube position. This allows you to
conveniently collect eluate of interest in a new tube.

| M Note

When you click the Next Tube button, the system immediately
marks the tube advance on the chromatogram. However, the
system delays the movement of the drop former over the tubes.
This delay accounts for the volume held in the tubing between the
detector and the drop former, sometimes called the “delay
volume.” It is important to remember that the chromatogram
displays activity in real time while the fraction collector activity lags
behind. The duration of this delay will vary with the flow rate.

* Rewind — This button is active when the system has
completed the run, or if the run was stopped by clicking
the Stop button. The Rewind button returns you to the
Main window with the current method.

If you have stopped the run before its programmed run
length has elapsed, clicking the Rewind button changes the
current method to the new, shorter run length. This modi-
fied method is ready for the next run, or can be saved for
future runs.

¢ Fast Forward — Click this button to jump to the next
step of a run.

Once you have started a run, the system performs several
steps. The first step is to deliver solvents using the pro-
grammed gradient for the entire run length. When this step
is complete, the system will purge the column with air and
clean the injection valve. Clicking the Fast Forward button
will cause the system to skip any remaining time in the
current step and advance to the beginning of the next step.
Unlike the Rewind button, clicking the Fast Forward but-
ton to complete the run will not modify the current
method’s run length setting.
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5.4.2 Bypassing the Solid Load Cartridge
(Rf* systems, including those equipped with 4x)
Occasionally, impurities precipitate in the solid load cartridge
as compounds are purified. This may cause high back
pressures resulting in reduced flow rates and long run times.
Clicking this button changes the injection valve position,
which removes the cartridge from the solvent path and
relieves the back pressure.

/N CAUTION
Bypassing the solid load cartridge too soon during the purification
run may leave desired compounds on the solid load cartridge.
After removing the cartridge from the fluid path, these compounds
cannot be purified.

If you need to use this feature, perform the following to ensure
that you do not leave desired compounds on the cartridge:

1.Run a TLC plate prior to starting the run. Measure the Rf
of the slowest eluting compound of interest. (The Rf should
be between 0.2 and 0.8 — the same range used by the
Gradient Optimizer [6.3.3]). Note the Percent B solvent
used to run the TLC plate. If a compound displays tailing
peaks as streaks on TLC, the Rf used corresponds to the
bottom of the streak.

2. Load the Sample in the Solid Load Cartridge and note the
cartridge size. Refer to list below to determine the cartridge
volume. If the cartridge is partially filled with silica, use
the cartridge volume as if the cartridge were completely
filled with silica.

e 5 gram cartridge = 10 mL volume
e 25 gram cartridge = 45 mL volume
e 65 gram cartridge = 110 mL volume

3.Run the sample and observe the flow rate from the Status
Bar in the upper right corner of the main window. As long
as the system is delivering the programmed flow rate,
there is no need to bypass the cartridge.

4.If the flow rate is slower than that programmed, note the
slowest displayed flow rate. Use the equation below to
determine if the cartridge can be bypassed.
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T = Cartridge Volume / (Rf * Flow Rate)

Where T is the time in minutes to wait after the system
reaches the %B solvent used to run the TLC plate; Rf is the
retention factor measured in step 1; Cartridge Volume is
the volume in mL from step 2; and Flow Rate is the current
flow rate in mL/min.

5. Observe the current %B concentration in the status bar.
Once the system reaches the %B percentage used for the
TLC, wait at least the time established as T. After this time
has elapsed it is likely that the desired compound has come
off the cartridge and you can safely click the Cartridge
Bypass button.

For example, a TLC plate run at 30%B revealed that the last
desired compound had an Rf factor of 0.35. An empty 25-gram
size solid load cartridge was filled with sample adsorbed onto
10 grams of silica, and then placed on the system. The
programmed flow rate was 60 mL/min. During the run, the
flow rate dropped to 30 mL/min. The equation is then:

T =45 mL /(0.35 * 30 mL/min) = 4.3 minutes

In this example, the Cartridge Bypass feature was used 4.3
minutes after the solvent gradient reached 30% B.

The calculation is conservative, but allows you to minimize the
time needed to keep the solid load cartridge in the fluid path.

5.4.3 About Solvent Level Detection

When enabled in the TOOLS>Configuration window,
CombiFlash Rff, Rf Lumen and Rf 4x systems will estimate
the solvent volume usage by measuring the solvent level in the
container and the monitoring the usage rate. The system
continues to refine this estimate of available solvent during
operation.

At the beginning of a run, the system calculates the amount of
solvent required to complete the run. The system will alert you
if it detects that there is not enough solvent at the start of the
run. Likewise, the system will alert you during the run if the
estimated usage rate or the measured level indicates that
there is insufficient solvent. Note that pauses and automatic
run extensions during a run will increase the required solvent
volume.
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The options available on the alert message will vary
depending on when the condition occurs (before or during a
run) and which method (measured level or estimated usage
rate) indicated the condition.

To clear the alert message, the user must select one of the
options below.

e Continue — Select this option after you have added
more solvent to the container. After selecting this option
the system measures the solvent level again. If the level
is sufficient to complete the run, the run continues. If
not sufficient, the system displays the alert message
again.

¢ Ignore — This option is available when the estimated
usage rates indicates that the solvent levels are
insufficient. Select Ignore to clear the message and
continue the run. The system then ignores the estimated
solvent usage rate for the remainder of the run, but
continues to measure the solvent level. Should the level
become insufficient, the system will display another
alert message.

e Disable — Select this option to turn off solvent level
measurements and estimated solvent usage rates for the
remainder of the run.

e Cancel — This option appears before the run is started.
Select this option to cancel the run and return to the
main window which will display the current method.
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5.5 EZ Prep Operation
Flash separations on the EZ Prep system are identical to those
performed on the Rf*. Preparative HPLC separations have the
same control capabilities as the flash separations with a few
minor differences.

5.5.1 Column Mounting

| M Note

HPLC columns that have less than 100 psi back pressure may not
function reliably on the EZ Prep. This may occur with columns
using 20 pm packing and low viscosity solvents such as hexane.

The HPLC column is mounted on the right side of the EZ Prep
system. Use of a guard column is recommended to protect and
extend the life of the HPLC column.

To install a guard column:

1. Remove the union installed on the preparative column
tubing on the right side of the instrument.

2. .Take the tubing supplied with the guard column and
connect it to the guard column outlet.

3. Connect the line that exits from the prep inject valve to the
guard column inlet.

4. Remove the cap on top of the column mounting tower by
grasping the tabs on the front and back of the cover.

5.Place the guard column in the top of the tower, orienting it
so that the inlet is towards the rear of the instrument. The
inlet and outlet tubing for the guard column can be placed
into slots provided in the tower.

6. Replace the cap on top of the tower.
7.Proceed with installing the preparative column.
To install a HPLC Column:

1. If not using a guard column, remove the union from the
tubing.

2. Lift the upper column mount up to allow the column to fit
in the mount.
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3. Locate the tubing which exits the right side of the
instrument through a union located near the bottom of the
instrument. Attach this to the outlet of the column and
feed the tubing into the slot of the lower column mount.

4. Lower the column fitting into the space in the column
mount.

5. Locate the tubing connected to the guard column outlet (or
inject valve if no guard column is used). Connect this
tubing to the preparative column inlet fitting and feed the
tubing through the slot of the column mount.

6. Lower the top column mount over the fitting. The tubing
passes through slots in the upper and lower mounts
allowing the tubing fittings to be captured in the holes in
the upper and lower mounts.

5.5.2 Sample Preparation

The HPLC sample must be prepared as a liquid. To prevent
sample loss to waste, the sample injection must not exceed %
of the injection loop volume of the EZ Prep. (Standard loop
volume is 5 ml. 1 and 10 ml loops are available.) The solvent
used to prepare the sample should be similar to the stating
conditions of the gradient if possible. If the sample is dissolved
in a solvent that is too strong, it can have negative effects on
the chromatography. The sample should be filtered with a 2
um filter or finer to prevent clogging of the HPLC column.

The loop will contain solvent from the previous separation.
Typically, reverse phase separations end with an organic
concentration between 50 and 80%. If your sample elutes at a
low percentage of organic, this remaining fluid in the loop can
affect the quality of your separation. This can be addressed by
flushing the high organic solvent from the loop before loading
your sample. Flushing the loop with at least 2 loop volumes of
water or minimal organic solvent will result in improved
separations in this situation. This also has the benefit of
rinsing any residue remaining in the injection port from
previous injections.

After injection of your sample, ~50ul of injection fluid will
remain in the lower port. To maximize sample recovery, a
small amount of suitable solvent should be used to push the
sample into the injection loop. An alternative injection port
fitting is available from Teledyne Isco. This alternative port
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requires an injection syringe to use a 22 gauge blunt needle
for injection. The adapter can be obtained as Teledyne Isco
PN/29-9125-060.

5.5.3 Starting the Separation

1. On the main screen, press the RediSep drop down.

2. Select the Prep HPLC Column from the drop down menu.
This loads the HPLC column that was selected as “Default”
in the configuration screen. The screen color scheme will
change to green signifying the HPLC portion of the
instrument will be used.

e If this is the desired column, simply press the PLAY
button to continue.

e If a different HPLC column is preferred, select the
RediSep drop down again, and select the desired
HPLC column, or select “Flash Column” to return to
flash operation.

3. The sample loading technique must be selected. LOAD NOow
assumes that your sample is ready for loading. If that is
correct, inject the sample into the HPLC inject port.
Remember that the sample volume should not exceed Y% of
the loop volume.

4.Then press the sample loaded button to start the
separation.

e If LOAD AFTER EQUILIBRATION is selected, the START
EQUILIBRATION button can be pressed to begin the
equilibration. This allows extra time to prepare the
sample while the column is being equilibrated. At the
completion of the equilibration phase, the system will
stop, prompting injection of the sample. After
acknowledgement of the sample injection the run will
continue.

e Operation now proceeds as described for a flash
separation. At the end of the separation, the flash
valve wash and column air purge are not performed.
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Section 6 User Help Reference

The CombiFlash Rf system includes User Help topics that are
available from the PeakTrak touchscreen or remote browser
window. This section contains many of these topics that
describe the PeakTrak interface and its use.

On-line Software Help benefits from linked text to navigate
through topics of interest—a feature not available in printed
manuals. For your convenience, linked text is displayed in
SMALL CAPITALIZED TEXT, followed by the section number in
brackets. Some topics are only available in the on-line help
format.

6.1 PeakTrak Overview

PeakTrak is the control software for Teledyne Isco’s
CombiFlash Rf system. This overview provides a description
of:

¢ The PEAKTRAK WINDOW ELEMENTS [6.1.1]
e The METHOD FILE [6.1.2]

e The RUN FILE [6.1.3]

e HOW TO GET PEAKTRAK HELP [6.1.4]

6.1.1 PeakTrak Window Elements
The MAIN WINDOW [6.3.1] displays the current METHOD FILE
i6.1.2]. From this window you can access many of PeakTrak’s
features, view the system status, and view or edit the method
file settings. The elements of the main window are the:

e Menu — The topmost item in the window is the
PEAKTRAK MENU OPTIONS [6.2] from which you can
access all of PeakTrak’s features.
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¢ System Status — PeakTrak displays the system status
to the right of the current method. Status messages may
include:

e system mode

e current position in a run, expressed in time or column
volumes

e current %B
e flow rate

¢ Main region — This area is where you can view or
modify method file settings. Frequently used method
settings are displayed on the MAIN WINDOW [6.3.1].
Advanced method settings are displayed on the METHOD
EDITOR [6.3.2] window.

Many of the PEAKTRAK WINDOWS [6.3] contain these main
elements, or a subset of them. Note that the available
commands and options will change according to the active
window, the state of the system, and the current file.

6.1.2 Method File

PeakTrak controls the separation runs performed by the
system through a Method file. The system uses the method file
to direct the system operation after you click the Play button.

PeakTrak categorizes the method settings as Basic or
Advanced. Basic settings are the frequently used controls
accessed through the MAIN WINDOW [6.3.1]. Use the METHOD
EDITOR [6.3.2] window to access the Advanced settings.

Method files are stored by the system and can be opened for
review, reuse, or modification. To open a method file, use the
FILE>OPEN [6.2.1.2] menu command. Method files can be
transferred to the system from an external storage device
using the FILE>IMPORT METHOD [6.2.1.9] menu command.
Method files use an *.mtd filename extension.

6.1.2.1 Default Methods

With the exception of the Rf 150, when PeakTrak is started,
and every time a RediSep Rf column is inserted, the system
loads a default method. A default method contains Teledyne
Isco’s recommended basic and advanced settings for the use of
RediSep Rf columns on the system. There is a default method
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for each size and media type of RediSep Rf column. See
REDISEP RF COLUMN SELECTION GUIDE (online).

Default methods provide a starting point for your separation
or purification. From these initial settings, you can perform a
purification run, or you can modify the settings for your next
run. Subsequent runs will use the settings in the active
window. If you have modified the settings, you can save the
method file for future use.

If you find that the default methods are not a practical
starting point for your applications, the default methods can
be changed to meet your specific requirements. See EDITING A
DEFAULT METHOD [6.4.4].

6.1.3 Run File

When the system has finished a run, it saves the run history
in a Run file. The history includes the METHOD FILE [6.1.2]
settings, rack and tube information, spectral data, and a
chromatogram. You can open and review the Run files stored
by the system. To open a Run file, use the FILE>OPEN [6.2.1.2]
menu command. Run files use an *.run filename extension.

6.1.4 How to get PeakTrak help

PeakTrak help can be displayed by selecting Help>Help from
PeakTrak’s menu.

If you need additional help, refer to Teledyne Isco’s CONTACT
INFORMATION (online).

6.2 PeakTrak Menu Options

PeakTrak menus include:
e FILE [6.2.1]
e METHOD EDITOR [6.2.2]
e MS [6.2.3]
e TOOLS [6.2.4]

e HELP [6.2.5]

6.2.1 File
The file menu lists the following commands:
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6.2.1.1 New
Select the New command to open a new method file.

Rf150

The main window opens using the default method for the
currently selected column.

Rf+ systems

PeakTrak will open the main window using the default
program settings for the detected column size.

6.2.1.2 Open

Choose this command to open a METHOD FILE [6.1.2] (.mtd) or a
RUN FILE [6.1.3] (.run) stored on the system’s internal hard
drive.

6.2.1.3 Manage Files

Choose this command to open a window from which you can
archive or delete method and run files from the current
directory. You can archive files by connecting a USB Flash
drive and selecting the Copy or Move files to flash drive
option.

To remove a file from the internal hard drive, highlight the file
or enter the filename and click the Delete button.

To remove multiple files, click the Delete by Age button. Then
specify the age limit in months and click OK.

Use the Move and Delete options with caution as the files
cannot be recovered from the internal hard drive once the
action is complete.

6.2.1.4 Set Data Path...

This opens the SET DATA PATH [6.3.7] window. Use this window
to specify the default storage folders for users. These folders
contain multiple METHOD FILE [6.1.2] and RUN FILE [6.1.3]
resources created by system users. (See also USER
MANAGEMENT [6.3.15].)

6.2.1.5 Save Method

Choose this menu command to save the settings of the current
method file to the system’s internal storage. The file will be
saved under the current file name.

6-4
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| M Note

Note: DEFAULT METHODS [6.1.2.1] are an exception and cannot be
overwritten by the Save Method command. If a default method is
open and you attempt to save any modifications to that method,
the FILES [6.3.6] window appears so you can rename the method
file. This preserves the default method. If you do wish to edit and
save the system’s default methods, use the “TOOLS>EDIT
DEFAULTS [6.2.4.4]" command instead.

6.2.1.6 Save Method As...

Choose this command to open the FILES [6.3.6] window. From
this window you can rename the current method and save it
on the system’s internal hard drive.

The Save Method As command also can scale a method to a
different column size. To scale a method, select the scale
option and select the new column size from the drop-down list.
Then, click the Save button. The system saves a new method
file with the gradient and run length scaled to the selected
column size.

6.2.1.7 Save Run As PDF

Choose this command to save the displayed run on a remote
computer’s hard drive or a USB Flash storage device
connected to the system. When selecting this menu command
from the touch screen, the system saves the file on the USB
storage device. The default file name will be the same as the
Run file, except with a “PDF” file name extension. PeakTrak
displays a file download window so you can select a location
and enter a file name.

(You can open and print PDF files with Adobe Reader.)

6.2.1.8 Save Run As TXT

Choose this command to save the displayed run on a remote
computer’s hard drive or a USB Flash storage device
connected to the system. When selecting this menu command
from the touch screen, the system saves the file on the USB
drive. The file name will be the same as the Run file, except
with a “TXT” file name extension. PeakTrak displays a file
download window so you can select a location and enter a file
name.
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(You can open, edit, and print TXT files with text editing or
word processing software.)

6.2.1.9 Import Method

Choose this command to load a Method file from an external
source (see EXPORT METHOD [6.2.1.10]) onto the system’s
internal storage. From the touch screen, this command opens
the FILES [6.3.6] window so you can locate and select the file on
a USB Flash storage device. When selecting this command
from a remotely connected computer, PeakTrak displays a
window so you can select the method file. After selecting the
file, click the Open button to save the method file on the
system’s internal hard drive.

6.2.1.10 Export Method

Choose this command to save a Method file in a location other
than the system’s internal hard drive. This can be done to
archive method files or to transfer the method to another
system using the IMPORT METHOD [6.2.1.9] menu command.
From the touch screen, this command opens the FILES [6.3.6]
window so you can save the file on a USB Flash storage device.
When selecting this command from a remote computer,
PeakTrak displays a window from which you can save the
method file.

6.2.1.11 Export SMM/XL Method

Choose this command to export a method file for use on a
CombiFlash Companion system equipped with the Solvent
Management Module (SMM) or a CombiFlash Companion XL
system. From the touch screen, this command opens the FILES
[6.3.6] window so you can save the file on a USB Flash storage
device. When selecting this command from a remote computer,
PeakTrak displays a window from which you can save the
method file.

6.2.1.12 Print...

From the touch screen, this command prints the completed
run on the network printer (see NETWORK PRINTING on the
NETWORK CONFIGURATION [6.3.13.2] window). When selecting
this command from a remotely connected computer, PeakTrak
displays the Printer window. From this window, you can select
and configure the printer of your choice. After configuring the
settings, click the PRINT button to print the completed run.

6-6
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6.2.1.13 Logout

Choose this command to logout of the system. After logging
out, the system displays a login screen and waits for the next
user to log in.

6.2.2 Method Editor

Selecting the Method Editor menu command will open the
METHOD EDITOR [6.3.2] window. Use this window to view and
modify the advanced method file settings.

6.2.3 MS

This menu item is only available in Purlon systems to control
the mass spectrometer. The following options are available:

6.2.3.1 Method Development

Choose this command to open the MS METHOD DEVELOPMENT
[6.3.8] window to verify ionization conditions for the compounds
to be purified. This command is not available from a remotely
connected computer via a web browser.

ION FINDER - Enables the user to find fragments and
adducts based on the molecular weight of their desired
compound.

e DESIRED MASS - enter the molecular weight of your
compound, rounded to the nearest integer.

e DETECTION IONS - list of ions to be detected.

¢ Detection Ion - list of possible adducts or fragments
based on the value entered in the desired mass control
and detected by the system. Checking one of these
values adds it to the DETECTED IONS list.

6.2.3.2 Manual Control

Use this command to open the MS MANUAL CONTROL [6.3.9]
window to prime and control the carrier solvent pump and
switching valve on the mass spectrometer fluid interface. This
command is not available from a remotely connected computer
via a web browser.

6.2.3.3 Ionization settings

This command opens the IONIZATION SETTINGS [6.3.10] window
to allow creation of custom ionization parameters that can be
saved for various compound classes and projects. This
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command is not available from a remotely connected computer
via a web browser.

6.2.3.4 Operate

This command sets the status of the Purlon mass
spectrometer from Standby to an operational mode by
applying power to the heaters and dynode detector. The
nitrogen gas is also supplied to the nebulizer. If the mass
spectrometer is already in Operate mode, the Standby button
will display.

6.2.3.5 Shutdown

This command removes power to the heaters, and removes
power from the turbomolecular pump. A window will appear
confirming that the user does want to initiate the shutdown
procedure. This command is used to shut down the Purlon
mass spectrometer for maintenance or to move the system.

/AN\WARNING

Warning: Do not shut down or disconnect the vacuum line to
the roughing pump until the Purlon is fully vented as indicated
by PeakTrak.

6.2.4 Tools

PeakTrak’s Tools menu has the following options:

6.2.4.1 Auto Prime/Valve Wash

Choose this command to automatically prime the solvent
pumps. On CombiFlash Rf+ systems, this feature will also
wash the injection valve. When you select this command, the
system opens the AUTO PRIME/VALVE WASH [6.3.11] window.

6.2.4.2 Manual Control

Choose this command to open the MANUAL CONTROL [6.3.12]
window. From this window you can operate the system
manually. Manual control can assist with priming or purging
the internal plumbing, and aid system troubleshooting.

6.2.4.3 Auto Zero
Choose this command to zero the absorbance trace during a
run.
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6.2.4.4 Edit Defaults

Choose this command to open the METHOD EDITOR [6.3.2]
window from which you can modify the default method files.
To prevent tampering with the default column programs,
access to this function can be password protected using the
SET ADMINISTRATOR PASSWORD [6.2.4.6] menu command.

See Also: EDITING A DEFAULT METHOD [6.4.4].

6.2.4.5 Configuration

Choose this command to open the CONFIGURATION [6.3.13]
window. From this window you specify the solvents used with
the system, set default volumes for collection tubes, set the
system date and time, configure network settings, etc.

6.2.4.6 Set Administrator Password
Choose this command to open the SET ADMINISTRATOR
PASSWORD [6.3.14] window.

Passwords protect unauthorized modifications to:
¢ Default methods
¢ User management
e system date and time
e system password

Before any of the above can be accessed, the user must enter a
password. Password protection for the default methods can be
disabled so all users can modify default methods.

6.2.4.7 User Management

Choose this command to open the USER MANAGEMENT [6.3.15]
window. Use this window to add or remove users from the
system. This feature allows you to create a working folder on
the system for each user. Use the FILE>SET DATA PATH...
[6.2.1.4] command to select your folder.

To prevent unauthorized changes to user management, this
function is password protected.

6.2.4.8 Calibrate Touchscreen

Choose this command from the touch screen to calibrate the
interaction between touch screen display elements and stylus
location.
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The calibration routine places a series of targets on the touch
screen display. Touch the exact center of each target with a
stylus. The routine will move clockwise through 20 calibration
targets, after which the system will return to the normal
display.

During calibration routine, ensure that no part of your hand or
anything other than the stylus touches the screen.

| M Note

Note: If you select this command from a remote connection, the
system will start the calibration routine. Invoking this from a
remote connection may be useful if the system is miscalibrated
that this menu command cannot be selected from the
touchscreen.

6.2.5 Help

PeakTrak’s Help menu has the following options:

6.2.5.1 Help
Choose this command to view the Help documentation.

6.2.5.2 Service

Qualified service personnel use this command to access the
system’s service functions. These service functions are
password protected to restrict their use to only trained
personnel.

6.2.5.3 Software Update
Choose this command to open a window used to install patch
files to update your CombiFlash Rf system software.

6.2.5.4 Export Log Files

During operation, the system writes operating data to a log
file. Teledyne Isco service personnel can interpret this data to
optimize system performance or to troubleshoot difficulties.
Teledyne Isco recommends that you use the menu command
only when advised by a qualified service technician.

6.2.5.5 Last Reorder Code

This command should only be used by RediSep Rf Column
Plan customers. Displays the last reorder code generated by
the column plan. Use this to verify the reorder code was
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entered into the Column Plan website to ensure timely
deliveries of replacement column inventory.

6.2.5.6 About PeakTrak
Choose this command to view information about PeakTrak.

6.2.5.7 About Isco
Choose this command to view contact information for Teledyne
Isco.

6.3 PeakTrak Windows

This section contains descriptions of the windows used for
most PeakTrak tasks. In this section you will find information
on the following:

e MAIN WINDOW [6.3.1]

¢ METHOD EDITOR [6.3.2]

¢ GRADIENT OPTIMIZER [6.3.3]

e COLUMN DATA [6.3.4]

e BATCH [6.3.5]

¢ FILES [6.3.6]

e SET DATA PATH [6.3.7]

e MS METHOD DEVELOPMENT [6.3.8]
e MS MANUAL CONTROL [6.3.9]

¢ [ONIZATION SETTINGS [6.3.10]

e AUTO PRIME/VALVE WASH [6.3.11]
e MANUAL CONTROL [6.3.12]

¢ CONFIGURATION [6.3.13]

e SET ADMINISTRATOR PASSWORD [6.3.14]
e USER MANAGEMENT [6.3.15]

6.3.1 Main Window

The Main window gives you control of the frequently used
functions before and during the run. After a run, or when
viewing previous runs, the Main window displays peak
collection data as well as the settings used for that run. The
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Main window dynamically changes to display the controls
required for the current state of the system.

The top region of the Main window always displays a
GRADIENT PLOT [6.3.1.1] area. The bottom region of the window
displays the RUN SETTINGS [6.3.1.2], RUN CONTROL BUTTONS
[6.3.1.3], and PEAK COLLECTION BUTTONS [6.3.1.4]. After a run,
the left side of the window changes to show the collection rack
map or the method parameters in a PEAK COLLECTION DATA
[6.3.1.5] pane.

| M Note

Note: The main window is expanded for CombiFlash Rf 4x
systems. The main window the displays the settings and views in
four tabs, one for each column channel. A fifth tab — BATCH [6.3.5]
— contains the controls to run sequential separations.

6.3.1.1 Gradient Plot

The gradient plot area depicts the current gradient that will
be used for the run. The X-axis of the plot displays the run
time in minutes or COLUMN VOLUMES (online). The X-axis
scale can be adjusted by typing or selecting the Run Length.
The left Y-axis displays absorbance units and the right Y-axis
indicates the percentage of solvent B. By default, PeakTrak
automatically scales the left Y-axis to best display the
absorbance trace. PeakTrak also sets the right Y-axis to 100%.
You can override the Y-axes scales by clicking the Format
Graph button and setting the desired values.

The Cartridge Bypass button may be used during a run to
relieve back pressure caused by impurities precipitating in the
solid load cartridge. Use this feature with care to avoid leaving
desired compound on the cartridge. Read more about this
feature in BYPASSING THE SOLID LOAD CARTRIDGE [6.4.7]

If the external detector option is enabled on Rf+ systems, the
plot area will include a secondary y-axis to display the analog
voltage trace. If the evaporative light scattering detector
(ELSD) is enabled on an Rf+ Lumen system, a secondary left
Y-axis is also included. Purlon systems will display a
secondary y-axis which displays ion count for each single ion
or range chosen.

The gradient plot area also provides a convenient method to
edit the gradient curve. You can click and drag any of the
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points to change the shape of the curve and use the buttons at
the bottom of the plot area to insert and delete points. For
complete instructions on defining gradient curves, see
DEFINING A GRADIENT [6.4.5].

To zoom in on part of the plot area, click the Zoom In button to
enable the zoom action and then drag across the area of
interest. Click the Zoom Out button to revert back to the
normal display.

The MS button displays the current mass spectrum on Purlon
systems. This spectrum hides the flow rate and solvent
selection controls. Pressing the MS control again causes the
spectrum to disappear. When the spectrum is displayed,
touching the chromatogram at any point prior to the current
elution time displays a spectrum at that point in time; the
elution time corresponding to the spectrum is displayed under
the spectrum (in time or CV). The Live Data button shows the
current spectrum. The Add Spectrum button saves the
spectrum at a point for inclusion in a run report screen. Up to
4 spectra can be saved in a run report. The button depicted
with a triangle pointing down allows a user to cycle through
saved spectra.

The UV (UV-vis on Rf+ systems with a UV-vis detector) button
displays the UV spectrum on CombiFlash systems. This
spectrum hides the flow rate and solvent selection controls.
Pressing the UV control again causes the spectrum to
disappear. When the spectrum is displayed, touching the
chromatogram at any point prior to the current elution time
displays a spectrum at that point in time; the elution time
corresponding to the spectrum is displayed under the
spectrum (in time or CV). The Live Data button shows the
current spectrum. The Add Spectrum button saves the
spectrum at a point for inclusion in a run report screen. Up to
4 spectra can be saved in a run report. The button depicted
with a triangle pointing down allows a user to cycle through
saved spectra." The + button displays the positive or negative
ion spectrum (PURION S and PURION L systems only). A dot
in the button indicates whether the positive or negative
ionization spectrum is displayed.

6.3.1.2 Run Settings

¢ RediSep — (Rf+ systems, including those equipped
with 4x) The system reports the detected RediSep
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column media and size. The column should match the
one that will be used for the run. You may override the
detected column size by selecting a different size or
media. See also REDISEP RF COLUMN SELECTION GUIDE
(online).

Sample Name — The sample name is a text entry box
in which you can label the run. Type a unique descriptor.
PeakTrak saves the run information under this name.
Therefore, PeakTrak cannot accept any characters that
are reserved by the operating system (* ?/ \, etc.). If you
do not type a Sample Name, PeakTrak will generate a
date/time stamp for the name when you click the Play
button to begin the run.

Flow Rate — Type or select the desired flow rate for the
run. When using the Isco default column methods, the
system sets the flow rate to the optimum flow rate of the
column.

Detector — (Rf+ systems, including those equipped
with 4x) Reports the current peak detection mode. To
change the peak detection settings, open the METHOD
EDITOR [6.3.2] window.

¢ Solvent A — Select the desired solvent from the list.

The solvents in the list are those defined by the
CONFIGURATION [6.3.13] window.

e Solvent B — Select the desired solvent from the list.

6.3.1.3 Run Control Buttons
From left to right, the control buttons are:

¢ Play — The Play button starts or resumes the run. After
a run has started, this button is replaced by the Pause
button.

e Pause — The Pause button holds the %B at the current
value while the system continues to operate (sometimes
called an isocratic hold). Note that pausing the run
extends the run length. While in the Paused state, you
can resume the gradient by clicking the Play button, or
stop the run by clicking the Stop button. If you resume
the run, the system continues the gradient curve from
the %B when the system was paused.
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e Stop — This button suspends the entire run. Unlike the
Paused state, the pump, peak detection, and fraction
collection will not operate. While stopped, you can save
the run data by clicking the Save button, abort the run
by clicking the Rewind or Fast Forward buttons, or
resume the run by clicking the clicking the Play button.
Using the Fast Forward button is the recommended way
to abort a run because this runs the valve wash and cone
cleaning routines (Purlon systems only) to clean the
system for another run.

¢ Next Tube — This button advances the fraction
collector to the next tube position. This allows you to
conveniently collect elute of interest in new tube.

¢ Rewind — This button is active when the system has
completed the run, or if the run was Stopped by clicking
the stop button. The Rewind button returns you to the
MAIN WINDOW [6.3.1].

If you have stopped the run before its programmed run
length has elapsed, the current method is modified using
the new run length. This modified method is ready for
the next run, or can be saved for future runs.

e Fast Forward — Click this button to jump to the next
step of a run. Once you’ve started a run, the system
performs several steps. The first step is to deliver
solvents using the programmed gradient for the entire
run length. When this step is complete, the system will
purge the column with air. Following this, the system
will clean the injection valve.

Clicking the Fast Forward button will cause the system
to skip any remaining time in the current step and
advance to the beginning of the next step. Unlike the
Rewind button, the Fast Forward button will not modify
the current method’s run length setting.

6.3.1.4 Peak Collection Buttons
Three peak collection buttons are located at the bottom of the
Main window.

e All — Click this button to collect all fluids in the fraction
collection tubes.
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¢ Peaks — Click this button to collect only eluted peaks in
the fraction collection tubes.

¢ None — Click this button to divert all fluids to the
waste port.

6.3.1.5 Peak Collection Data

Peak Collection data is displayed in the Main window after a
run. You may also open a RUN FILE [6.1.3] for viewing data from
previous runs.

Clicking on a test tube with the mass spectrum window
displayed displays the mass spectrum for compounds eluted
into that tube (Purlon systems only). Clicking on adjacent
tubes allows a user to determine which fractions may
potentially contain impurities.

The peak collection data is displayed on the left side of the
Main window:

¢ Rack and tube information — Collected peaks are
color coded in the rack diagram so that you can easily
locate the peaks of interest. The tube colors correspond
to the color bars under the peaks displayed on the
chromatogram. If during the run more than one set of
tube racks was filled, use the Next and Previous Rack
buttons to view the additional racks. The table below the
rack diagram displays the peak data in tabular form.

Display Method — Click the Display Method button to
view a summary of the peak detection and collection
settings for the run. You can return to the rack and tube
display by clicking the Display Rack button.

See Also:
e PEAKTRAK OVERVIEW [6.1]

¢ STARTING A RUN USING DEFAULT SETTINGS [6.4.1]
¢ REAL-TIME GRADIENT EDITING [6.4.6]

e METHOD EDITOR [6.3.2] for advanced functions

6.3.2 Method Editor
The Method Editor window has several sections. The BUTTON
BAR [6.3.2.1] at the top of the window gives you quick access to
file operations, a GRADIENT OPTIMIZER [6.3.3], and COLUMN
DATA [6.3.4] (Rf+ systems, including those equipped with 4x).
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Below the button bar are the RUN SETTINGS [6.3.2.2] and the
RUN NOTES [6.3.2.3]. The lower part of the window contains the
GRADIENT PLOT AREA [6.3.2.4] and settings for PEAK
COLLECTION [6.3.2.5] and PEAK DETECTION [6.3.2.6].

6.3.2.1 Button bar
The Method Editor button bar contains the following:

e New — (Rf+ systems, including those equipped with 4x)
Click this button to open a new method file using the
default method settings for the detected column media
and size.

e Open — Click this button to open a method file stored
on the system’s internal hard drive.

e Save — Click this button to save any modifications to
the current method file. Note that if you attempt to save
modifications to a default method file, the FILES [6.3.6]
window will open instead so you can rename the file.
This preserves the default method. If you do wish to edit
and save the system’s default methods, use the
“TOOLS>EDIT DEFAULTS [6.2.4.4]” command instead.

e Save As — Click this button to open the FILES [6.3.6]
window. From this window you can rename the current
method and save it on the system’s internal storage.

¢ Exit — Click this button to close the Method Editor and
return to the MAIN WINDOW [6.3.1].

¢ Gradient Optimizer — Click this button to open the
GRADIENT OPTIMIZER [6.3.3] window. This feature
produces an optimized gradient optimized based on your
TLC retention factor data.

¢ Column Data — (Rf+ systems, including those
equipped with 4x) Click this button to open the COLUMN
DATA [6.3.4] window. This window reports information
about the column installed in the system.

¢ Time to CV/ CV to Time — Click this button to toggle
the Run Length (X-axis) units between minutes and
COLUMN VOLUMES (online). You can configure
PeakTrak’s default Run Length units by changing the
CONFIGURATION [6.3.13] settings.
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6.3.2.2 Run Settings

¢ RediSep Column — (Rf+ systems, including those
equipped with 4x) The RediSep column media and size
are detected by the system and reported here. The
column should match the one that will be used for the
run. You may override the detected column size by
selecting a different size. See also: REDISEP RF COLUMN
SELECTION GUIDE (online).

e Sample Name — The sample name is a text entry box
in which you can label the run. Type a unique descriptor.
PeakTrak saves the run information under this name.
Therefore, PeakTrak cannot accept any characters that
are reserved by the operating system (* 7/ \, etc.). If you
do not type a Sample Name, PeakTrak will generate a
date/time stamp for the name when you click the Play
button to begin the run.

¢ Flow Rate — Type or select the desired flow rate for the
run. When using the Isco default column methods, the
system sets the flow rate to the optimum flow rate of the
column.

¢ Equilibration Volume — Type or select the volume of
solvent that is pumped through the column and out the
waste port before the sample is introduced. Data is not
collected while this volume is being pumped. Three or
more column volumes are recommended for most
applications.

¢ Initial Waste & Time Windows — Click this button to
open a window from which you can view and modify
these settings. For the Initial Waste, type or select the
volume of eluate that is allowed to pass through the
column to the waste port after the sample is injected.
After this volume has been diverted, the system is ready
to collect peak or all fluids in the collection tubes. Use
this feature to clear the internal lines of any elute left
from a previous run and to conserve collection tubes by
diverting all fluids until the first peak is expected.

Time Windows can limit the fraction collection to specific
time durations of the run. To use time windows, first

enter a start time and an end time (column volumes may
also be used). Note that all times are relative to start of
the run, just following the sample injection. Then choose
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a peak collection mode. If you select Peaks, the module
will collect fluid only when the time window is active
and a peak is present. If you select All, the module will
collect all fluid during the time window regardless of the
peak state. Define up to three time windows.

e Air Purge — (Rf+ systems, including those equipped
with 4x) Type or select the duration of a post-run air
purge, in minutes. An air purge clears the solvent from
the column and the fluid path, forcing any liquid out the
waste port. If you are disposing the column after each
run, a sufficient post-run air purge ensures that it will
be empty. To disable the air purge, enter a value of 0
(zero). A column can also be manually air purged. See
MANUAL CONTROL [6.3.12].

6.3.2.3 Run Notes
Use this text entry box to enter comments or notes for the run.

These comments will be saved with the run and will appear in
TXT and PDF reports.

6.3.2.4 Gradient Plot Area

The gradient plot area depicts the current gradient profile
that will be used for the run. The X-axis of the plot displays
the run time in minutes or COLUMN VOLUMES (online). The
X-axis scale can be adjusted by typing or selecting the Run
Length. The left Y-axis displays absorbance units and the
right Y-axis indicates the percentage of solvent B.

The gradient plot area also provides a convenient method to
edit the gradient curve. You can click and drag any of the
points to change the shape of the curve, or use the buttons at
the bottom of the plot area to insert and delete points. The
following controls appear in the Gradient Plot Area:

¢ Insert — Click this button to enable the gradient point
insert mode. When this mode is active, click the gradient
curve to add a single point. You can then drag the new
point to any desired position. Click the insert button
once for each gradient point that must be added to the
plot area.

e Delete —Click this button to enable the gradient point
delete mode. When this mode is active, the system will
delete the point nearest the next click on the gradient
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curve. Click the Delete button once for each point that
must be deleted from the plot area.

Run Length — Type or select the length of the run.
Note that this will change the scale of the X-axis on the
gradient. Points that define the gradient will be
automatically scaled to fit the new run length. The run
length can be expressed in minutes or COLUMN VOLUMES
(online) (CV). You can configure PeakTrak’s default Run
Length units by changing the CONFIGURATION [6.3.13]
settings.

Solvent A — Select the desired solvent from the list.
The available solvents are those defined by the
CONFIGURATION [6.3.13] settings.

¢ Solvent B — Select the desired solvent from the list.
You can program mid-run solvent B changes by clicking
the Edit Gradient button to open the GRADIENT TABLE.

Edit Gradient — Although the gradient may be edited
directly within the plot area, you can also edit the
gradient in tabular form. Click this button to open the
GRADIENT TABLE. On Rf+ systems, including those
equipped with 4x, the Gradient table also lets you
program solvent changes in the gradient.

For complete instructions on defining gradient curves, see
DEFINING A GRADIENT [6.4.5].

Gradient Table The gradient table depicts the points that
define the gradient curve in a tabular format. From this table
you can change Solvent B (Rf+ systems, including those
equipped with 4x), the duration, and %B concentration of any
point on the curve. To do so, select the new value for a gradient
point. Changes that you make to the table will be reflected in
the gradient plot area.

You can also change the number of points on the curve by
inserting or deleting rows in the table. To change the number
of points, first highlight a table cell or row. Then click the
appropriate Gradient Button for the action you desire.

¢ Insert Point — This command or button will insert a
row below the selected point.
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¢ Delete Point — This command will delete the selected
row. Note that you cannot delete the initial point. There
must be at least two points to define a gradient.

The system automatically updates the Run Length setting or
scales the other points when you change the number of points
and their duration on the curve.

To close the Gradient Table, click the Edit Gradient button.
See Also: DEFINING A GRADIENT [6.4.5]

6.3.2.5 Peak Collection
Use the Peak Collection buttons to set the collection mode.

e All — Click this button to collect all fluids in the fraction
collection tubes during a run.

* Peaks — Click this button to collect only eluted peaks in
the fraction collection tubes during a run.

® None — Click this button to divert all fluids during a
run to the waste port.

¢ Tube Volume — You can also specify the Tube Volume
for collected fluids. This volume can be the default
maximum volume (Max option) as entered in the
CONFIGURATION [6.3.13] window, or a method-specific
volume less than the capacity defined by the
CONFIGURATION [6.3.13] window. Note that the actual
fraction size may be less if a newly detected peak causes
a tube change, or if you click the Next Tube button.

e Peak — Type or select the desired volume to be
collected in each tube when the system detects a
peak.

¢ Non-peak — Type or select the desired volume to be
collected in each tube when peaks are not detected.
This setting allows you to conserve tubes without
diverting non-peak elute to waste. This setting is
ignored when the peak collection mode is set to Peaks
or None.

6.3.2.6 Peak Detection

This section of the window contains option buttons to enable
and disable various peak detection options. When an option is
enabled, the window also allows you to modify the setting
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details for that peak detection option. All enabled options will
be displayed on the chromatogram. The options and settings
for the Rf+ systems, including those equipped with 4x, are
described below.

| M Note

Note: You can select up to four peak detection options on the Rf+
systems, including those equipped with 4x. If using more than one
option, such as A1 with A 2, the system considers a peak to be
present when any option is true (a logical OR).

¢ )1 and 12 (wavelength 1 and 2) — Enable these
options to use and configure primary and secondary
wavelength detection. A2 is set to monitor by default.
When enabled, type or select the peak detection
wavelength in nanometers, then click the Details button
to configure additional settings described below.

¢ Slope Based — Select this option to enable
Slope-based peak detection. When enabled, peaks will
be recorded if the slope algorithm indicates a peak
within the Peak Width setting.

e Peak Width — Select the average peak width
setting. Peak widths are measured at the baseline.
The slope detector will detect peak widths ranging
from about 0.2 to 2 times the peak width setting. For
example, if you entered a peak width of 1 minute, the
range would be 12 seconds to 2 minutes. For best
operation, the peak width should be set to just over
the average peak width being separated. For
instance, if the average peak width is 45 seconds, you
should enter a peak width of 1 minute. For most flash
chromatography, 1 minute is a good starting point for
a peak width.

e Threshold Detection — Select this option to enable
Threshold peak detection. When enabled, peaks will
be recorded if the Absorbance Units (AU) value is
exceeded.

¢ Threshold — Type or select the Absorbance Units
value to be used for Threshold detection.
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| M Note

Note: If both Slope and Threshold peak detection methods are
checked, the system considers a peak to be present when any
one condition is met. This logical OR operator means that the
system will cut a peak when either the Slope condition is true, or
when the Threshold condition is true.

¢ Monitor — Enable this option to only use the
detection source as a monitor. When enabled, the
detection source will be displayed as a trace on the
gradient plot area, but will not be used to cut peaks.

¢ All Wavelength Detection — Enable this option to
detect peaks within a user-selected range of
wavelengths. When enabled, click the Details button to
configure additional settings. These settings include the
slope-based and peak width options described in A1 and
A2 above. Peak width is used to determine solvent
suppression. Peaks that are twice the peak width are
deemed to be solvent or other baseline drift and the
signal will be rezeroed. Additionally, you can type or
select the minimum and maximum wavelengths limits
in nanometers.

e Mass Spectrometer — Enable this option to monitor or
detect compounds with a Purlon mass spectrometer
system (Purlon systems only).

Threshold - signal level used to detect a peak. This
is based on the baseline noise. The baseline noise is
measured during the first column volume; this is
multiplied by the value entered in the THRESHOLD
control to generate a trigger value. A peak is collected
if the signal is greater than this trigger value.
Monitor — Clicking on this option prevents
fractionation based on the mass spectrometer signal.

Terminate On Target — stops the run after all mass
spectrometer detection ions have been detected.
Detection Ions — used to set ions for detection or to
be monitored. Up to 4 single ions may be chosen, or a
range of ions and up to 3 single ions may be chosen.
On PURION S and PURION L systems, detected ions
may be a mixture of positive and negative ions.
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Ion Settings — set ionization parameters to enhance
detection of molecular ion peaks.

e External Detector — Enable this option to use a 0 to 1

volt analog signal from an external detector. When
enabled, click the Details button to configure additional
settings. These settings include the slope-based and
peak width options described in A1 and A2 above. The
system will use its internal algorithms to cut detect and
cut peaks based on the analog input signal. Refer to the
External Detector instruction sheet for cable and
plumbing requirements.

The external detector option is not available on Rf+
Lumen and Rf+ Purlon systems.

ELS Detector — Enable this option to use the
evaporative light scattering (ELS) detector on an Rf+
Lumen system. When enabled, click the Details button
to configure additional settings:

Signal Gain — You may modify the gain to scale the
detector signal.

Slope Based and Threshold — Refer to these
features described in 2.1 and A2 above.

Spray Chamber Temperature — The default
settings are 30 °C (normal phase default methods)
and 15 °C (reverse phase). This setting may be
adjusted from 10 to 60 °C so that detection can be
optimized for the solvent system in use. However, the
lower limit is 5 °C below the ambient temperature.

Drift Tube Temperature — The default settings are
60 °C (normal phase default methods) and 60 °C
(reverse phase). This setting may be adjusted from 30
to 90 °C, but is limited to a range of 5 °C below and 60
°C above the ambient temperature.

Purity Measure — If using two absorbance
wavelengths, check this option to display a ratio of the
selected wavelengths. The ratio trace is often a useful
indicator of purity. Use the SHOW SPECTRAL PURITY
control to measure purity by using a comparison of
UV-spectra measured at differing times as a purity
measurement. The SPECTRAL PURITY DETECTION
button allows fractionation based on spectral purity.
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Refer to the MONITORING THE PURITY MEASURE
topic for more details of these features.

Rf150 systems have a fixed UV detection wavelength of 254
nm. The peak detection settings for these systems include
slope-based and peak width options. These are described in A1
and A2 above. Rf150 systems with the variable wavelength
option include a control to type or set the detection
wavelength.

6.3.3 Gradient Optimizer
Use this window to automatically generate a gradient curve
from the results of two TLC plates. Follow the on-screen
instructions, then enter valid TLC data in the Gradient
Optimizer window. Click the OK button and the Method
Editor window will display the new gradient curve.

When using the Gradient Optimizer, the system may insert an
isocratic hold into the generated gradient. Furthermore, the
system may automatically extend the isocratic hold during the
run to increase peak resolution.

To open the Gradient Optimizer window, open the METHOD
EDITOR [6.3.2] window, then click the Gradient Optimizer
button.

6.3.4 Column Data
(Rf+ systems, including those equipped with 4x) The Column
Data window reports information about the RediSep Rf
column installed in the system. Compatible RediSep Rf and
RediSep Rf Gold columns have an RFID tag that identifies the
column type. The system reads this information to identify the
size and media, then automatically adjusts the default method
to match the inserted column.

If the column is reusable, the system will also write
information to the RFID tag that can help you manage its use.
The “Number of times used,” “First used on,” and “Last used
on” information can help you determine when the column
should be replaced. The “Last fluid used” will help you
determine if any solvent remaining in the column will be
miscible with the solvent currently used in the system.

To view the Column Data window, open the METHOD EDITOR
[6.3.2]1 window, then click the Column Data button.
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6.3.5 Batch

The Batch tab contains the controls to stage and run
sequential separations on systems with a 4x Module.

6.3.5.1 Queue
The Queue section of this tab lets you enable column positions
and specify operating parameters.

* Queue — Check the box by the column positions that
are to be run. Note that the Rf 4x system performs the
separations sequentially. Columns can be run in any
order. Column positions are run in the order clicked, as
seen from top to bottom in the queue. As column runs
are finished, they can be replaced with new runs that
can be added to the queue.

Sample Name — The sample name is a text entry box
in which you can label the run. Type a unique descriptor.

PeakTrak saves the run information under this name.
Therefore, PeakTrak cannot accept any characters that
are reserved for the operating system (* 7/ \, etc.).

If you do not type a Sample Name, PeakTrak will
generate a date/time stamp for the name when you begin
the run.

RediSep — Select the column that will be used for the
run.

Loading Type— Select the type of injection.

e Start Tube — Select Next Tube to begin at the next
available tube in the current rack or Next Rack to begin
with the first tube in the next rack.

6.3.5.2 Gradient Plot Area

The Gradient Plot Area is the same as the one displayed on
the tabs for each column position. The display shows the
current channel. The top corner displays the current system
pressure.

6.3.5.3 Run Control Buttons
The Run Control Buttons allow you to control the operation of
the system.
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6.3.6 Files

The Files window is modal. That is, its function and features
change according to the command used to open the window.
Menu commands such as FILE>OPEN [6.2.1.2] and SAVE
METHOD AS... [6.2.1.6], or clicking Open and Save As buttons
will open this window. Use this window to browse the system’s
files and folders. The following controls appear on the window:

¢ Current Path — The top-left corner of the window
displays the path (current folder). As you browse
through the files, the path will update as you go. You can
click the folder names to return to upper folder levels.

¢ File and Folder Operation buttons:

¢ Copy — Click this button to copy a highlighted file to
the system’s clipboard memory.

e Paste — Click this button to paste a file from the
clipboard memory. If the file already exists in the
current folder, the system will ignore the Paste
command to prevent the original file from being
overwritten.

¢ Delete — Click this button to delete a highlighted
file or a folder and its contents.

¢ New Folder — Click this button to create and name
a new folder.

e Up — Click this button to browse the contents of the
next-higher folder level.

e Search — Enter a keyword and click the Search
button to find matching file names. Click the Clear
Search button to clear the results.

¢ File Management options — Click the Copy Files to
Flash Drive or Move Files to Flash Drive to create
archive copies (PDF or Text) of the files on a
connected flash drive. Click the Delete by Age to
specify an age limit, beyond which will be deleted
from the internal hard drive.

¢ File/folder info scroll box — This box lists the
contents of the current folder. The contents can be sorted
by clicking the column headings.
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¢ File Type — This option is shown when you can limit
the display to certain types of files. Select the desired file
type from the list.

File Name — This text entry box is used to identify the
currently selected (highlighted) file or folder when
browsing and opening files. When using a Save As
command, use this box to name the file.

¢ Open/Save — This button performs the listed action.

¢ Continue Last Run on Detected Column — (Rf+ and
Rf+ Lumen) This option appears when using the
FILE>OPEN [6.2.1.2] command. If you click this option, the
system reads the RFID tag on the RediSep Rf column,
loads the previous method and adds a run extension. You
can then modify the method and click Play to continue
the run, skipping the equilibration and injection. This
feature can be useful if the run was interrupted or if
additional compounds of interest might be left on the
column.

¢ Load Previous Run from Detected Rack — (Rf+ and
Rf+ Lumen) This option appears when using the
FILE>OPEN [6.2.1.2] command. If you click this option, the
system reads the RFID tag on a single rack and displays
the RUN FILE (6.1.3]. This feature is useful when there is
a need to recall run results at a later time.

Cancel — Click the Cancel button to close the window
without saving or opening the file.

6.3.7 Set Data Path

The FILE>SET DATA PATH... [6.2.1.4] menu command opens the
Set Data Path window. Use this window to select a default
folder for the current user. After selecting a folder, file
operations such as saving or opening files will use this selected
directory.

The Set Data Path primarily is used with the USER
MANAGEMENT [6.3.15] feature. User Management will
automatically create a folder for each user. When using the
system, set the data path to your folder or a subfolder within.
Each user has a different data path.

The window contains the following controls:
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¢ Current Data Path — The top-left corner of the
window displays the path (current folder). As you browse
through the files, the path will update as you go.

¢ New — Click this button to add and name a subfolder
within the currently selected folder.

¢ Delete — Click this button to delete the selected folder.

¢ Folder selection box — This box lists the available
folders and selection buttons.

e OK — Click this button to save your selection as the
data path and close the window.

¢ Cancel — Click the Cancel button to close the window
without changing the data path.

6.3.8 MS Method Development

The MS->METHOD DEVELOPMENT menu command opens
the Purlon mass spectrometer method development window
(Purlon equipped systems only). This enables a user to test
and verify ionization conditions for their compound. This
command is not available from a remote connection.

This window contains the following controls:

e POLARITY—On the Purlon system, this control
changes the probe polarity between positive and
negative ionization. On PURION S and PURION L
systems, this button toggles the displayed mass
spectrum between positive and negative ionization.

e ION SETTINGS - Allows selection of different ion
settings to maximize the intensity of the desired
molecular ion. The factory selections include “Robust”,
for compounds that do not easily ionize. “T'ypical” works
well for most compounds. The “Fragile” setting is used
for those compounds that are delicate or easily fragment.

User defined ion settings may also be loaded (see section
6.2.3.3)

¢ TON FINDER - Identifies potential adducts and
fragments for the compound of interest when the
compound of interest does not show up in the spectrum

graph.
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DETECTION IONS—After a spectrum is collected,
clicking on a peak adds that ion to this control.
Alternately, masses can be entered using a keypad
control.

CLEAR ION—clears the last value entered into the
DETECTION IONS control.

Mass spectrum graph- this displays the mass
spectrum. There are two mass spectra displayed. The
spectrum depicted in blue shows what the Purlon is
currently detecting. The red spectrum depicts the
largest peaks detected. The red spectrum is reset after
injecting a sample. To inject a sample, move the Purlon
injection valve to the “inject Sample position”

Inject the sample (>20 uL) and move the valve to the
“Scan Mass” position.

| M Note

Note: Only use 22 gauge square tip needles (PN 29-9001-911) to
avoid scratching the internal surfaces of the injection valve! Filter
the sample with a 0.45 yp filter to avoid clogging the Purlon tubing
and probe capillary. Sample concentration should be less than 20
pg/mL.

FORMAT GRAPH—Set the displayed range of the
mass spectrum. The Purlon system still collects the
entire mass range even when the range is set within
than the minimum and maximum values allowed for the
spectrometer. Values can range from 50 to 1200 Da
(PURION or PURION S) or 2000 Da (PURION L).
Changing the mass range defined by these controls may
cause the Y-axis (ion count) scaling to change based on
the tallest peak within the range.

SPECTRUM NAME - the file name for the mass
spectrum only needed if the user will save the file.

SAVE DATA - saves the data to either the CombiFlash
hard drive or network drive.

Save run as PDF - save the displayed spectrum on
either a USB drive or a remote computer’s hard drive.
The file name will be the same as the spectrum name
except it has a PDF extension. PeakTrak displays a file
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download window so you can select a location and
change the file name.

¢ Fluid Interface Pressure - The carrier solvent
pressure is displayed in a ribbon gauge. If the pressure
approaches the level of the red line, the system is
clogged and should be cleaned to allow proper operation.

6.3.9 MS Manual Control
The MS->MANUAL CONTROL menu command allows the
fluid interface carrier solvent pump to be run for priming and
to purge the carrier solvent. This window can also be used for
trouble

e START CARRIER PUMP- Turns the carrier pump on
for priming or to replace one carrier solvent with
another one. A purge is complete in ~5 minutes. This
changes to read STOP CARRIER PUMP when the pump
is running.

To prime the pump, open the priming valve on the fluid
interface counterclockwise. Use the 5 mL Luer lock
syringe provided with the accessory kit to draw liquid
into the pump. Repeat this procedure once more to
completely fill or purge the line from the carrier solvent
reservoir to the priming valve. Make sure the priming
valve is tightly shut after priming the system.

e STOP CARRIER PUMP - Stops the carrier pump. This
changes to read START CARRIER PUMP after the
pump is stopped.

e OPERATE SPLITTER VALVE - Runs the splitter
valve to verify operation.

¢ Fluid Interface Pressure - The carrier solvent
pressure is displayed in a ribbon gauge. If the pressure
approaches the level of the red line, the system is
clogged and should be cleaned to allow good response.

e CLOSE - Closes the window and stops the carrier pump
if it is running.

6.3.10 Ionization Settings

The MS->IONIZATION SETTINGS menu command allows a
user to adjust various settings to improve the ionization of a
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particular compound by reducing fragmentation or adduct
formation.

¢ Mass Spectrum Graph - this displays the mass
spectrum. There are two mass spectra displayed. Blue
displays the maximum of the current injection. Red
displays the maximum of the previous injection for
comparison. When a new injection is performed, the blue
spectrum replaces the red spectrum and a new blue
spectrum is started. To inject a sample, move the Purlon
injection valve to the “Inject Sample” position.
Inject the sample (20 ulL) and move the valve to the
“Scan Mass” position.

| M Note

Note: Only use 22 gauge square tip needles (PN
29-9001-911) to avoid scratching the internal surfaces of
the injection valve. Filter the sample with a 0.45 p filter to
avoid clogging the Purlon tubing and probe capillary.
Sample concentration should be less than 20 pg/mL.

e POLARITY - switches the mass spectrometer between
positive and negative polarity.

e FORMAT GRAPH - Set the displayed range of the
mass spectrum. The Purlon system still collects the
entire mass range even when the range is set within
than the minimum and maximum values allowed for the
spectrometer. Values can range from 50 to 1200 Da
(PURION and PURION S) or 2000 Da (PURION L).
Changing the mass range defined by these controls may
cause the Y-axis (ion count) scaling to change based on
the tallest peak within the range.

Fluid Interface Pressure - The carrier solvent
pressure is displayed in a ribbon gauge. If the pressure
approaches the level of the red line, the system is
clogged and should be cleaned to allow proper operation.

¢ TON SETTINGS - Allows selection of different ion
settings to maximize the intensity of the desired
molecular ion. The factory selections include “Robust”
for compounds that do not easily ionize. “T'ypical” works
well for most compounds. The “Fragile” setting is used
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for those compounds that are delicate or easily fragment.
User-defined settings may also be loaded.

¢ MAKE CHANGES- Pressing this button allows a user
to change the settings to improve the intensity of an ion.

e SAVE- save changes to an existing ion settings file.

e SAVE AS...- save changes and create a new ion settings
file. This new file can be selected in ionization settings or
method development (see section 6.2.3.1). Additionally,
this file can also be selected when setting up a
separation run.

e FACTORY SETTINGS- restore the “typical”, “Robust”,
and Fragile” ion settings to the factory default values.

e PROBE - The probe nebulizes and ionizes the sample.
There is a choice of ESI (electrospray interface) or APCI
(atmospheric pressure chemical ionization) probes. The
software will change the labels on the control to reflect
the probe installed in the mass spectrometer.

o GAS TEMP -the temperature of the nebulization gas
for the probe. Lower temperatures are used for more
delicate, heat labile compounds. The temperature is
set to quickly evaporate the carrier solvent (note that
PURION S and PURION L systems will display a
single temperature for both positive and negative
ionization).

e VOLTAGE (CURRENT) - This displays a voltage
setting (ESI probes) or current value (APCI probes).
Lower values are used for more delicate compounds.

The capillary is heated to complete the evaporation of solvent.
It also carries a voltage; lower voltages are used for more
delicate compounds.

¢ Source Voltage - The source voltage settings have the
greatest effect on fragmentation. Higher values induce
more fragmentation but also reduce adduct formation.

e OFFSET - Offset is the voltage applied to all masses.
Large values tend to increase fragmentation but
reduce adduct formation.
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e SPAN - Span voltage defines an increased voltage
applied as the mass increases. As with the offset,
larger values increase fragmentation.

¢ CLOSE - Closes the window.

6.3.11 Auto Prime/Valve Wash

The Auto Prime feature is a convenient way to prime the
pumps with solvent. This should be done whenever new
solvents are connected to the back panel ports, or to change
between the available solvents. An Auto Prime pumps 50 mL
of the selected strong solvent, drawing it in through the back
panel port, through the pump, and out the waste port. On Rf+
systems, including those equipped with 4x, the injection valve
is included in the fluid path to wash the valve. The Auto Prime
then does the same for the selected weak solvent. By priming
Solvent A last, the system is ready for the starting mobile
phase of the next run.

The Auto Prime window is opened by selecting the
ToOLS>AUTO PRIME/VALVE WASH [6.2.4.1] menu command. The
window contains the following controls:

¢ Progress bar — This bar displays how much of the
solvent has been pumped.

¢ Solvent Selections — There are 4 solvent selection
lists labeled from 1st solvent through 4th solvent.,
describing the order in which solvents will be pumped.
The solvent choices for each list are those defined by the
CONFIGURATION [6.3.10] window. (Rf+ systems,
including those equipped with 4x). It is recommended
that the solvent be primed in order of decreasing solvent
strength, with the weakest solvent primed last.

Play button — Click this button to start the Auto
Prime.

Fast Forward button — Click this button to skip to the
next Auto Prime step.

¢ Cancel button — Click this button to stop the Auto
Prime and close the window.

6.3.12 Manual Control

Manual Control can assist with method development,
maintenance of the system plumbing, and system
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troubleshooting. The Manual Control window can be opened
by selecting TOOLS>MANUAL CONTROL [6.2.4.2] from the
PeakTrak menu.

The Manual Control Window has several controls:

¢ Channel - Select the channel for manual control. (Rf4x
systems only.)

¢ Solvent Selections — (Rf+ systems, including those
equipped with 4x) There are 4 solvent selection lists
labeled from 1st solvent through 4th solvent., describing
the order in which solvents will be pumped. The solvent
choices for each list are those defined by the
CONFIGURATION [6.3.13] window. (Rf+ systems, including
those equipped with 4x). It is recommended that the
solvent be primed in order of decreasing solvent
strength, with the weakest solvent primed last.

¢ Percentage Solvent B — type or select the mixture
percentage.

¢ Flow Rate — Type or select the pump’s flow rate in
mL/min.

e Pump into Tube # — As a default setting, solvent is
pumped to the waste port during manual control. If you
would like to collect the solvent in a tube, select the
option button and enter the tube number. This function
cannot be used with the Waste Flow Path valve position.
This feature can be useful when trying to recover a
compound that has precipitated or “crashed” somewhere
in the fluid path.

e Valve Position — Select the valve position for the
desired solvent flow path. (Rf+ and Rf+ Lumen systems
only.)

¢ Prime A — Click the “Prime A” button to pump 100% of
solvent A at the selected flow rate.

¢ Prime B — Click the “Prime B” button to pump 100% of
solvent B at the selected flow rate.

¢ Prime 50% B — Click this button to pump a mix of
Solvent A and B.

e Stop — Click this button to stop the pump. This button is
only active while the pump is running.
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The window also includes controls to air purge Rf+ systems,
including those equipped with 4x:

¢ Air Purge Cartridge — Click this button to pump
compressed air or external gas through the solid sample
cartridge.

e Air Purge Column - Click this button to pump
compressed air or external gas through the column.

e Stop — Click this button to stop the air purge. This
button is only active while purging.

The right half of the window displays the raw lamp energy.
Click the Close Manual Control button to close the window.
See Also: MANUAL CONTROL OF THE COMBIFLASH RF [6.4.11]

6.3.13 Configuration

The Configuration window allows you to define the operating
characteristics of your CombiFlash Rf system. It also allows
you to configure the system for network connections for remote
access and printing. Open the Configuration window by
selecting the TOOLS>MANUAL CONTROL [6.2.4.2] menu
command.

The configuration window displays three tabs: INSTRUMENT
CONFIGURATION [6.3.13.1], NETWORK CONFIGURATION [6.3.13.2],
and USER PREFERENCES [6.3.13.3].

6.3.13.1 Instrument Configuration

Solvent Controls

¢ Solvents 1 through 4 — From the list of solvents,
specify the solvent connected to the each port of the
system.

¢ Add Solvent button — Click this button to enter a
solvent name. The system can store up to 16 solvent
names. For assistance in selecting appropriate solvents,
see the SOLVENT SELECT table (online).

¢ Remove Solvent button — Click this button to open a
list of all entered solvent names. Select the names you
want to remove and then click the OK button.
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¢ Enable Solvent Level Sensing — (Rf+ systems,
including those equipped with 4x) If this option is
selected, the system will check the solvent levels before
and during a run. The system will alert you if a solvent
level becomes too low. Note that the solvent level
monitoring option does not control the operation of
Waste Solvent Level monitoring. Waste level sensing is
always enabled at the beginning of a run.

* Minimum Solvent Level — This value is
density-dependent, thus a range is given. To understand
the range, consider that dichloromethane is more dense
than hexane. If the selected range is 1-2, an alert would
be triggered when the dichloromethane falls to about 1
cm above the bottom of the weighted filter. At the same
selected range, an alert would be triggered when the
hexane solvent level falls to about 2 cm above the
weighted filter.

CombiFlash Rf Name Enter a name for the system. This name
will appear in the title bar of the Main window. The name will
also appear in run summaries. Unique names are helpful
when operating more than one system.

Time Zone Select your local time zone.

Set Date/Time Click this button to set the date and time. From
the touch screen, this command opens a window that allows
you to set the instrument date and time. If you select this
command from a remotely connected computer, this menu
command automatically sets the system time to match the
computer’s.

| M Note

Note: The system will require restart after you set the time.

To prevent unauthorized time changes, this feature is
password protected. See also: SET ADMINISTRATOR PASSWORD
(6.3.14].

Vapor Limit (Rf+ and Rf+ Lumen) Type or select the vapor
limit setting. The CombiFlash Rf system’s internal vapor
sensor detects vapors present in the immediate atmosphere.
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When this value is exceeded, the system will shut down to
avoid a hazardous condition. For more information, refer to
SETTING THE VAPOR LIMIT [6.4.12].

The Vapor Limit function is an optional addition to the Rf150.

Set Default Tube Volume Click this button to open a window
from which you can set the default volume of the collection
tubes. You can increase or decrease these values to set the
desired default volume collected in each container. Be sure you
do not overfill the containers by exceeding their capacity.

The system will automatically advance to the next tube when
this default volume is met in each tube. Keep in mind that the
PEAK COLLECTION [6.3.2.5] settings on the METHOD EDITOR [6.3.2]
window may override this default volume. During a run, other
factors such as automatic tube advances for detected peaks
will affect collected volume.

Enable Automatic Column Purchase This feature requires a
current subscription in a Teledyne Isco Column Plan. Contact
your sales representative for more information on this feature.
The certificate issued with the column plan includes
instructions for activating this feature. TEST CONNECTION
is used if a column plan is enabled and the system reports
column usage via an internet connection. This control allows
verification of connection to the Column Plan server and aids
troubleshooting connection issues.

Multiple Wavelength Detection (Rf150 Only) This feature
requires a valid activation code for the variable wavelength
option. Contact your sales representative for more information
on this feature.

6.3.13.2 Network Configuration

Network configurations settings require assistance from your
network administrator. Contact your Information Technology
department before changing the settings.

Instrument IP Address Configuration Use these settings to
specify the instrument’s network address and its parameters:

¢ Network Type — Select the “Static IP” option.
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The "Static IP" option will require an IP address, Net
mask, and Gateway provided by you network
administrator. The DHCP option will request these
parameters when the CombiFlash system is rebooted.

¢ IP Address — Enter the static IP Address for the
system. Static IP option only.

¢ Netmask — Enter the Netmask for the system. Static
IP option only.

e Gateway — Enter the Gateway for the system. Static
IP option only.

Network Printing The system can print to a network printer
and supports JetDirect and line printer (LPR) queues.

Consult with your network administrator to determine:
e The IP address of selected printer.

e [fthe printer uses an LPR print queue, you must also
find out the queue name.

e Ifthe printer uses a JetDirect print queue, also ask
for the port number.

e The printer type: either Postscript or PCL.

When this information is known, you can proceed with
configuring system for network printing.

Follow the on-screen instructions for entering the address,
queue, and printer type information. After successfully
printing a test page, the network printer will be available for
printing using the FILE>PRINT... [6.2.1.12] menu command and
the AUTOMATICALLY PRINT REPORT AT END OF RUN feature.

The Network printing controls may also be configured to print
to a local USB printer connected the system’s back panel USB
port. The printer must support postscript printing. To
configure the local printer, select Postscript for the Printer
Type. Then, type the following connection URL:
“usb:/dev/usb/1p0”.

Network File Save Configuration When configured, this
feature allows the system to access a network directory from
which it can save run files as PDF, text, or run monitor. To
enable this feature, select a file type to be saved and enter the
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remaining settings necessary for network access. Your
network administrator will be able to provide the required
settings.

@Note

Note: All server and domain names must be fully qualified. That is,
entries must include the full name (server
name.domain.domain...). Use forward slashes (/), not back
slashes, when entering the network share path.

6.3.13.3 User Preferences
Language Select the language for PeakTrak.

Automatically Print Report at End of Run If this option is
enabled, the system will print a completed run report using
the NETWORK PRINTING feature.

Default Run Units Run units are displayed along the X-axis of
the chromatogram. Select “Time, Minutes” or COLUMN
VOLUMES (online) (CV) run units to be displayed on program
settings and chromatogram displays. The duration in minutes
will vary according to the column media and size, and the flow
rate.

Enable Run Length Extensions When enabled, this option
automatically extends the run if a peak is eluting at the end of
the programmed run length. This ensures that a late-eluting
peak is still collected.

Gradient Method Select the desired gradient method option.

e Ifthe Linear method is selected, solvents A and B will be
mixed gradually from the last programmed %B until the
next programmed %3B is reached. This method connects
the inflection points that define the gradient with a
straight line.

If the Step method is selected, each %B value is held
until the next programmed %B is reached. Because the
%B values are held, the changes at each new value are
nearly instantaneous, producing a stepped appearance
on the plot area.
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e If Isocratic is selected, the system will pump a single %B
mix throughout the run.

Enable Rapid Equilibration Select this option to turn on rapid
equilibration. When enabled, this time-saving feature pumps
solvent at the maximum flow rate during column
equilibration. Note that some column sizes and types might be
adversely affected by high flow rates.

Default MS Graph settings The X-AXIS START control denotes
the starting mass displayed in the mass spectrum graph. The
X-AXIS END control denotes the ending mass displayed in the
mass spectrum graph. In either case, the entire mass
spectrum (50 Da through 1200 (2000 Da PURION L only)

6.3.14 Set Administrator Password

This window, opened by selecting the TOOLS>SET
ADMINISTRATOR PASSWORD [6.2.4.6] menu command, is used to
enter and change the system password, and to enable
password protection for the default methods.

To enter or change a password:
1. Type the password.
The factory default password is combiflash.

2. Type the password again to verify your entry.

3.To protect the Default methods select the “Require
Password For Editing Default Methods” option.

4.Click the OK button to save your settings and close the
window.

The following menu commands will require a password before
displaying the requested window:

¢ TOOLS>EDIT DEFAULTS [6.2.4.4]
¢ ToOLS>USER MANAGEMENT [6.2.4.7]
e HELP>SERVICE [6.2.5.2]

¢ TOOLS>SET ADMINISTRATOR PASSWORD [6.2.4.6]. This
protects the current password.
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6.3.15 User Management

Use the TOOLS>USER MANAGEMENT [6.2.4.71 menu command to
open a window from which you can add and remove system
users. When you add a user, the system will create a user
folder that becomes the data path for that user. User
management, in conjunction with this data path feature,
conveniently lets you store your working files apart from other
system users.

To add a user, click the Add New button and enter the user
name in the window that appears. Another window will
appear to enter a password for the new user. Enter the
password, or leave the text empty if no password is desired. To
delete a user, click the Delete button next to the user’s name
and confirm the action.

Use the CHANGE PASSWORD button to change the password
for a user. To delete a password, leave the text box empty.

See also: SET DATA PATH [6.3.7]

6.3.16 Calibrate Touchscreen

Use TOOLS>CALIBRATE TOUCHSCREEN when the cursor
displays at a significant location from where the screen in
touched. A stylus should be used for this procedure for best
accuracy. A dialog will appear providing further directions.
Use the CANCEL button to cancel the calibration, and the
CALIBRATE button to start the calibration procedure. Note:
once touchscreen calibration is started, it must be completed
or the touch screen may be rendered unusable.

6.4 Examples of PeakTrak actions

In this section you will find instructions for typical PeakTrak
tasks, such as:

® STARTING A RUN USING DEFAULT SETTINGS [6.4.1]

¢ EDITING A METHOD [6.4.2]

¢ ALTERNATIVE WAYS TO CREATE METHOD FILES [6.4.3]
¢ EDITING A DEFAULT METHOD [6.4.4]

¢ DEFINING A GRADIENT [6.4.5]

¢ REAL-TIME GRADIENT EDITING [6.4.6]

e BYPASSING THE SOLID LOAD CARTRIDGE [6.4.7]
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¢ MONITORING THE PURITY MEASURE [6.4.9]

¢ VIEWING RUNS [6.4.10]

¢ MANUAL CONTROL OF THE COMBIFLASH RF [6.4.11]
e SETTING THE VAPOR LIMIT [6.4.12]

6.4.1 Starting a run using default settings
After the CombiFlash Rf system has been set up and
automatically primed (See AUTO PRIME/VALVE WASH [6.3.111),
the system is ready to perform a run using the default
settings. These default settings are preset to the most common
configurations used by chemists, and have been optimized for
the use of RediSep Rf columns. The default settings will:

e collect all fluid in the fraction collector rack

e differentiate between UV (default is 254 nm) vs. non-UV
absorbing fluid and place the fluids into separate tubes

e cut UV absorbing peaks based on slope detection or level
threshold.

To start the run from the PeakTrak Main window:

1. Enter a sample name. If you choose not to, PeakTrak will
enter the date and time as the sample name when you start
the run.

2.Review the PeakTrak Main window settings. If you want to
change any settings, refer to the Editing a Method on-line
help topic.

3.Click the Play button.

4.Select the sample Loading Type from the list. The Loading
Type should support the sample injection technique you
intend to use (see SAMPLE INJECTION METHODS online).
Possible sample loading types for the Rf+ systems,
including those equipped with 4x are:

¢ Solid (Pause) — Select this option if you intend place
the sample into a solid sample load cartridge, but
have not yet prepared the sample. You must also
specify the cartridge type and size (Column plan
subscribers only). When you click the run button, the
system will perform a column equilibration and then
wait while you prepare the cartridge. After you have
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placed the cartridge on the system, click OK to
continue with the run.

¢ Solid — Select this option if you have already
prepared the sample, placed it into a solid sample
load cartridge, and loaded the cartridge on the
system. You must also specify the cartridge type and
size (Column plan subscribers only). The system will
automatically proceed until the end of the
programmed run length.

e Liquid — Select this option if you have prepared a
liquid sample and plan to manually inject it into the
injection port after column equilibration.

¢ None (on column) — Select this option if you have
preloaded the sample on the column. The system will
skip column equilibration so that the sample will not
be flushed from the column before the run.

Loading types for the Rf150 system are:

¢ Equilibration — Select this option if you intend to
equilibrate the column before introducing the liquid
or solid sample.

¢ No Equilibration — Select this option to skip column
equilibration.

5.Review or update the Start Rack and Start Tube.

6.Review the Minimum Run Requirements. The system will

report the estimated solvent volumes, expected waste,
collection tube usage, etc. You can use this information to
verify that there will be enough solvent to complete the
run, the waste volume does not exceed the collection
container’s capacity, and whether or not more tubes will be
required during the run.

Note: The Rf+ systems, including those equipped with
4x estimate the solvent volumes by monitoring the
solvent level in the container and the known usage rate.
The system continues to refine this estimate during
operation.

Note: If the waste level sensing tube is inserted
correctly into the waste container, the system
automatically will suspend operation before an overflow
condition might exist. To prevent the run from being
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suspended before completing the run, ensure that the
container will hold the expected waste volume. Waste
level sensing is not available on the Rf150 system.

7.(Rf+ Lumen only) If the ELSD will be used for the run,
ensure that the ELSD option is selected. Otherwise, you
may disable the ELSD. The Rf+ Lumen system will
automatically check this option if the previous run used the
ELSD.

8.Purlon systems only. If the mass spectrometer will be used
for the run, ensure that the Mass Spectrometer option is
selected. Otherwise, you may disable the mass
spectrometer. The Rf+ Purlon system will automatically
check this option if the previous run used the mass
spectrometer.

9.Purlon systems only. Select "LOW" for highly loaded
columns or samples with a strong molecular ion to reduce
saturation of the mass spectrometer detector. Select
"HIGH" for lightly loaded columns of samples with weak
detection on the mass spectrometer. Default is "Medium".

10.Enter up to 4 ions, or a range and up to 3 ions. On PURION
S and PURION L systems only, the ions may be a mix of
positive and negative.

11.Click OK and the run begins. The system responds
according to the sample Loading Type you selected in
step 4.

Rf+ systems, including those equipped with 4x:
If you selected Solid (Pause), the system equilibrates
the column with the starting %B and then waits while
you prepare the solid sample load cartridge. Place the
cartridge on the system and click OK to continue.
If you selected Solid, the system equilibrates the
column and immediately starts the separation.
If you selected None (on column), the system skips the
equilibration and immediately starts the separation.
If you selected Liquid, the system equilibrates the
column and then waits. When instructed, perform the
following steps:
a. Place the injection syringe on the injection port.
b. Slowly force the liquid into the injection port.
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c. Chase the first injection with a second injection
solution of at least 0.25 mL. The chase solution can be
the starting mobile phase or diluted sample mixture.

d. Click OK to continue the run.

Rf150 systems:

If you selected Equilibration, ensure that the solvent
delivery tubing is connected to the injection port above
the column. When you click the OK button, the system
equilibrates the column and then waits. When
instructed, perform a liquid injection as described in
steps a through d above, or attach the solid sample
cartridge to the injection port and connect the solvent
delivery tubing. Click the OK button to continue.
If you selected No Equilibration, ensure that the
solvent delivery tubing is connected. The system starts
the run immediately and assumes that the sample has
been injected on the column or the solid load cartridge is
in place.
You may allow system to proceed with the run while
monitoring the progress on the PeakTrak Main window. If
desired, gradient parameters may be modified during the run.
(See REAL-TIME GRADIENT EDITING [6.4.6].)

As the run progresses, the absorbance trace is drawn on the
Gradient Plot area. The purification continues until the end of
the run defined by the run length setting.

See Also:

REDISEP RF COLUMN SELECTION GUIDE (online)
SOLVENT SELECTION (online)

EDITING A METHOD [6.4.2]

EDITING A DEFAULT METHOD [6.4.4]

BYPASSING THE SOLID LOAD CARTRIDGE [6.4.7]

6.4.2 Editing a method

Editing a method allows you to tailor the operation of the
CombiFlash Rf system to best separate or purify the
compounds of interest.

PeakTrak has two types of method settings — basic and
advanced.
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6.4.2.1 Basic method settings

The basic settings allow you to control the %B gradient mix,
flow rate, solvents, and run length. These settings are part of
the MAIN WINDOW (6.3.1]. These settings are the most
frequently changed settings when developing or improving
purification methods.

The %B gradient mix and run length are shown on the plot
area. Refer to the DEFINING A GRADIENT [6.4.5] topic for more
details. The other settings are:

¢ Flow Rate — When using the Isco default column
methods, the flow rate is automatically set to the
optimum flow rate of the column. If using a non-Isco
column, refer to the manufacturer’s column
documentation to determine the best flow rate for the
column. Note that if the column is not detected by the
system the operating pressure is limited to 50 psi.

¢ Solvent A and B — Select the desired solvents from the
lists. The solvents are those defined by the
CONFIGURATION [6.3.13] window.

6.4.2.2 Advanced method settings

The METHOD EDITOR [6.3.2] window gives you access to
advanced settings such as equilibration volume, initial waste,
air purge, peak detection, and peak collection mode.

Equilibration Volume Column equilibration is optional, but
you may find that separations are more effective if the column
is equilibrated before injecting the sample. The recommended
equilibration volume is at least three column volumes of the
starting mobile phase.

RediSep Silica gel column volumes are:

e RediSep Rf4 g = 4.8 mL

e RediSep Rf 12 g = 16.8 mL

e RediSep Rf 24 g = 33 mL

¢ RediSep Rf 40 g = 48 mL,

¢ RediSep Rf 80 g = 125 mLL

® RediSep Rf 120 g = 192 mL

¢ RediSep Rf 220 g = 334 mL
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¢ RediSep Rf 330 g = 443 mLL

Other media types will have similar column volumes. Refer to
the REDISEP RF COLUMN SELECTION GUIDE (online) for actual
volumes.

As an example, consider a RediSep Rf 4 g column and a 3
column volumes setting. Before instructing you to inject the
sample, the system will pump 14.4 mL of solvent A through
the column and out the waste port.

Initial Waste & Time Windows The initial waste diverts a
user-determined line volume to the waste port until the eluant
is about to be collected. At the start of a run, the internal
solvent lines hold some solvent from the previous run. This
volume can be diverted to waste, along with the anticipated
volume of fluid that will pass through the column before a
compound of interest will elute.

Time Windows can limit the fraction collection to specific time
durations of the run. To use time windows enter a start time
and an end time. All times are relative to start of the run, just
following the sample injection. Then choose a peak collection
mode. If you select Peaks, the module will collect fluid only
when the time window is active and a peak is present. If you
select All, the module will collect all fluid during the time
window regardless of the peak state. Define up to three time
windows.

Air Purge You can program the system to purge the column
with air after a run. This feature allows you to remove
solvents from the column before it is discarded. Enter the
desired time to purge the column, in minutes. To disable the
post-run air purge, enter zero minutes.

Peak Collection There are three peak collection options: All,
Peaks, or None. The All option will collect peak and non-peak
fluid in tubes. The Peaks option will collect only peak fluid in
tubes and divert all other fluids to the waste port. The None
option will divert all fluids, peak and non-peak, to the waste
port. The None option is useful for developing custom methods
that perform a column wash, system cleaning, or similar
function where solvents and elute do not need to be collected.
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When using the All or Peaks options, you can specify the
maximum Peak and Non-peak volumes to be collected in the
tubes. Be sure to enter volumes less than the maximum tube
capacity. Different peak and non-peak tube volumes can be
used to conserve tubes when using the All peak collection
mode by collecting large volumes of non-peak fluid while
creating more, smaller fraction volumes of fluids of interest.

The fraction collector will advance to the next tube whenever a
peak is detected. Also note that the system will advance to the
next tube if a new peak is detected before completing the last
one (sometimes called a double advance). Tubes may also
advance, when using multiple detectors, depending on
impurities or sensitivity to a given compound by each detector.
Keep in mind that the slope and threshold detection methods
use algorithms which optimize the peak detection. For
example, peak detection includes a hysteresis to reduce the
likelihood of multiple tube advances that may occur if there is
noise at the beginning or tail end of a peak.

Peak Detection This section of the window contains option
buttons to enable and disable various peak detection options.
When an option is enabled, the window also allows you to
modify the setting details for that peak detection option. All
enabled options will be displayed on the chromatogram. The
options and settings for the Rf+ systems, including those
equipped with 4x are described below.

| A Note |

Note: You can select up to four peak detection options (excluding
the External option) on the Rf+ systems, including those equipped
with 4x. If using more than one option, such as A1 with A 2, the
system considers a peak to be present when either option is true
(a logical OR).

¢ .1 and A2 (wavelength 1 and 2) — Enable these
options to use and configure primary and secondary
wavelength detection. When enabled, type or select the
peak detection wavelength in nanometers, then click the
Details button to configure additional settings described
below.

¢ Slope Based — Select this option to enable
Slope-based peak detection. When enabled, peaks will
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be recorded if the slope algorithm indicates a peak
within the Peak Width setting.

Peak Width — Select the average peak width
setting. Peak widths are measured at the baseline.
The slope detector will detect peak widths ranging
from about 0.2 to 2 times the peak width setting. For
example, if you entered a peak width of 1 minute, the
range would be 12 seconds to 2 minutes. For best
operation, the peak width should be set to just over
the average peak width being separated. For
instance, if the average peak width is 45 seconds, you
should enter a peak width of 1 minute. For most flash
chromatography, 1 minute is a good starting point for
a peak width.

Threshold Detection — Select this option to enable
Threshold peak detection. When enabled, peaks will
be recorded if the Absorbance Units (AU) value is
exceeded.

Threshold — Type or select the Absorbance Units
value to be used for Threshold detection.

Note: If both Slope and Threshold peak detection
methods are checked, the system considers a peak to
be present when any one condition is met. This logical
OR operator means that the system will cut a peak
when either the Slope condition is true, or when the
Threshold condition is true.

Monitor — Enable this option to only use the
detection source as a monitor. When enabled, the
detection source will be displayed as a trace on the
gradient plot area, but will not be used to cut peaks.

e All Wavelength Detection — Enable this option to
detect peaks within a user-selected range of
wavelengths. When enabled, click the Details button to
configure additional settings. These settings include the
slope-based and peak width options described in A1 and
A2 above. Additionally, you can type or select the
minimum and maximum wavelengths limits in
nanometers. Peak Width for All Wavelength Detection
also determines the length of time before an automatic
auto-zero of baseline occurs. This period is twice the
peak width setting.
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¢ External Detector — (Rf+ systems, including those
equipped with 4x) Enable this option to use a 0 to 1 volt
analog input signal from an external detector. When
enabled, click the Details button to configure additional
settings. These settings include the slope-based and
peak width options described in A1 and A2 above. The
system will use its internal algorithms to cut detect and
cut peaks based on the analog input signal. Refer to the
External Detector instruction sheet for cable and
plumbing requirements.

e ELS Detector — Enable this option to use the
evaporative light scattering (ELS) detector on an Rf+
Lumen system. When enabled, click the Details button
to configure additional settings:

Signal Gain — You may modify the gain to scale the
detector signal.

Slope Based and Threshold — Refer to these
features described in A1 and A2 above.

Spray Chamber Temperature — The default
settings are 30 °C (normal phase default methods)
and 15 °C (reverse phase). This setting may be
adjusted from 10 to 60 °C so that detection can be
optimized for the solvent system in use. This setting
is limited to a minimum of 5 °C below the ambient
temperature.

Drift Tube Temperature — The default settings are
60 °C (normal phase default methods) and 60 °C
(reverse phase). This setting may be adjusted from 30
to 90 °C, but is limited to a range of 5 °C below and 60
°C above the ambient temperature.

¢ Mass Spectrometer — (Purlon systems only) Enable
this option to monitor or detect compounds with a
Purlon mass spectrometer system.

Threshold - signal level used to detect a peak. This
is based on the baseline noise. The baseline noise is
measured during the first column volume; this is
multiplied by the value entered in the THRESHOLD
control to generate a trigger value. A peak is collected
if the signal is greater than this trigger value.
Monitor — Clicking this option prevents
fractionation based on the mass spectrometer signal.
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Terminate on Target — Stops the run after all mass
spectrometer detection ions have been detected.

DETECTION IONS - Sets ions for detection or to be
monitored. Up to 4 single ions may be chosen, or a
range of ions and up to 3 single ions may be chosen.
On PURION S and PURION L systems, detected ions
may be a mixture of positive and negative ions.

ION SETTINGS - Sets ionization parameters to
enhance detection of molecular ion peaks. See
IONIZATION SETTINGS [6.3.10].

¢ Purity Measure — If using two absorbance
wavelengths, check this option to display a ratio of the
selected wavelengths. The ratio trace is often a useful
indicator of purity. Use the SHOW SPECTRAL PURITY
control to measure purity by using a comparison of
UV-spectra measured at differing times as a purity
measurement. The SPECTRAL PURITY DETECTION
button allows fractionation based on spectral purity.
Refer to the MONITORING THE PURITY MEASURE [6.4.9]
topic for more details of these features. Rf150 systems
have a fixed UV detection wavelength of 254 nm. The
peak detection settings for these systems include
slope-based and peak width options. These are described
in A1 and A2 above. Rf150 systems with the variable
wavelength option include a control to type or set the
detection wavelength.

6.4.2.3 Saving Changes to the Method File

After you have edited the method file, you can save the
changes for future use. Click the Save As button, give the
method file a descriptive name, then click the Save button.
The method file will be stored by the CombiFlash Rf system
and will be available for future runs.

6.4.3 Alternative Ways to Create Method Files

Other than editing a method file on the CombiFlash Rf
system, there are more ways to create method files.

6.4.3.1 Importing Method Files from another System

If a method file is located on another CombiFlash Rf system,
you can use the FILE>EXPORT METHOD [6.2.1.10] menu
command to save the method file on an external storage
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device. From the touch screen panel, this storage device is a
USB Flash Drive connected to the USB port below the display.
If connected to the system via an Internet browser, the storage
device may be any device that can be accessed by the local
computer.

To move the method file onto the system, insert the USB flash
drive into the USB port or connect to the system from the
remote computer, then use the FILE>IMPORT METHOD [6.2.1.9]
menu command to locate and import the method file.

6.4.3.2 Extracting a Method File from a Previous Run

You can perform real-time editing during a run to fine tune
the method. After the run, you can extract the run parameters
as a method file so it can be used on future runs. To do so, open
the Run file and click the Extract button. The system will load
a new method with identical run parameters. You can then
save the method using the FILE>Save Method As menu
commands.

6.4.3.3 Scaling Method Files to Different Column Sizes

If you want to scale a method file to a different column size,
use the FILE>Save As menu command. From the FILES [6.3.6]
window, select the Scale option, then choose the new column
size and click the Save button. The system will create a new
method file with the gradient and run parameters scaled to
the new column size.

This feature is useful when developing methods using small
sample volumes. After you optimize the method to successfully
extract the compounds of interest, you can then scale up the
method to load and extract larger volumes using larger
RediSep column sizes.

6.4.4 Editing a Default Method
Default Methods allow you to quickly recall standard method
settings. There are standard methods for each size and type of
RediSep column. When shipped from the factory, the Default
Methods were set to the settings recommended by Teledyne
Isco.

The Default Method settings can be tailored to your
application. To modify the Default Methods:

1. Select the TOOLS>EDIT DEFAULTS [6.2.4.4] menu command.
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2.If prompted for a password, enter the system password.
(The SET ADMINISTRATOR PASSWORD [6.3.14] window
controls the password protection feature.)

3.Select the column size and media from the RediSep Column
list.

4.Change the settings to meet your specific application
requirements. Refer to the EDITING A METHOD [6.4.2]
instructions.

5.Click the Save button to replace the default method
settings.

You can reset the method to Teledyne Isco-recommended
defaults. While viewing the default method file for a selected
column size and type, click the “Reset file to Isco defaults”
button. The settings will revert to the original factory settings.
Click the Save button to save the settings for future use.

6.4.5 Defining a Gradient

The simplest way to change the gradient is to click and drag
the inflection points that define the shape of the gradient. Add
a point by clicking the Insert button, then click the gradient
curve to add a point. You can then drag the new point to the
desired location. Delete a point by clicking the Delete button
and then clicking the undesired inflection point.

The above methods work in the MAIN WINDOW [6.3.1] and
METHOD EDITOR [6.3.2] window. Alternatively, you can modify,
add, insert, and delete points using a tabular view on the
Method Editor window. Click the Edit Gradient button to open
this view, then use the controls to modify the settings. Click
the Edit Gradient button again to close the table view.

The system can also optimize a gradient from your TLC
results. To use this feature, select a single solvent system and
run two TLC plates, each with a different concentration of
solvent. For example, run one plate at 1:1 hexane:ethyl
acetate, the other at 1:3 hexane:ethyl acetate. If the resulting
Rf values are between 0.2 and 0.8, you can enter the TLC data
in the GRADIENT OPTIMIZER [6.3.3] window. When you accept
the data, the system will generate a gradient curve to separate
the target compound from the nearest impurity. When using
optimized gradients, PeakTrak may automatically insert an
isocratic hold to further increase the resolution.
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6.4.6 Real-time Gradient Editing
The gradient shape can be changed during the run. Any time
after the fraction collector has positioned the drop former over
the first tube, click and drag the points on the gradient plot
area of the Main window. You can also add or remove points by
clicking the Insert or Delete point buttons. The Insert button
allows you to add a single point when you click on the gradient
profile. Repeat this action to add more points. The Delete
button allows you to remove a single point when you click on
it.
Note that only the portion of the gradient that has not yet
occurred during the run can be modified.

6.4.7 Bypassing the Solid Load Cartridge
(Rf+ systems, including those equipped with 4x)
Occasionally, impurities precipitate in the solid load cartridge
as compounds are purified. This may cause high back
pressures resulting in reduced flow rates and long run times.
Clicking this button changes the injection valve position,
which removes the solid load cartridge from the solvent path
and relieves the back pressure.

/N\CAUTION

CAUTION: Bypassing the solid load cartridge too soon during the
purification run may leave desired compounds on the solid load
cartridge. After removing the cartridge from the fluid path, these
compounds cannot be purified.

If you need to use this feature, perform the following to ensure
that you do not leave desired compounds on the cartridge:

1.Run a TLC plate prior to starting the run. Measure the Rf
(retention factor) of the slowest eluting compound of
interest. (The Rf should be between 0.2 and 0.8 — the same
range used by the GRADIENT OPTIMIZER [6.3.3]). Note the
Percent B solvent used to run the TLC plate. If a compound
displays tailing peaks as streaks on TLC, the Rf used
corresponds to the bottom of the streak.

2.Load the Sample in the Solid Load Cartridge and note the
cartridge size. Refer to list below to determine the cartridge
volume. If the cartridge is partially filled with silica, use
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the cartridge volume as if the cartridge were completely
filled with silica.

e 5 gram cartridge = 10 mL volume
e 25 gram cartridge = 45 mL volume
e 65 gram cartridge = 110 mL volume

3.Run the sample and observe the flow rate from the Status
Bar in the upper right corner of the main window. As long
as the system is delivering the programmed flow rate,
there is no need to bypass the cartridge.

4.If the flow rate is slower than that programmed, note the
slowest displayed flow rate. Use the equation below to
determine if the cartridge can be bypassed.

T = Cartridge Volume | (Rf * Flow Rate)

Where T is the time in minutes to wait after the system
reaches the %B solvent used to run the TLC plate; Rf is
the retention factor measured in step 1; Cartridge
Volume is the volume in mL from step 2; and Flow Rate
is the current flow rate in mL/min.

5.0bserve the current %B concentration in the status bar.
Once the system reaches the %B percentage used for the
TLC, wait at least the time established as T'. After this time
has elapsed it is likely that the desired compound has come
off the cartridge and you can safely click the Cartridge
Bypass button.

For example, a TL.C plate run at 30%B revealed that the last
desired compound had an Rf factor of 0.35. An empty 25-gram
size solid load cartridge was filled with sample adsorbed onto
10 grams of silica, and then placed on the system. The
programmed flow rate was 60 mL/min. During the run, the
flow rate dropped to 30 mL/min. The equation is then:

T=45mL / (0.35 * 30 mL/min) = 4.3 minutes
In this example, the Cartridge Bypass feature was used 4.3
minutes after the solvent gradient reached 30% B.

The calculation is conservative, but allows you to minimize the
time needed to keep the solid load cartridge in the fluid path.
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6.4.8 Bypassing the Injection Loop

When in the Prep HPLC mode, the loop bypass button is used
to override the position of the Prep injection loop. During
normal operation the loop is placed into the flow path ahead of
the column after the equilibration is completed. It remains in
this position for the remainder of the separation. This feature
allows the user to remove the loop from the flow path and is
useful for manually stacking injections when doing an
isocratic separation. It will require the user to perform
sufficient method development to know when all of the
compounds elute from the column.

As a simple example, assume that a separation is developed
with 2 compounds that elute at 5 and 10 minutes. At the 5
minute point of the separation, the sample loop can be
removed from the flow path and loaded with another sample of
the same materials. The loop can then be placed into the flow
path at the 6 minute point. In this scenario, the first
compound will elute at 5 minutes, the second compound will
elute from the column at 10 minutes. The first compound in
the second injection will elute at 11 minutes (6 minute
injection time plus 5 minutes to elute) and the second
compound from the second injection will elute at 16 minutes.

In this simple example, the 2 injections can be separated in 16
minutes instead of 20 minutes. The process can be repeated as
needed in increase system throughput. While isocratic
separations may typically be slower than a gradient
separation, you are also able to eliminate the time required for
column equilibration after a gradient separation.

6.4.9 Monitoring the Purity Measure
When using two wavelength detection options, a ratio of the
two wavelengths can also be displayed which at times can
provide the best indication of compound purity. Refer to the
following discussion.

If a pure compound is eluting, the absorbance is linearly
related to the concentration of the compound in the solvent. If
the compound absorbs differently at different wavelengths,
the absorbance at each wavelength may be different, but still
linearly related. For example, assume a compound eluting
from the system has an absorbance equal to 2 times the
concentration at 254 nm. This same compound at 220 nm has
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an absorbance of 1.5 times the concentration. The ratio of
these signals will be 1.33. Since the relationship of absorbance
to concentration is not variable, the ratio remains steady while
the concentration changes from the beginning to the end of the
peak. During the duration of the peak, the ratio will be 1.33
and this constant value is displayed as a horizontal line.

Now assume a case where there is a second compound eluting,
only slightly shifted in time from the original compound. It is
possible that the detection absorbance trace alone would
indicate a single, valid chromatographic peak. In reality, it is a
combination of two peaks. By monitoring a second wavelength,
it may be possible to reveal the second compound. Because of
the slight shift in time and the different absorbance properties
of the two compounds, the changing ratio during the detected
peak would reveal the impurity. Therefore, one can therefore
assume that if the ratio is not constant for the entire duration
of the peak, the compound eluting may not be pure.

The SHOW SPECTRAL PURITY control measures purity by
using a comparison of UV-spectra measured at differing times.
The algorithm used is the "similarity index". The SPECTRAL
PURITY DETECTION button allows fractionation based on
spectral purity. The spectral purity algorithm doesn't will fail
on saturated peaks (flat on top due to detector saturation).

To display the ratio, open the METHOD EDITOR [6.3.2] window
and select the Show Ratio option.

6.4.10 Viewing runs

After completing a run, the PeakTrak Main window is used to
display all collected run data. You can also open previous runs
to view the chromatogram and the peak/tube locations. To
open a previous run:

1. From the main window, select File>Open, or click the Open
button. The FILES [6.3.6] window is displayed.

2.Choose a Run file and click the Open button.
3.PeakTrak displays the run in the MAIN WINDOW [6.3.1].
The PeakTrak Main window will include:

¢ Rack and tube information — The left pane of the
window lists the current rack, a map for that rack, and a
table that lists the peaks and their corresponding tube
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numbers. If the window is currently displaying the
collection parameters, click the DISPLAY RACK button
to view this information. On Purlon equipped systems,
the mass spectrum of the fraction contents can be
displayed by pushing the MS button and clicking on a
tube."

e Method parameters — Click the DISPLAY METHOD
button to view a summary of the peak detection and
collection settings for the run.

e Chromatogram — The right side of the window
displays the chromatogram, identified by the Sample
Name in the title bar of the window.

¢ Option buttons — The option buttons give you quick
access to frequently used commands while viewing a
run. The buttons are:

¢ Print — Click this button to print a run summary.
When viewing the run from a remote personal
computer, the summary can be printed on any
installed printer. If you are attempting to print from
the systems touch panel display, you must first set up
NETWORK PRINTING in the NETWORK CONFIGURATION
[6.3.13.2] settings.

e Save As PDF — Click this button to save the run
summary in PDF file format. When viewing the run
from a remote personal computer, the summary can
be saved to any connected storage device. If you are
attempting to save a PDF file from the touch panel
display, insert a USB Flash drive in the USB port
below the display panel.

e Save As TXT — Click this button to save the run
summary in an ASCII text file format. When viewing
the run from a remote personal computer, the
summary can be saved to any connected storage
device. If you are attempting to save a TXT file from
the touch panel display, insert a USB Flash drive in
the USB port below the display panel.

e Zoom In — Click this button to enable the zoom
feature. Then, click and drag across the region to be
magnified.
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e Zoom Out — Click this button to restore the
chromatogram to the normal view.

¢ Format Graph— Click this button to open a window
from which you can set the left and right Y-axis
scales. These scales are controlled by the Absorbance
and %B upper limits. Clicking the Show Threshold
Level button shows the threshold level setting of all
detectors except the mass spectrometer. The
threshold levels are color-coded to the detector trace.

e MS - Click this button to display a mass spectrum
(Purlon systems only). Clicking in the Chromatogram
window displays a mass spectrum at that point
during the run. Clicking on a tube in the rack map
shows the mass spectrum of the contents of that
fraction.

e UV (will be displayed as vis on UV-vis equipped
systems) - Click this button to display a UV or
UV-visible spectrum (UV-vis systems only). Clicking
in the Chromatogram window displays a mass
spectrum at that point during the run.

e Extract Method button — Click the Extract button to
load a new method file based on the parameters for the
run you are viewing.

¢ Close button — Click the Close button when you are
done viewing the run.

6.4.10.1 General instructions for reading the data

Most elements on the window are color-keyed to help you
locate the tubes containing the peaks of interest. Below each
collected peak there is a color bar that matches a tube in the
map on the left. The tube map provides a visual
representation of the tubes that contain the peaks of interest.
If you wish to identify the tube by number, refer to the table
below the rack diagram.

If the run used multiple racks, the Previous and Next Rack
buttons are active. Click these buttons to scroll through the
available racks. The number of the currently displayed rack is
shown at the top left of the window.
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6.4.10.2 Reading the Chromatogram
The plot area displays the following:

¢ The red absorbance trace produced by the system’s peak
detector. Absorbance units (also shown in red) that
correspond to this trace are shown on the left Y-axis.

e Purple absorbance and green purity measurement
traces may be visible if you are monitoring a second
wavelength. See the MONITORING THE PURITY MEASURE
[6.4.9] help topic.

e Green traces are from ELSD (Lumen systems) or
external detectors.

e The Purlon traces are color coded with the selected
masses below the graph y-axis.

e The blue gradient curve that was used during the run.
The % Solvent B scale is shown in blue on the right
Y-axis.

e The X-axis depicts the run time, shown as minutes or
COLUMN VOLUMES online.

e Vertical lines appear at intervals along the X-axis. These
lines indicate collection tube changes. To prevent the
plot area from being obscured by tube change marks,
PeakTrak may limit the number of marks.

6.4.11 Manual Control of the CombiFlash Rf

Manual Control can assist with method development,
maintenance of the system plumbing, and system
troubleshooting. To manually control the CombiFlash Rf
system, first open the MANUAL CONTROL [6.3.12] window by
clicking the Tools>Manual Control menu command.

6.4.11.1 Pumping Solvents

To pump either solvent, select the solvent from the Solvent A

or Solvent B lists. Then, click the Prime A or Prime B buttons
to pump the selected solvent. To pump a mixture or Solvent A
and B, adjust the Percentage Solvent B setting and then click
the Prime __% B button. When finished, click the Stop button.

You can control the flow rate by adjusting the Flow Rate
mL/min setting.
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By default, the system pumps the solvent directly to the waste
port. With Rf+ systems, including those equipped with 4x, you
can change the fluid path by selecting a different Valve
Position option (through column or through cartridge and
column). For valve positions other than Direct To Waste, you
can pump the solvent into a collection tube. To do so, select the
Pump Into Tube # option and then select which tube (“next” or
specific tube number).

6.4.11.2 Air Purging

On CombiFlash Rf+ systems, including those equipped with
4x, you can purge the solid sample cartridge and column path
with air. To air purge a path, click the Air Purge Solid Sample
or Air Purge Column buttons. Click the Stop button to halt the
air purge.

6.4.11.3 Raw Lamp Energy

The right side of the Manual Control window shows a Raw
Lamp Energy gauge. This provides an indication of the UV
light measured by the optical detection system at 254 nm.
High lamp energy (green) means that the flow cell easily
passes through a sufficient UV light source. Lower lamp
energy (yellow or red) means that either the light source is
weak or that the flow cell is obstructed.

¢ Green — lamp energy is sufficient to detect peaks up to
2.4 Absorbance Units.

¢ Yellow — lamp energy is partially obstructed and the
peak detector performance might be impaired. The
system can be operated although the absorbance trace
might appear noisy. Yellow might be a normal indication
for systems with flow cell windows stained by
compounds.

¢ Red — lamp energy is obstructed to a degree that the
system might not reliably detect peaks. If you attempt to
operate the system, peak collection will be forced to
collect all. This prevents diverting desired compounds to
waste.

Depending on what you are doing with the Manual Control
functions, low lamp energy could be a normal indication. For
example, a UV-absorbing compound could be present in the
flow cell as you are pumping solvent. Or, the selected solvent
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absorbs UV light at 254 nm. Abnormal indications could be a
flow cell blocked by a compound that has precipitated or there
is a film built up on the flow cell. If you suspect the low lamp
energy is an abnormal indication, perform the steps in the
QUICK CLEANING WHEN RECOMMENDED (online) topic.

6.4.12 Setting the Vapor Limit
(Rf+ systems, including those equipped with 4x) The system
has an internal vapor sensor that detects vapors present in
the immediate atmosphere. When the limit is exceeded, the
CombiFlash Rf will shut down to avoid a hazardous condition.

Teledyne Isco recommends using the default setting of 25.
This value represents an organic vapor level slightly above the
ambient vapor level of a well-ventilated laboratory.

A setting below 25 could cause random alarms without
significant vapors present. If PeakTrak displays a Vapor Limit
alarm while the Vapor Limit is set at 25, perform the following
checks on your laboratory and the instrument:

¢ Ensure that no open containers or spills of organic
solvent are in close proximity to the system.

¢ Ensure that the system is located in a well-ventilated
area.

e Ensure that there is no visible solvent leakage from the
system.

If PeakTrak continues to display the Vapor Limit alarm after
you have made these checks and corrected any problems
found, it is likely that organic vapors are present in the
ambient environment of your laboratory. In this case, increase
the setting of the Vapor Limit. Settings greater than 25 are
appropriate for laboratory environments with a somewhat
elevated background solvent vapor concentration,
representing a safe setting, but one with a reduced margin for
error.

6.5
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Section 7 Remote Interfaces

This section provides instructions for controlling the
CombiFlash Rf system through a remote interface. The system
can be accessed by several personal computers through a
corporate network, or by a single personal computer (PC)
through a direct connection.

7.1 Network Configuration

IﬁNote

The procedures described in this section will require assistance
from your network administrator. Contact your Information
Technology department before proceeding.

The system has a factory-assigned IP address—192.168.1.51.
In many cases, this address must be reconfigured for use on a
corporate network. To reconfigure the IP address:

1. From the touch screen panel, select the
Tools>Configuration menu command.

2. Select the Network Configuration tab.
3. Select Static IP as the Network Type.

|§(Note

The CombiFlash Rf system also provides limited support for
DCHP connections. If DHCP is desired, select DCHP as the
network type and skip steps 4 through 7. The system will display
instructions required to complete a DHCP connection.

4. Enter the IP Address, Netmask, and Gateway information
provided by your network administrator.
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| M Note

Should your network administrator request the MAC address, a
label on the system’s back panel lists the Address. You also can
find the MAC Address on the Help>About PeakTrak window.

5. Click the OK button to save the settings.

6. Confirm that your network administrator has completed
any necessary network changes to support the system.

7.Locate the CAT5 connection cable (P/N 480-6545-01) in the
accessory package. Insert one end into the Ethernet port on
the back panel. Connect the other end of the cable to your
network access port.

You should be able to connect to the CombiFlash Rf from a PC
on the network (Section 7.1.1) and configure other network
features such as network printing (Section 7.1.2) and network
file saving (Section 7.1.3). Networks with Wi-Fi access points
may also support remote control with mobile digital devices
(Section 7.1.4).

7.1.1 Network PC Access

A successfully networked CombiFlash Rf system can be
accessed by a PC that meets the recommendations listed in

Table 7-1.

Operating Systems: Microsoft Windows 2000, XP, Vista, or Windows 7

Hardware: The computer hardware must meet the minimum
required specifications of the selected operating
system.

Network Protocol: TCP/IP

Network Connection: IEEE 802.3 (Ethernet)

Display: 800 x 600 pixels, 256 colors, minimum

Internet Browser: Last two versions of Microsoft Internet Explorer

a. This table shows supported PC configurations. Other configurations or
AJAX-compatible browsers may be possible but are unsupported by Tele-
dyne Isco.
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To access the system, simply open an Internet Browser and
enter the IP address as “http://___._ . . ” where the
blanks are replaced by the selected address. The browser
window will load PeakTrak after you enter the address.

7.1.2 Network Printing

The CombiFlash Rf system can print to a network printer and
supports both JetDirect and line printer (LPR) queues.

Consult with your network administrator to determine the IP
address of selected printer. If the printer uses an LPR print
queue, you must also find out the queue name. If the printer
uses a JetDirect print queue, also ask for the port number.
When this information is known, you can proceed with
configuring system for network printing.

1. Select the Tools>Configuration menu command.
2. Select the Network Configuration tab.

3. Follow the on-screen instructions for entering the address
and queue information.

4. Click OK to save the settings. The CombiFlash Rf system
will send a test page to the printer.

After successfully printing a test page, the network printer
will be available for printing using the File>Print menu
command or through the Automatically Print Report at End of
Run option on the Tools>Configuration User Preferences tab.

7.1.3 Network File Save Configuration

By default, this option is disabled and post-run reports are
automatically saved internally on the CombiFlash Rf system.
You can recall any run and view it from the system as long as
the .RUN file has not been deleted. To save the post-run report
for viewing elsewhere, you can save the run history as text or
PDF files as needed. This Disabled option is useful when there
is no need, or only an occasional need to save a run history file
externally.

To save all run histories automatically as a text or PDF file,
configure the Network File Save option. This allows the
CombiFlash Rf system to access the corporate network and
save the file in a selected Network Share folder. Consult with
your network administrator to configure these fields.
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7.1.4 Apple Mobile Digital Devices

You can wirelessly monitor and control CombiFlash Rf 75, Rf*,
Rf* Lumen and CombiFlash Torrent systems using the
PeakTrak app, which is available for download from the App
Store. The app is designed for a mobile digital device (iPod
Touch, iPhone, and iPads) running iOS 4.2 or later and is
compatible with CombiFlash systems running PeakTrak
version 2.1.15 or greater.

| M Note

Remote communication requires the CombiFlash Rf system and
mobile digital device to share a common network with Wi-Fi
access in the remote location. Refer to the Remote Interfaces
section in the system’s user manual for details on network
configuration.

7.1.5 Install and Configure the PeakTrak App

1. From the Apple mobile digital device, visit the App Store
and locate the “PeakTrak” app by Teledyne Isco.

@Note

The App Store requires an Internet connection on the Apple
mobile digital device.

2. Install the app on the Apple mobile digital device.

3. Open the PeakTrak app.

4. From the PeakTrak display, tap the “+” button.

5. Enter a descriptive name for the CombiFlash system.

6. Enter the address for the CombiFlash system. The
assigned address from the system’s touch panel display can
be located using the Help>About PeakTrak menu
command.

7.Tap the Connect button to save the information and
connect to the system. Or tap the Save button to save the
information and enter additional systems.

7.2 Direct Connection

A direct connection supports communication between the
CombiFlash Rf system and a single PC that meets the
recommendations in Table 7-1.
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This guide provides instructions for Windows 7 (7.2.1),

Windows Vista (7.2.2), Windows XP (7.2.3), and Windows 2000
(section 7.2.4). Refer to the applicable section, then follow the
instructions in section 7.2.5 to complete the direct connection.

| M Note

A direct connection requires a “crossover” CAT5 cable. Standard
CATS5 network cables will not work. You can purchase a crossover
cable locally or ask your Information Technology department to
assemble one. You can also order a crossover cable (part number
480-6545-02) from Teledyne Isco.

| M Note |

These instructions assume that the system is using the factory-set
IP address of 192.168.1.51.

IﬁNote |

The following instructions may require a user account with
Administrator privileges on the PC. If you cannot modify the
settings in sections 7.2.1 through 7.2.4, contact your Information
Technology department.

7.2.1 Windows 7 Settings
1. From the Windows Start menu, select Control Panel, then
select the Network and Sharing Center option. The PC
displays the Network and Sharing Center.

2. Select the Change Adapter Settings option to display the
available network connections.

3. Right-click on the Local Area Connection icon and select
the Properties option.

4. Select Internet Protocol Version 4 (TCP/IPv4) and click the
Properties button. The PC displays the Internet Protocol
Version 4 (TCP/IPv4) Properties window (Figure 7-2).

IﬁNote |

If the Internet Protocol Version 4 (TCP/IPv4) option is not listed,
click the Install button to add it. If assistance is needed, press the
F1 keyboard button to display Windows Help.
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| M Note

The following steps change the local area connection settings. If
the PC must be restored to its original network configuration,
record the present Internet Protocol (TCP/IP) settings now.

5. Select the “Use the following IP address” option.
6. Enter the IP address “192.168.1.200”.
7. Enter the Subnet Mask, “255.255.255.0.”

8. Click the OK button to close the Internet Protocol Version 4
(TCP/TPv4) Properties window. Click the OK button to close
the Local Area Connection properties window.

9. Shut down the PC and place the CombiFlash Rf system in
Standby.

= Local Area Connection Properties ==

Metworking

Connect using:

&Y VMware Accelerated AMD PCNet Adapter

Corfigure

This connection uses the following tems

™ Client for Microsoft Networks

4= (105 Packet Scheduler

Bﬁle and Printer Sharing for Microsoft Metwarks
- Intemet Protocol Version 6 (TCP/IPvE)

B el Protocol Verion 4 (TCP/IPv) |

i Link-Layer Topology Discovery Mapper /O Driver
& Link-Layer Topology Discovery Responder

Install... Uninstal
Description
Transmission Control Protocol/Intemet Protocol. The default

wide area network protocol that provides communication
across diverse interconnected networks.

OK Cancel

Figure 7-1 Local Area Connection Properties
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Internet Protocol Version 4 (TCP/IPvd) Properties @
General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

“ Obtain an IP address automatically
@) Use the following IP address:

1P address: 192 .168 . 1 . 200
Subnet mask: 255 . 255 . 255 . O
Default gateway:

@) Use the following DNS server addresses:
Preferred DNS server:

Alternate DNS server:

Advanced...
———

Figure 7-2 Internet Protocol Version 4 (TCP/IPv4) Properties

7.2.2 Windows Vista Settings

1.From the Windows Start menu, right-click on Network,
then select the Properties menu option. The PC displays
the Network and Sharing Center.

2. Under Tasks, select Manage Network Connections.

3. Right-click on the Local Area Connection icon and select
the Properties option. After you provide permission to
continue, the PC displays the Local Area Connection
Properties window (Figure 7-1).

4. Select Internet Protocol Version 4 (TCP/IPv4), then click
the Properties button. The PC displays the Internet
Protocol Version 4 (TCP/IPv4) Properties window
(Figure 7-2).

| M Note

If the Internet Protocol Version 4 (TCP/IPv4) option is not listed,
click the Install button to add it. If assistance is needed, press the
F1 keyboard button to display Windows Vista Help.
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| M Note

The following steps change the local area connection settings. If
the PC must be restored to its original network configuration,
record the present Internet Protocol (TCP/IP) settings now.

5. Select the “Use the following IP address” option.
6. Enter the IP address “192.168.1.200”.
7. Enter the Subnet Mask, “255.255.255.0.”

8. Click the OK button to close the Internet Protocol Version 4
(TCP/TPv4) Properties window. Click the OK button to close
the Local Area Connection properties window.

9. Shut down the PC and place the CombiFlash Rf system in
Standby.
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7.2.3 Windows XP Settings
1. From the Windows Start button, open the Control Panel.

2. Locate the Network Connection icon and open this control
panel.

3. Highlight the “LLAN or High-speed Internet Connection”
icon. Select the “Change settings of this connection” option,
or right-click and select “Properties.” Refer to Figure 7-3.

4. Highlight the “Internet Protocol (TCP/IP)” item in the list,
and click on the “Properties” button. Refer to Figure 7-4.

5.Select the Alternate Configuration tab. Click the “User
Configured” option. See Figure 7-5.

6. Enter the IP address “192.168.1.200”.
7. Enter the Subnet Mask, “255.255.255.0.”

8. Click the OK button to close the Internet Protocol
properties window. Click the Close button to close the Local
Area Connection properties window.

9. Shut down the PC and place the CombiFlash Rf system in
Standby.

iix

Fle Edit Vew Favorites Iools Advanced Help | "

Q- - T ‘ ) semch Folders ‘E‘
Address [ hetwork Connections 8

[ create a new connection
@ Disable this network device
©, Repair this connection

=) Rename this connection
L) View status of this
connection
Change settings of this
connection

Figure 7-3 LAN or High-speed Internet Connection
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General | Authentication I

Connect using

| E# 3Com 30920 Integrated Fast Ethemet Controller {3C905C-

This connection uses the following items:

%Oism for Microsoft Metworks
gﬁ\e and Printer Sharing for Microsoft Networks
BODS Packet Scheduler

Install | Whinstall Propertties

~ Description
Transmission Control Protocol/intemet Protocol. The default

wide area network protocol that provides communication
across diverse interconnected networks.

™ Show icon in notification area when connected

0K Cancel

Figure 7-4 Local Area Connection Properties

Internet Protocol (TCP/IP) Properties 2] x|

General Altemate Configuration |

If this computer is used on mare than one network, enter the aftemate [P
settings below.

™ Automatic private IP address

1P address: 192 168, 1 . 200

Subnet mask: |255 255 255 . 0
Default gateway: I . .

Erefemed DNS server. .
Atemate DNS server: .

Prefemed WINS server: I . .
Altemate WINS server: I

cos
Figure 7-5 Alternate Configuration Settings
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7.2.4 Windows 2000 Settings

1. From the Windows Start button, select “Settings>Control
Panel” to view the control panels.

2. Locate the “Network and Dial-up Connections” icon and
open this control panel.

3. Highlight the “Local Area Connection” icon. View the

properties by right-clicking and selecting “Properties.” The

Local Area Connection Properties Window will open
(Figure 7-6).

4. Highlight the “Internet Protocol (TCP/IP)” item in the list,

and click on the “Properties” button. The Internet Protocol
Properties Window will open (Figure 7-7).

IﬁNote

The following steps change the local area connection settings. If
the PC must be restored to its original network configuration,
record the present Internet Protocol (TCP/IP) settings now.

5. Click the “Use the following IP address” option.
6. Enter the IP address “192.168.1.200”.
7. Enter the default Subnet Mask “255.255.255.0.”

8. Click the OK button to close the Internet Protocol

properties window. Then, click the OK button to close the
Local Area Connection properties window.

9. Shut down the PC and place the CombiFlash Rf system in
Standby.
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Local Area Connection Properties

General I

21|

Caonnect using:

Components checked are used by this connection:

3Com 3C320 Integrated Fast Ethemet Controller [3C306C-

B Client for Microsaft Metwarks
File and Printer Sharing for Microsoft Metworks
%~ 3Com BCAITDI DMI TOI

Uninstall

Install... I

Properties

r— Description

Tranzmission Contral Protocaol/Intemet Protocol. The default
wide area netwark pratocol that provides communication
across diverse interconnected networks.

I™ Show icon in taskbar when connected

0k Cancel

Figure 7-6 Local Area Connection Properties Window

Internet Protocol {TCP/IP) Properties

21|

General |

‘You can get IP settings assigned automatically if your netwark. supports
this capability. Otherwise, you need to ask your network administrator for

the appropriate [P settings.
{~ Dbtain an IP address automatically
—{* Uge the following IP address:
P address:

192.168. 1 . 200
|255.255.255. a

Subnet mask:

Default gateway:

= [htain DNE server addiess automaticalls
—{* Usg the following DNS server addresses:

Erefered DMS server: I . . .

Alternate DNS server.

Advanced |

Cancel
Figure 7-7 Internet Protocol Properties Window
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7.2.5 Completing the Direct Connection

1. Connect the PC to the CombiFlash Rf system using the
cross-over cable.

2. Turn the system’s On/Standby switch to ON. Wait for the
PeakTrak operating screen to appear on the CombiFlash Rf
system, then start the PC.

3. Start Internet Explorer and type the factory default
address “http://192.168.1.51”. The browser will display the
PeakTrak screen.

| M Note

The PeakTrak screen indicates that the direct connection is
working.

The CombiFlash Rf system and the PC are now configured for
communication through a direct connection. Refer to
PeakTrak’s on-line help for operating instructions.
Abbreviated instructions can be found in Section 5 of this
guide.

7.3 Direct Printing

The CombiFlash Rf system supports direct printing to a USB
printer. The printer must support postscript. To set up the
printer:

1. Connect the printer with the USB cable to the USB port on
the back panel of the system.

2. Select the Tools>Configuration menu command.
3.Select the Network Configuration tab.

4. Select the Postscript option for the Printer Type.
5. For the Connection URL, enter “usb:/dev/usb/lp0”.

6. Click OK to save the settings. The CombiFlash Rf system
will send a test page to the printer.

After successfully printing a test page, the local printer will be
available for printing using the File>Print menu command or
through the Automatically Print Report at End of Run option
on the Tools>Configuration User Preferences tab.
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Section 8 Maintenance

8.1 System Standby and Shut Down

During extended periods of inactivity, you can place the
system in Standby to conserve power. To do so, log off the

system (File > Log out) and place the (/) On/Standby switch in
Standby.

When in the Standby state, normal system operation is no
longer available from the touch screen or remotely. However,
some internal components are still powered.

/A WARNING

As long as the AC mains power cord is connected, power is
inside the unit. The mains power cord is the disconnect device.
Position the CombiFlash Rf system so that the power cord can
be unplugged, or use a power strip where the plug can quickly
be removed from the outlet in the event of an emergency.

When you first place the system in Standby, internal
components continue to operate for almost one minute while
performing file maintenance and preparing the system for
possible power removal.

/N\CAUTION

Removing the AC mains power cord before the file maintenance is
complete might corrupt files on the internal hard drive. These
corrupted files can cause abnormal operation or a complete
system failure that requires service. Unless power must be
removed due to an emergency, always wait at least one minute
after placing the system in Standby before removing the AC mains
power cord.
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8.2 Preventive Maintenance

The system requires preventive maintenance for safe and
reliable operation. Refer to the schedule below for the
minimum periodic maintenance requirements.

As Needed — Perform these tasks as conditions require:
¢ Cleaning (section 8.3).

¢ Quick flow cell cleaning when recommended by a system
alert message (section 8.5.2).

e Wipe cone on Purlon system with wipe soaked with
methanol or water to remove visible residue near cone
inlet. (Purlon systems only).

Every Run — Perform these tasks at the end of each run:

¢ Allow the separation run to finish with a high
percentage of solvent B to flush residual compounds
from the column, internal tubing, and flow cell. Refer to
section 8.5.1.

e Allow Cone wash to run to completion (Purlon systems
only) to wash residual compounds from the fluid
interface, probe, and to clean the cone area.

Monthly — Perform these tasks at least monthly, more
frequently if conditions warrant:

e Tubing Inspection (section 8.4).
e Collection rack and tray cleaning (section 8.3.1).
e Monthly flow cell cleaning (section 8.5.3).

Annually - Perform these tasks at least annually, more
frequently if conditions warrant:

¢ Change roughing pump oil (Purlon systems only)

8.3 Cleaning

To clean the exterior surfaces, use a cleaning cloth dampened
with a mixture of distilled water and a mild detergent. Use
isopropyl alcohol for tougher stains.

On printed areas such as labels, avoid rubbing vigorously or
using aggressive solvents like acetone. Each will ruin the
printed text.
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/\CAUTION
Do not immerse the instrument in a water bath or subject it to a
liquid spray. The instrument is not watertight and these actions
could damage the internal electronics.
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8.3.1 Collection Rack and Tray Cleaning

/MN\WARNING

Risk of fire or equipment damage. Unclean collection racks and
tray might inhibit their conductive properties. The racks and
tray must be kept clean to dissipate static electricity.

The collection tube racks and tray are made of conductive
plastic. Dirt, film, or coatings might prevent their ability to
dissipate static electricity. To avoid problems that possibly
result from an electrostatic discharge, clean the racks and tray
monthly. Use distilled water with a mild detergent. For
tougher stains, use isopropyl alcohol.

8.4 Tubing Inspection

/MN\WARNING

Risk of fire or equipment damage. Faulty tubing, fittings, and
drains may allow organic solvents to pool in unsafe areas,
creating a potential for dangerous levels of flammable vapors.
Improper draining may damage the instrument’s internal
components.

Perform a tubing inspection monthly:

1. Visually inspect the solvent, waste, and drain tubing. The
tubing must be free of any damage, kinks, or deterioration.
Fittings should show no signs of leaks.

2. Test the collection tray drain and top shelf drain by
connecting a vacuum or air supply source to the outlet end

of the drain tubes. Then, verify the presence of such
vacuum or air supply source on the drain hole (Figures 8-1

and 8-2).
Correct any deficiencies before returning the instrument to
operation.

8-4
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o O

Figure 8-1 Collector tray drain hole

N\ —
D

Figure 8-2 Top shelf drain hole

v Vacuum or

pressurized air
applied to the outlet
end of the drain
tube must exist at
the collection tray
drain hole.

L— Vacuum or

pressurized air
applied to the outlet
end of the drain
tube must exist at
the top shelf drain
hole.
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8.5 Flow Cell Cleaning

8.5.1 Post Separation
As a preventive measure, all default column methods finish
the separation run with a high percentage of solvent B
(Figure 8-3). This brief time (two to three column volumes) of
strong solvent flushes residual compounds from the column,
flow cell, and internal tubing.

End of T 100
Separatlorl " Flush | -
// ! —
7/ | —
. ! —75 o
. ‘ C g
y &
Separation - ! B 3
Gradient,” | 50
7 | [ wn
/ | o
7 I - <
7z | = CDD
% 'Endof 25 =
/ i Run [
/ | -
- - - Initial %B Next Run Initial %B - - - - - T o
| | | | | | | | |
[ [ [ [ [ [ [ [

Time or Column Volumes

Figure 8-3 Default post-separation column and flow cell flush

Skipping the post-separation flush may cause residual
compounds to build up and crystallize, which might result in:

¢ cross contaminating later separation runs
¢ higher operating pressures

¢ reduced flow cell lamp energy

¢ a noisy baseline on the absorbance trace

¢ frequent messages recommending flow cell cleaning
(Figure 8-4).

Typically, chemists Stop and then Fast Forward the run after
the last compound elutes. This action skips the
post-separation flush. If any of the above conditions appear,
consider allowing some of the runs to continue through the
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flush, or run a high percentage of %B solvent through the
system for a few minutes at the end of each day.

If the separation runs always continue through the flush and
the conditions still occur frequently, edit the default column
methods to extend the flush duration.

/N\CAUTION

Do not use polar, basic solvent systems with silica column
media. These solvent systems may break down the silica
structure, possibly causing obstructions in the flow path.
Examples of such solvent systems include, but are not
limited to, those containing more than 20% methanol with
ammonia.

8.5.2 Quick Cleaning when Recommended
When the lamp energy is lower than normal, the system will
recommend flow cell cleaning (Figure 8-4) before starting a
separation run.

Flow cell cleaning is recommended. Continued operation
without cleaning may result in a noisy trace.

Lamp Data = 5@ 81
COMTIMUE A0JC
CAMCEL RUM COLLECT ALL HELP

Figure 8-4 Flow cell cleaning message

When the system displays this message you can:

e Cancel Run (recommended) — Click the Cancel Run
button so you can perform a quick cleaning described in
the following steps.

¢ Continue Collect All — Click this button to ignore the
message. Because the peak detection operation might be
impaired, the system automatically collects all fluids to
avoid diverting compounds of interest to waste.

e Help — Click this button to display the flow cell cleaning
on-line help topic.

To perform a quick cleaning:

EAR99 Technology Subject to Restrictions Contained on the Cover Page 8-7



CombiFlash® Rf* User Manual

1. After clicking the Cancel Run button, select the
Tools>Manual Control menu option.

2. From the Manual Control window (Figure 8-5), note the
Raw Lamp Energy level at 254 nm. The Raw Lamp Energy
gauge has two ranges: red and green.

RAW LAMP ENERGY: 1000 at 81 ms

The flow cell should be cleaned for optimal
detector performance. A dirty flow cell may cause
the detector signal to appear "noisy"

( FLOY CELL CLEAMIMG HELP )

Figure 8-5 Raw Lamp Energy Gauge

¢ Red - lamp energy is obstructed to a degree that the
system might not reliably detect peaks. If you
attempt to operate the system, peak collection will be
forced to collect all. This prevents diverting desired
compounds to waste.

e Green - lamp energy is sufficient to detect peaks up
to 2.4 Absorbance Units.

3.Remove the column and insert a bypass tube between the
upper and lower column mounts. A bypass tube (P/N
209-0165-46) can be found in the accessory kit shipped
with your system.

4. Set the Flow Rate to 40 mL/min (Figure 8-6).
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SOLVENT &
hexane PRIME £
SOLVENT B
ethyl acetate PRIME B [}
PERCENTAGE SOLVENT B (—)
: PRIME 50% B
20 v
FLOWY RATE, mifmin
- STOP
a0 v
@ PLIF INTO TUEE # __
VALVE POSITION
Through column "v

Figure 8-6 Manual Control Settings - Quick Cleaning

5.Select Through column for the Valve Position option.

6. Select Next for the Pump into Tube # option. By pumping
into a collection tube, the diverter valve is also cleaned of
any residue during this operation.

7.Click the Prime B button to pump 100% Solvent B through
the bypass tube and into the collection tubes.

IﬁNote |

Pumping solvent B at a moderate flow rate (25 to 45 mL/min) over
time will usually solubilize obstructions. Generally, the
recommended solvent is the highest polarity solvent you have
recently used (solvent B).

8. Monitor the Raw Lamp Energy gauge. As the system
pumps solvent, the raw lamp energy should gradually
improve. Pump solvent for two to five minutes or until the
indicator reaches the far-right of the green range.

If after five minutes the indicator is still in the red range,
repeat the cleaning steps using an alternative solvent
(Table 8-1). Or, complete the steps in the Monthly Flow Cell
Cleaning procedure (section 8.5.3).

| M Note |
If the numerical values of the Raw Lamp Energy (Figure 8-5) do
not change, or if the first number remains at zero, contact
Teledyne Isco’s Technical Service department.
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Table 8-1 Suggested Flow Cell Cleaning Solvents?®

Solvent Description

Methanol Miscible with most LC solvents. Methanol will force other
solvents through the system so they will not interfere with
the next sample.

Acetone Common organic solvent with high dissolving properties.

Acetone absorbs UV light at 254 nm. Therefore, the Raw
Lamp Energy gauge will always read red when acetone is
in the flow cell. After pumping acetone, pump a different
solvent through the system to remove the acetone and
read the Raw Lamp Energy gauge.

Dichloromethane
(DCM)

Effective at solubilizing organic molecules.

Dimethylsulfoxide
(DMSO)

Strong solvent that will clear organic sample.

Dimethylformamide
(DMF)

Strong solvent if other solvents do not produce the
desired results.

aqueous solution

Tetrahydrofuran Strong solvent.

(THF)

Water/DMF/ A 50/25/25 solvent mixture effective in clearing some
methanol obstructions.

Water/DMF/ 30/30/30ml solvent mixture effective in clearing some
Acetic Acid obstructions.

Mildly acidic 0.5M acetic acid in distilled water can be used to clear
aqueous solution samples that are not removed by organic solvents.
Mildly basic A dish-type detergent solution can wash through

particulates not picked up by the acidic solution. The
emulsification effect of detergent is an effective tool as
well to help wash through oily samples. Follow the
detergent with several minutes of clean, distilled water.

a. Recent synthesis solvents should also be considered.

8.5.3 Monthly Flow Cell Cleaning
Perform this procedure as part of your scheduled preventive
maintenance, or when Quick Cleaning As Required (section
8.5.2) does not improve the lamp energy.

1.Remove the column and insert a bypass tube between the
upper and lower column mounts. A bypass tube (P/N
209-0165-46) can be found in the accessory kit shipped
with your system.

8-10
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2. From the menu, select Tools>Manual Control. This opens
the Manual Control window.

3. Set the Flow Rate to 40 mL/min (Figure 8-6).
4. Select Through column for the Valve Position option.
5. Select Next for the Pump into Tube # option.

6. Place the B1 Solvent inlet line into a reservoir of methanol,
acetone, or a strong solvent that readily dissolves residual
sample material.

7.Click the Prime B button to pump 100% Solvent B through
the bypass tube and into the collection tubes.

8. After three minutes, click the Stop button. Allow the
system to stand for at least six hours. Overnight is
recommended.

9. Return the B1 solvent line to the original solvent container.

10. Perform the Quick Cleaning as Required (section 8.5.2) and
monitor the Raw Lamp Energy.

If the lamp energy is in the green range return the system
to operation. If the lamp energy is red, contact Teledyne
Isco’s Technical Service department for assistance.

8.6 Purlon Maintenance

8.6.1 Removing ESI Probe
Refer to Figure 8-7 for procedure illustration.

1. Use Menu item MS -> Standby to place the Purlon into
standby mode.

2. Disconnect the high voltage connector by pulling straight
up (do not twist).

3. Unscrew the 10-32 PEEK fitting from the probe.

4. Disconnect the 1/8" PTFE nebulization gas tubing from the
push-to-connect fitting.

5. Loosen the thumb screw on the ion source block.
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6. Pull out the ESI Probe directly up and out of the ion source
chamber.

Figure 8-7 Removing the ESI probe

8.6.2 ESI Probe Replacement
1.Insert the ESI probe into the source chamber (ensure the
corona discharge pin is removed from the source chamber.
Refer to Removing the Ion Source Chamber and
Reinstalling the Ion Source Chamber to remove the corona
discharge pin- APCI equipped systems only).

2.Push down on the ESI probe and tighten the thumb screw
on the ion source chamber to ensure the ESI probe is fixed
in position.

| M Note

Failure to tighten the thumbscrew will result in Error 317, indicating
the probe is not fully seated in the ion source housing.

3. Connect the 1/8" PTFE tubing into the push-to-connect
fitting labeled as 'Neb Gas'.

4. Finger-tighten the 10-32 PEEK fitting.

5. Connect the high voltage connector.
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8.6.3 APCI Probe Removal
Refer to Figure 8-8 for procedure illustration.

1. Disconnect the high voltage connector by pulling straight
up (do not twist).
2. Unscrew the 10-32 PEEK fitting from the probe inlet.

3. Disconnect the 1/8" PTFE tubing from the push-to-connect
fitting labeled as 'Neb Gas'.

4. Disconnect the 1/8" PTFE tubing from the push-to-connect
fitting labeled as 'APCI heated gas'.

5. Loosen the thumbscrew on the front of the ion source
housing.

6. Carefully lift and pull out the APCI probe from the source
chamber.

7.1If changing to ESI, remove the corona discharge pin (see
removing the ionization source chamber section).

Figure 8-8 Removing the APCI probe

8.6.4 APCI Probe Replacement
1.Remove the ion source housing and install the corona
discharge pin. The pin should not be placed over the cone
inlet hole, but rather at the "9:00" position.
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2. Insert the APCI probe into the source chamber.

3. Push down on the probe and tighten the thumbscrew on
the front of the ion source housing.

4. Connect the 1/8" PTFE tubing labeled "Neb Gas" into the
push-to-connect fitting labeled as 'Neb Gas'.

5. Connect the 1/8" PTFE tubing labeled "APCI" to the
push-to-connect fitting labeled as 'APCI heated gas'.

6. Finger-tighten the 10-32 PEEK fitting.

7.Connect the high voltage connector.

8.6.5 Removal of Ion Source Housing
1. Follow the steps in "Removing the ESI Probe" or

"Removing the APCI Probe" as appropriate to disconnect
the lines.

2. Loosen the two thumb screws and unscrew the %4-28 PTFE
tube fitting labeled as 'heated desolvation' from the side of
the chamber.

3. Gently lift and pull out the ion source chamber.

8.6.6 ESI and APCI Removal from Purlon S and Purlon L
Refer to Figure 8-9 for procedure illustration.

1. Place the mass spectrometer Standby mode.
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2. Unscrew the %4-28 PEEK fitting at the top of the ion source
housing.

3. Loosen the two clamps at both sides.

4. Gently lift and pull out the source housing.

Figure 8-9 ESI and APCI removal from Purlon S and Purlon L

8.6.7 ESI and APCI Replacement from Purlon S and Purlon L
1. Carefully place the ion source housing on top of the base
plate and line up with the rear electrical connection. Push
down until source chamber is seated evenly across the base
plate.

2. Lock down two housing clamps at both sides.

3. Finger-tighten the %4-28 PEEK fitting at the top of the
source housing.

8.6.8 Cleaning the Ionization Source Capillary
Plugging of the capillary (either in the ESI or APCI probe)
causes the pressure of the carrier fluid from the fluid interface
to exceed the maximum operating pressure indicated by Error
310 or Error 316. This error can be avoided by filtering
directly injected samples through a 0.45 p syringe filter. To
unplug the capillary, complete the following:

1. Complete the appropriate procedure to remove the probe
from your system.
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2. Using a 1 ml syringe, with Luer-Loc and adaptors,
connected to ESI or APCI capillary and push fluid through
to remove plug. If this procedure does not resolve the issue,
an HPLC pump can be connected to the inlet fitting.

—

( 3

Figure 8-10 ESI probe with syringe

3.If this procedure fails to unplug the capillary, refer the
instructions for the rebuild kit provided with your Purlon
system.

4. Reinstall the probe following the appropriate procedures
for your system.

8.6.9 Replacement of Ion Source Housing

1. Place the ion source housing on top of the base plate and
line up with the rear electrical connection. Push down until
source chamber is seated evenly across the base plate.

2. Finger tighten the two thumb screws and finger- tighten
the 14-28 PTFE tube fitting labeled as 'heated desolvation'
on the side of the housing.

3. Follow the steps in "Replacing the ESI Probe" or "Replacing
the APCI Probe" as appropriate to reconnect the lines.

8.6.10 Overpressure Error

The fluid interface has a pressure transducer to monitor
pressure of the carrier fluid. Since the sample is introduced at
the splitter valve, plugs usually occur between the valve and
the Purlon source sprayer. The most common location for a
plug is within the probe capillary. The occurrence of plugs can
be reduced by using a 0.45 pu syringe filter when injecting
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samples for Method Development and Ionization Settings. To
troubleshoot an over pressure error, complete the following:

e If the error occurs during a run, select CONTINUE
WITHOUT Purlon, and the purification can continue
without the Purlon signal or peak detection, but will rely
on any other detector selected such as UV or ELSD. This
allows the run to be completed before troubleshooting
the plug.

¢ Use the menu item MS-> Manual control [MS MANUAL
CONTROL [6.3.9]].

e Press the Start Carrier Pump button.
e Watch the pressure on the ribbon gauge.

® Loosen the fitting at the source inlet. If the pressure
drops, then the source capillary is plugged.

e If there is still an error or the pressure remains high,
then the plug is between that point and the splitter
valve (or the valve itself). Continue to loosen fittings
going back the to the splitter valve until the error is
corrected.

8.6.11 Check Valve Cleaning
If the check valves are allowed to dry out after using volatile
salts (e.g., ammonium acetate or ammonium formate), they
may stick and fail to function. Complete the following to clean
the check valves:

1.Remove the inlet and outlet lines from the check valve
holders (Figure 8-11), and then remove the check valve
holders. Pliers may be needed to remove the holders.
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Figure 8-11 Check valve holders

2. Remove check valves from pump head and place in a
beaker of methanol. Sonicate check valves for 15 to 20
minutes.

3. Reinstall check valves into pump head making sure that
the ends of the check valves (with multiple holes) are
facing up towards the outlet of the pump.

4. Reinstall check valve holders and tighten finger tight.
Then using pliers tighten an additional % turn.

5. Check the flow rate delivery. If the flow rate delivery is still
incorrect, replace the check valves. The correct flow rate
depends on the back pressure of the carrier solvent. The
flow will be 0.5 mL/minute until the fluid interface reaches
operating pressure, then reduces the flow rate to 0.2
mI/minute under typical operating conditions for the fluid
interface. The operating mode can be determined by
listening to the pump operate. While running at 50 ml/min,
the pump motor speed is continuous. Once operating
pressure is reached, the pump has a rapid refill stroke
approximately that occurs ~ 8 seconds.

8.6.12 Replacing Check Valves

1. Install new check valve cartridges (PN: 250-0001-17) into
pump head housing making sure the ends of the cartridges,
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with three small holes, are facing upwards towards the
outlet. See Figure 8-12.

Figure 8-12 Correct orientation of cartridge

2. Tighten check valve holders finger tight, then with pliers
tighten an additional % turn.

8.7 Injection Valve Maintenance

CombiFlash Rf* systems, including those equipped with 4x,
have an automatic injection valve. Under normal operating
conditions, this self-cleaning valve does not require any
maintenance.

If maintenance is required, refer to Instruction Sheet
60-5232-475, CombiFlash Rf Injection Valve Replacement.

8.8 Electrical Troubleshooting

If your instrument stops working and the touch panel display
is off, check the line cord connection.

If the line cord is connected properly, check the fuses in the
power input module located on the system’s rear panel. These
are time delay fuses (T-type) and rated according to the mains
input power voltage.

Combiflash Rf*, Rff Purion, and Rf 150 systems:
e 100 to 129 VAC mains input: 2.0 A fuse, one required
e 215 to 264 VAC mains input: 1.0 A fuse, two required
Combiflash Rf* Lumen system:
e 100 to 129 VAC mains input: 3.0 A fuse, one required
e 215 to 264 VAC mains input: 3.0 A fuse, two required
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/\CAUTION |

Always replace fuses with the same type and rating.

| M Note

The CombiFlash Rf 4x module does not have a user accessible

fuse.

Table 8-2 Common Purlon Error Codes and Resolutions

Error/Symptom

Solution

Purlon temperatures
are stabilizing.

[r] seconds remain.
(where [r] is a
number)

The Purlon has several areas with heaters.The
software has a set timer to allow temperatures to
come up to operating conditions. After that time, a
separate error is thrown if the heaters are not within
an acceptable band.The default time is 300
seconds after entering the operate condition.
During the standby condition most heaters are set
to OFF except the inlet capillary with is set to 50 C°
during standby.

The Purlon vacuum
level is too low to
operate. Please
verify  that the
roughing pump is
on and operating
correctly.

Pirani Pressure: [s1]
mbar. (where s1 is the
vacuum reading).

The Pirani pressure must be below 5.5E-3 mbar
before the Purlon turbo pump will operate. If trying
to place the Purlon in operate without turning on
the roughing pump, this message will appear.

This error generally occurs if the user forgets to
turn the roughing pump back on after cleaning the
capillary or changing the pump oil.

The Purlon has been
shut down. It will be
unavailable for use
until the Rf has been
rebooted. Please
ensure the Purlon
and fluid interface are
both turned on before
rebooting the Rf.

This message is displayed after the Purlon has
been successfully shut down through the
SHUTDOWN command. It serves as a reminder that
an Rf reboot will be necessary for the Purlon to be
enabled again by the Rf.

8-20
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Table 8-2 Common Purlon Error Codes and Resolutions

The splitter valve
seals have exceeded
their recommended
life. The Purlon will
continue to operate,
but there is an
increased possibility
of leakage at the
splitter valve and loss
of Purlon detection
during a separation.

The splitter valve supplier has stated that typical
valve life exceeds

1,000,000 actuations. After that time, there is no
method of determining when it will leak. The valve
can be rebuild using the valve

rebuild kit (PN:60-5234-629) or continue to use and
monitor for leakage. Leakage should not drip out
the bottom of the fluid interface front cover.

No ion source is
detected on the
Purlon. Please
ensure that the ion
source is properly
installed and
connected. If the
source is still not
detected, contact a
qualified service
technician. Error 309

The Purlon has reported that the ion source high
voltage cable is not properly plugged into its
socket. This is the cable with the round connector
and is to the right and behind the ion source.

This generally occurs upon changing or cleaning
probes.

Aplug has occurred in
the Purlon fluid lines.
The separation can
be continued without
Purlon detection or
continued if the plug
is corrected. Error
310

This error message is displayed if a plug is
detected during a separation.

The Purlon inlet cone
may be plugged
which could prevent
detection. Continued
operation will not
cause damage.
Please contact a
qualified service
technician to clean
the cone; Pirani
Pressure: [s1] mbar.
Error 315

During normal operation, the Pirani pressure
should be >1.5E-3 mbar. Anything less is an
indication of either partial or complete plugging of
the capillary cone entrance to the vacuum area.
See cleaning the cone capillary.
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Table 8-2 Common Purlon Error Codes and Resolutions

A plug has occurred in
the Purlon fluid lines.
The plug must be
corrected to allow
continued operation.
Error 316.

This error occurs if the tubing is plugged while the
method development screen is in use. See cleaning
the probe capillary.

The ionization probe
(ESI or APCI) isn’t
fully seated into the
ion source housing.
Please ensure the
probe is fully seated,
then press Ok to
continue. Error 317.

On Purlon systems (not Purlon S or Purlon L), the
probe isn’t seated properly. Loosen the
thumbscrew on the front of the ion source housing,
push down on the probe, then tighten the
thumbscrew.

The fluid interface
pressure is too low.
Error 325

This could be due to lack of carrier fluid, loss of
pump prime, or leakage.

Error/Symptom

Solution

No signal on any
mass, or very weak
signal

« Verify nitrogen pressure. Nitrogen is required
to nebulize the sample.

» Check carrier solvent level, refill carrier.
solvent and re-prime the carrier solvent
pump. Carrier solvent is needed to bring
sample to the mass spectrometer.

» Check that the priming valve is tight. A loose
priming valve prevents sample from getting
to the mass spectrometer.

» Verify the splitting valve is not leaking. This
causes loss of carrier solvent preventing
sample from getting to the mass
spectrometer.

» Check for leaks around other fittings on the
solvent interface
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Delayed signal
during run

Table 8-3 General Troubleshooting
+ Verify nitrogen pressure. Sample may drip

through the cone and still be detected later.

Check priming valve tightness. A slight leak
will delay sample.

Verify the splitting valve is not leaking.

Check for leaks around other fittings on the
solvent interface.

Sample masses
observed but weak,
or masses other
than the analyte
observed

Check polarity to see if the sample ionizes
under the opposite polarity.

"Try another ionization settings [IONIZATION
SETTINGS [6.3.10]].

"Compound fragments- use fragment mass
or try another ionization setting.

"Compound forms adducts.

Compound fails to ionize using the selected
probe. Some compounds ionize better using
APCI rather than ESI, for example.
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